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Code Generation Basics

IBM Rationa Statemate is a systems design automation tool for the development of reactive
systems. In analyzing a design concept, a systems designer uses the Rational Statemate graphics
editor to build and validate agraphical model of the system being developed, together with its user
interface. The designer then analyzes the model on aworkstation to verify its behavior using both
static and dynamic analysis of the model’s design concepts. Having validated the concept in this

way,

Rational Statemate is then used to generate a C-based or Ada-based prototype of the design, based
on the model, which can then be run on an appropriate host. The generation of prototype codein C
or Adaisthe subject of this document. There are three software code generator options:

¢ C(K&Ror ANSII standard)
¢ Ada
¢ Embedded C

Standard C code has long been the preferred language for system designers and software
developers. It wasthe original language generated by Rational Statemate. The C code generated by
Rational Statemate is compatible with avariety of modern C/C++ compilers, including GCC,
Visual C/C++, and Borland C/C++. Consult the release notes for your version of Rational
Statemate for the latest compatibility list. Part 2 of this manual goesinto extensive detail on the
process of generating C code for a Native Host Environment (as opposed to the Rapid Prototyping
environment discussed below).

Adais another language supported by Rational Statemate. Generating Ada code has few
differences from the process used to generate C code. Therefore, Ada specific information is
discussed in Ada Code Generation of this manual. Consult the release notes for your version of
Rational Statemate for the latest compiler compatibility list.

The Embedded C option isa central part of the Embedded Rapid Prototyping capability. This
allows code generation to be taken to the next logical step: compilation and linking for usein an
Embedded Prototyping Development System used to test the model designed in Rational
Statemate in a prototype system environment. Rapid Prototyping allows a more function use case
testing environment for moving the validation of the system design closer toward the end product.
This guide also focuses on the details of Rapid Prototyping Code Generation.
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Code Generation Basics

Development Model

Rationa Statemate facilitates a design process that begins with the construction of a graphical
model of a design concept. This design concept is expressed as a set of charts, including
statecharts, activity charts, and module charts. The designer creates this graphical representation
of the desired product based on a written specification.

Chart Design Focus Shows

Statecharts Behavior How each function performs its job. The logic, ordering,
and stimulus/response of each function.

Activity Charts Function How the functionality of the system is decomposed. The
interfaces between functional units.

Module Charts Structure How the system is partitioned structurally. The interfaces
between structural units.

Rational Statemate takes these charts and integrates them into a comprehensive formal model of a
system that not only communicates the design intent clearly and precisely, but serves as a solid
foundation for meaningful analysis and simulation. The designer creates these charts using
Rationa Statemate's language-sensitive and intuitive graphics editors. The editors all work in
essentially the same way, though each is optimized for the type of chart being created.

The Properties editor facilitates the precise definition of the type and structure of all data and
control elements. It also allows creation of user defined types, including records, unions, queues,
and arrays. The properties can aso be used to add information such as comments, descriptions,
and attributes to all of the elements in the model.

Once the model is built, it can be verified through simulation. A successful simulation suggests a
good working model. The Check Model tool performs a more exhaustive verification to ensure
that the model is complete and consistent.
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Executable Model

Executable Model

Asadesigner creates amodel, Rational Statemate builds aformal mathematical representation of
the model that can be dynamically analyzed on a computer at any time. In conjunction with
debugging and analysistools, the model can be refined even further. Dynamic Testing can be used
to eliminate many logical problems that might otherwise not be found until the system is built and
inthefield.

The end result is a system design embodied in aformally defined working model of the system’s
functionality. This model can then be compiled using C or Ada source code generated by Rational
Statemate, including the model’s graphical interface panels. This compiled code can be run
independently of Rational Statemate on another code-compatible computer.

Alternately, the Rapid Prototyping C code generator can be used to create code suitable for
compilation/linking/downloading into a embedded prototyping development system. Thiswould
then allow the testing of the model within a prototype use-case environment.

Code Generation, and subseguent compilation, isthe focus of this manual. The Rational Statemate
code generators are consistent in their interface and basic functionality. Thisinterface and
functionality are the focus of the balance of this document.

Generating Native Code

Generating code for a native environment is the simplest code generation task. The more complex
task of generating code for an embedded devel opment system environment is inherently more
complex and is presented later in this manual.

The more complex a simulation model becomes, the more difficult it can be to “step through” the
animated model. The ability to generate and compile code that will execute al or part of the
simulation makes the over-all design process more efficient. Individual portions of the larger
model can be refined to a point of design stability and stored as compiled code modules. These
modules can be linked into a larger and more complex model as though they were “black boxes,”
thereby limiting the “under development” elements of the larger model that must be tested and
refined.

It isaso conceivable that an entire design can be compiled into an executabl e file that can be run
on a system other than the development system. This allows sharing the model with others
interested in the end result of the design effort.

Code generation within Rational Statemate follows a rather consistent process. This processis
described in the following flow chart. It isimportant to note that most of the process occurs within
the Code Generation Profile Editor window. However, it is also necessary to access the Workarea
Browser in order to select the specific Activity Charts and Panels that are to be brought into the
scope of the generated code.
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Concepts and an Example

This section describes the major Code Generator concepts that you need to know and provides an
example that demonstrates how to generate code.

Compilation Profile Concepts

The behavioral model consists of many Statecharts and Activity-charts that you may want to
segment into smaller components. With the Code Generator’s Profile Editor, you can define the
scope of the compilation profile that you want to compile into C or Ada. You can aso customize
the generated code by specifying several trandation alternatives.

Profile Editor

The Profile Editor allows you to specify which charts to generate code from as well as select the
parameters that control their style. Use the Profile Editor to define a compilation profile by:

*

*

*

*

*

Defining code modules

Assigning behavior (Statecharts and Activity-charts) to the modules
Selecting preferences and settings

Customizing the profile by adding testbenches and panels

Generating host code (K&R C, ANSI C) (Adais also supported; refer to Ada Code
Generation).

Use aprofileto save the scope and code generation options, then store it in aworkareawhere it can
be retrieved, edited, and used over and over again for subseguent code generation runs. The profile
can aso be saved to the databank where it becomes part of aformal release or configuration item.
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Concepts and an Example

Module Structure
A moduleisacollection of Statecharts and Activity-charts that comprise a component.

+ InC, amodule signifies asingle source file with its local data and functions.
¢ InAda, amodule signifiesalibrary package.

Scope Definition

The Scope Definition, which isin the Profile Editor’s main window, shows the Module structure
of the profilein atree format or as alist. Both views show the charts assigned to each module and
how they were assigned.

Connection to the Workarea
The process of assigning behavior to the profile structure consists of three stages:

¢ What charts do you want. (Select the charts from the Workarea.)
¢  Wheredo you want them. (Select the module you want to assign the behavior to.)
+ How do you want to assign them. (Select the method of assigning the behavior.)

Descendants
Descendants refer to all the subactivities that are lower than the current chart, down to the last
state and primitive activity.

Testbenches

Testbenches (called Watchdogsin earlier versions of Rational Statemate) are separate Statecharts
created outside the specification of the system being devel oped.

Testbenches trap a specific behavior to test a design’sinputs and outputs. It's a“ snapshot of a
scenario.” Testbenches also serve as debuggers, and they are visible to all signalsin the design
without having to draw discrete flows.

Note
Testbenches cannot test generics.
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Inserting Handwritten Code

Concurrency

How does Rational Statemate translate concurrent activities into a sequential language? Even
though one procedure in the generated code may call another, if both are executed in the same
cycle, they are concurrent.

Sometimes it seems natural to implement concurrent activities as different threads (tasks), but it is
also possible to implement them as a single threaded program. Writing a single or multi-threaded
embedded application is adesign decision that does not affect performance or modularity. Since
the underlying architecture is sequential, a multi-threaded program is actually a set of sequential
pieces managed by a sequential handler.

So why is multi-threading needed at all? A multi-threading capability is needed only if a designer
wants to add threads that run “concurrently” with the generated modules that execute as asingle
thread, denoted as the “main task.”

Graphical Back Animation (GBA)

The Rational Statemate Simulator highlights the charts as they are executed. Once you generate
code, you lose that graphical feedback. Generating code with the GBA (Graphical Back
Animation) option provides graphical highlighting similar to Simulation, but from generated code.

Inserting Handwritten Code

Code Generator’s modular code architecture enables you to integrate handwritten code (also
known as “ user-written code”) with Rational Statemate-generated code in two ways:

+ The profile's scope can include stubs for handwritten code. A stub is an empty module
where you can insert user-written code into Rational Statemate-generated code.
+ The new method of supplementing code offers the following advantages.
¢ Enablesyou to include code directly into your design.
+ Eliminates the need for special calls and services to integrate handwritten code.

¢ Storesthe code in the model’s database so it is common to both simulation and
code generation.

+ Automatically includes the user-written code whenever you run simulation or
code generation.

For information on these methods, refer to Required User-written Code.

Note

Rational Statemate supports the stub method for compatibility reasons, but it is
recommended that you use the new method for supplementing code.
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Concepts and an Example

Creating a Sample Profile

This section shows how to create a sample profile and generate code for it.

Invoking the Profile Editor
Use the following steps to access the Profile Editor and create a new profile.
1. Select the C code generator from the main window.

Note

If you are developing ADA, Embedded C, or MicroC code, you need to select the
appropriate icon.

ol

File Edit Yiew Project Configuration Tools Utilities Window Help

sl Eli2r X |(BRD 8|1 |@masas

o ! REAR DEFOG GDs Name || Defined In || Tupe: |Istatus | =
— [Al ACTIVITY CHART TEST

& [E CALC_REAR_DEFOG STATE

[E] DATABANE_TEST

9% REAR_DEFOG_EFHZ

REAR_DEFOG_RELAY_MGMT

E EEAR_DEFOG 58
EEAR_DEFOG_FEATURES

. 4t REAR_DEFOG_UCD
CI!Ck for C_ > & E || REAR_DEFOG_LO_SFEED_NO_LOAD
Click for MicroC —— & & SIMULATION
Click for Embedded C» & S ILOWEAART TR
Click for Ada S & < [ MODULE_CHART TEST

- @ STATECHART _TEST

§ [l REAR_DEFOG_IHI_SFEED_ILOAD1L
{| REAR_DEFOG_LO_SFEED_NO_LOAD
[| sEQUENCE_TEST

~

~

=

Charts |Flles IDataBank |Ssarch |

] —

Hessages ILoa I
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Creating a Sample Profile

The appropriate Profile Editor appears as shown in the following figure.

2. Select File> New Profile. The New/Open Compilation Profile dialog appears.

Rational Statemate 9



Concepts and an Example

Mew,/Open Compilation Prol |

Profiles

CODE_TEST
REAR_DEFOG

Profile Mame:

I

(K | Eancell Help |

3. Namethe new profile in the Profile Name text box and select OK. For example, in
previous figure, the profileis given the name: REAR_DEFOG.

The Profile Editor enables all the menu selections and displays the profile name in the
title bar.
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Creating a Sample Profile

Defining Code Modules
Code module can be structured as desired to meet the needs of the model being simulated. Use the

following steps to define the structure of modules that reflects the way you want the code
organized. Note that each module may contain one chart, several charts, or a portion of a chart.

1. Click CreateModule :5 or select Edit > Create Module.

The Create M odule window opens.

Create Module | x|

Hodule Mame:

0k | _Ear‘u:ell Helpl

2. Enter the name of the new module and click OK .

Note
For the example presented here, the name the moduleisREAR_DEFOG_MOD.

Assigning Behavior to the Module
Use the following steps to select charts from the workarea and assign them to the module you

want.

1. Click Add Chart to Module ﬁ or select Edit > Add With Descendants.

The Chart Tree windows opens.
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Charts Tree

4 REAR DEFOG_GDS
[El ACTIVITY CHART REAR_DEFOG
[El ACTI¥ITY CHART TEST
[l CALC REAR DEFOG STATE
[E] DATABANE _TEST
[H] MODULE_CHART_TEST
5t REAR_DEFOG_EFH3
REAR_DEFOG_RELAY MGMT
[# REAR DEFOG 55
[A] REAR DEFOG_FEATURES

E:ﬁg REAR DEFOG UCD

| REAR_DEFOG LO_SFEED_NO_LOAD
& SIMULATION
TOF
<E= FLOWCHART TEST
(E) STATECHART TEST
| REAR DEFOG 7HI SPEED LOADI
| REAR DEFOG LO_SFEED NO_LOAD
| SEQUENCE_TEST

2. Select the chart(s) you want to assign to the module. For example, select the Activity-chart
REAR_DEFOG_SS.

Note: To select charts with their descendants in a hierarchy, select only the parent.
The Code Generator adds your selection to the profile with its descendants.

3. Select the File > Save menu item to save the profile in your workarea.

12
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Creating a Sample Profile

Selecting Code Parameters

Use the Options menu to specify how you want the code generated.

Global Profile Settings,..
Module Settings...

Time Settings...
Activity Style,..
Makefile Settings...

Parels Dizplay...

Preferences Management,..

Option

Description

Global Profile Settings

Allows you to change settings for all modules in the current profile. Use
this feature to select the following:

e Language (For the C Code Generator, you can select K&R C or
ANSI C.)

« Modularity Style

« Double-Buffer Optimization

* Generation of main

« With Debugger

« Graphical Back Animation

« Infinite Loop Limit

« Packages/Headers for External Subroutines

Module Settings

For the selected module, you can either create a separate file for each
Statechart or set parameters.

Time Settings

Control time expressions settings (real, synchronous, or asynchronous)
and in what units.

Activity Style

Specifies software or hardware. If you select software, activities can be
started and stopped. If you select hardware, activities are always active.

Makefile Settings

Allows you to set flags for compilation and include libraries.

Panels Display

Allows you to have panel display on other workstations connected to the
network.

Preferences
Management

Allows you to select general preferences.

Rational Statemate
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Concepts and an Example

Generating Code

Before generating code, you may wish to run Check Profile to verify that the profile complies with
the scoping rules. For example, Check Profile makes sure that the settings are legal and do not
conflict with each other. The Code Generator also checks the profile when you generate code.

Complete the following steps to check the profile and generate code.
1. Select Compile > Check Profile.

Note: You must correct any errors before generating code, but you can continue to
generate code with warnings and information messages.

2. Select Compile > Generate Code.

Note: The default location for this operation is a sub-directory named according to
your current profile name, i.e., it isinside the “prt” sub-directory of your
current workarea.

3. Select Compile > File Management.

The SW Code M anagement dialog appears

SW Code Management

Files
MakeCode, bat e
Makefile
rear_defog,info Delete

CopY. .

Export,..

FREEL |

Print

:

DNizmiz=s | Help
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Creating a Sample Profile

File Management offers the following options:

— Show—Displays alisting of the generated code.
— Delete—Deletes the selected file.

— Copy—Copiesthe selected file after you re-name it. (Works the same way as
Save asin the File menu.)

— Export—Saves the file to another workarea or directory.
— Print—~Prints the generated code.
4. To view generated code, select afile and then click Show.

The selected file appears in the xless editor similar to the example in the following figure.
5. Select Quit and then Dismiss.
6. Select one of the following:

¢ File> Closeto close this profile and leave the Profile Editor open.
¢ File> Exit to close this profile and close the Profile Editor.

The Profile Editor automatically closes any related windows that you left opened and displays a
dialog asking if you want to save any unsaved changes to the profile.
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Concepts and an Example

File Edit Format “iew Help

int RD_TIMER;

int VEHICLE_SFEED_IN;

A% wvehicle speed from Powertrain (kHP). %/
Bvent TMEMRD_RELAY_OFF;

event TMEMRD_RELAY_CM;

event TMEMREAR_DEFOG_TIMED;

static wvoid schedule_timeouts()

it (EMRD_RELAY_OFF)
sC_tmo(&tMENMRD_RELAY_OFF, OFF_TIME * SEC);
it (EMRD_RELAY_ON)
SC_tmoC&TMEMRD_RELAY_OM, OM_TIME * SEC];
it (EMREAR_DEFOG_TIMED)
sC_tmo(&TMEMREAR_DEFOG_TIMED, RD_TIMER * SEC);
T/ schedule_timeouts */

wioid exec REAR_DEFOG_OUTPUT_TT ()
if ( DEFOG_DRIVE_SIG )

tt_notify((void *)scope_id, {(genptrlexec REAR_DEFOGS_OUTPUT_TT, FALSE,1);
setha(DEFOG_DRIVE_OUT,1,0,0,s2baf"0b0"),1,0,07;
return;

if ! DEFOG_DRIVE_SIG )

tt_notify({void *Jscope_id, {(genptrlexec REAR_DEFOGS_OUTPUT_TT, FALSE, 2);
setha(DEFOG_DRIVE_OUT,1,0,0,s2baf"0b1"),1,0,00;
return;

TS eweC_REAR_DEFOG_OUTPUT_TT %/
woid exit_CALC_REAR_DEFOG_EMAEBLED ()

nDtifﬁ(SCDpe_id,CDnCALC_REAR_DEFOG_ENABLED,FALSE);
switch (CALC_REAR_DEFOG_EMABLED_isin)
Case REAR_DEFOG_TIMED :
notify(scope_id, ConREAR_DEFOG_TIMED, FALSE];
break;
Cise REAR_DEFOG_MOT_TIMED
notify(scope_id, conREAR_DEFOG_MNOT_TIMED, FALSED;

break;
case notacalc_REAR_DEFOG_EMNABLED
break;
¥ .
CALC_REAR_DEFOG_EMAELED_isin = notaCALC_REAR_DEFOG_ENABLED;

4]
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Architecture of Generated C Code

This section describes the architecture of the generated C code including how the Code Generator
structures the modules.

The Rational Statemate Code Generator generates fully functional code, based on the Activity-
charts and Statecharts in the Rational Statemate model. The generated modules are partitioned
according to a compilation profile, which allows you to generate code for a complete Rational
Statemate model or just a part of one.

Each generated modul e reflects the state, timing, and scheduling logic of the model that isincluded
in the compilation profile. This allows a suitable set of components to be built that reflect the
system logic (behavior).

The generated code uses runtime modules for timing and scheduling. Requests are generated to the
timing module for timeouts and scheduled events, and to the scheduler module to control
handwritten tasks that are connected to basic and external activities. In addition, the data elements
are double buffered, so data assignments are synchronized to prevent racing conditions among the
“concurrent” behavioral components.

Note

In some cases where there are no racing conditions, you may want to disable double
buffering. For more information, refer to Optimizing Double Buffers.
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Architecture of Generated C Code

Code Libraries

All of the runtime modules are actually a set of compiled libraries. These libraries can be reused
for other projects because they are supplied in source code form which allows modifications based
on proj ect-specific requirements. The runtime modules actually provide an interface between the
generated behavioral logic and the underlying Operating System (OS).

Porting the generated behavioral components to a particular environment primarily means
tailoring the runtime library to use the specific services provided by the operating system. The
target operating system can even be a Real-Time OS kernel. The runtime library can even be
modified to provide an alternative functionality which does not normally exist in the target OS.

Note

Tailoring the runtime libraries is a usually one-time effort. Once completed, the generated
components can be compiled and linked without being modified any further.

The detailed process of generating code for an embedded target system is discussed in detail later
in this manual. However, there are many basic OS concepts that are more easily introduced using
the more limited scope of an embedded operating system. The following figure shows the layered
software components of the typical embedded application. The final executable image is normally
built from some permanent pre-compiled modules (such as the RTOS kernel) and the generated/
compiled modules that are dependent on the application.

Generated Code Permanent Code

application code
behavioral logic + user code

| 1 |
timer scheduler double

OS Services: Memory Management (3)
Timer Service
Multi-Threading Services (4)

18
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Tasks View of the Code

The key components include the following:

¢ The Scheduler Component is Optional - It isneeded only if the user specifiesthat basic or

external activities should be implemented as tasks or desiresto link agraphic panel into the
executable.

¢ Callback Handler. - This component will be used only if the user selects to attach
callback routines to behavioral logic components.

¢ Memory Management - The runtime modul€'s timer, double-buffering and callback
handlers utilize dynamic memory allocations. Under certain assumptionsit is possible to
tailor them to use only static allocation, if amemory management packageis not available
or memory resources are limited.

¢ Multi-Threading (Tasking) Support - This support provides amechanism for cresting task
threads and switching between them. This serviceis needed only if the user wishesto
implement environment tasks or basic activities astasks. Thisissueis discussed in grester detail
in the Software Code Generator |nterface Manual.

Tasks View of the Code

One of the mgjor issues that confuse many users is how concurrent activities and states are
actually trandated into a sequentia language. Concurrency within the languages of Rational
Statemateis represented explicitly between orthogonal states (AND states), and implicitly between
separate (concurrent) activities. Sometimes it is natural to implement them as different threads
(tasks), but it is also possible to implement them as a single threaded program.

Writing an application as a single thread or multi-threaded is actually a design decision. Since the
underlying architecture is sequential, a multi-threaded program is actually a set of sequential
pieces managed by a sequential scheduler.

Module Execution

The modules of the generated code are sequential. They are executed cyclically with each iteration
evaluating the next step of processing. In terms of simulation, executing the code is equivaent to
executing a“go-step” repeatedly, while changing the environment asynchronously. The main
difference is that the clock isincremented in real time, so timeouts will happen according to the
time taken to execute the code.
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Architecture of Generated C Code

Multi-Threading

So why is multi-threading needed at all? Multi-threading is used to allow the user to implement
basic activities as independent processes, without having to comply with the “one cycle at atime”
method. It also allows writing additional environment processes outside the system model, to
process inputs, to drive outputs or for simulating the environment. Therefore, a multi-threading
capability is needed only if the user wishesto add threads that run “ concurrently” with the
generated modules that execute as a single thread, denoted as the “main task.”

Asynchronous Timer

Another component in the process view of the code is the asynchronous timer. The main task
issues timer requests to be notified about timeouts and scheduled actions. The timer module

asynchronously notifies the main task when timeout events are occurring. An exampleisshown in
the following figure.

Ewnts, Condiions

{Caontral)

userfashi
user defned

reque sts

+ Insome applications there will be no basic activities implemented as tasks. In those cases,

the only processes that exist are the main task and the asynchronous timer. If basic-
activity tasks exist, the main task issues tasking control calls such as start, suspend, etc.

There are cases where the user implements environment tasks, but none of the basic-
activities are implemented as atask. In these cases, the generated-code (the main task)

does not use any tasking services. The code does not need a multi-threading adaptor
unless the user connects a panel to the executable.
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Tasks View of the Code

Using Simulated Time Model

Generated code uses the real-time modd by default. In thismodel, timeouts and scheduled actions are
treated very smilarly to other inputs. The system clock kegpstime and generatesinterruptsthat are
processed aong with the other inputs.

When using thistime mode!, it is possible for the code to miss atimeout or scheduled action due to
heavy loading of the processor or an extremely small request for atimeout. In such a situation, the
generated code may actually behave dslightly different than a simulation of the same model.

An additional time model is provided called the smulated-time modd. The purpose of thismodel isto
force the generated code to behave in the same manner asthe smulated moddl. It doesthis a the cost of
the real-time nature of the generated code.

The simulated-time model may be either asynchronous or synchronous. In the asynchronous time
model, time is consumed only for timeout statements and scheduled actions; otherwise, it runsin
real-time. In the synchronous time model, transitions are made on a clock. Every transition
consumes one clock period and every step consumes one clock cycle.

In order to meet all timeouts regardless of duration and CPU loading, the code would be required
to run at an arbitrarily fast speed. Since thisis not possible, code which is compiled using the
smulated-time model, does not adhere to the system clock. Rather, it kegpsits own artificia time, much
the same as asimulator. The code executes model steps until it reaches a stable status. It then advances
theinternal clock to the necessary value to execute the next timeout or scheduled action.

-- The main loop, loops forever

int main(argc, argv)
int argc;
{ char **argv;
while (TRUE) {
-- Execute a step --
-- Advance internal time keeper to next
relevant time --
-- Apply timeouts and scheduled actions. --
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Implementing a Function to Get External Inputs

To retrieve external inputs, you can create separate tasks within the Rational Statemate model.
This processis described in Adding User-Written Code.

Use the tasks to read inputs from the environment (possibly from the keyboard or an input file),
and use the value setting functions to insert the changes into the Rational Statemate model. In
order to simulate the passage of time, the de1ay function should be used between inputs.

The outputs can be captured using the event callback mechanism, or they can be polled using a
separate task.

Extracting the Time

Thefunction sched time (double) returnsthesmulated time. It can be used by the handwritten code
to decide when to simulate the model or to generate reports.

Main Task: Partition and Flow Control for C

This section describes how different generated modules are put together into a single thread, and
what is the control flow of the main task. The whole execution starts with an initialization phase,
where all components are initialized: the timer, the threads scheduler (if needed) and basic activity
tasks are created. In addition the user init procedureiscalled.

Theuser init procedureresidesin afilecaled user activities.c. When you generate code,
the Code Generator automatically createsthe user _activities.c fileandthe user init
procedure. Prior to executing the model, you may initialize valuesin the user_init procedure.

After the initialization phase, the main-task starts processing in acyclic manner, where every cycle
correspondsto asingle “go-step.” In every cycle, al the concurrent state machines are traversed,
process their inputs and generate outputs, issue timing requests and take the necessary state
transitions.
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Main Task: Partition and Flow Control for C

Thisis how the main program looks:

int main(argc, argv)
int argc;

char **argv;

pr_initialize();
while (TRUE) {

if (pr _make step()) /*if system is in stable status,
pr_pause;it enters the pause mode, waiting
for external inputs */

The C function pr_make step returns TRUE when system isin a stable status.

The main program is written as a task, which calls al the state machines within the profile.
pr_initialize iStheinitidization procedure, andpr make step completesasingle-step of thewhole
system. Note the user-tasks, including basic activities are processing independently, aswell asthe
asynchronous timer.

The following diagram shows the calling sequence within the main task:
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user_init
pr_initialize
other
main nits
‘ ] —| modulel
man .
' loop pr_make lo_main
step — | moduleN
handle p———| user
callbacks* callbackl
\ user
sched pause callbackN
wait
handle
combinational
assignments
handle
panel graphics
The C procedure pr_make_step follows:
boolean pr make step()
{
boolean step has changes = FALSE;
incr stepN(); /* increment step counter */
sched_disable(); /* disable async timer interrupts
during execution of step */
lo main(); /* step execution */
step_has_changes = update(); /* perform all deferred
assignments */
garbage collect() ; /* clearing intra-step allocations */
sched enable() ; /* enable accepting of elapsed
timeouts */
scheduler(); /* yield control to other ready
tasks, including panel driver */
if (!step_has changes) /* no changes:
return TRUE; system is in a stable status */

24
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Main Task: Partition and Flow Control for C

pge start graphics(); /* start critical section of panel
updates */

call cbks(FALSE); /* evaluate callbacks,
including panel outputs */

pge_end graphics(); /* end critical section of panel
updates */

return FALSE; /* step finished;

system status is not stable */

Thepr make step procedure activates al the functionsthat complete the execution of astep.

Activating the generated modules (the “state machines”)

lo_main iSagenerated procedure, that “glues’ together all the specific modules as partitioned by
the compilation-profile. It calls the top level procedures of these modules:

lo main()

<modulel> EXEC all();
<module2> EXEC_all();

I

<moduleN> EXEC all();

Note

The 1o main isactually the scheduler of the generated components. It applies afair non-
prioritized round-robin scheduling policy, similar to the interpretive simulator. However, it
is possible to introduce priority scheduling by modifying 10 main.

Updating double buffer assignments

The update function executes all the deferred assignmentsinto the actual data objects, based on the
update list. As a by-product, the function can determine whether the system is still processing data
or it has reached a stationary condition. If the update list is empty, it means that the system
executed anidle step. The step_has_changes flag indicates whether the step has ongoing
processing, or the previous execution cycle was actualy anidle step.
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Evaluating the callback list

If you define callbacks, they are checked at this point. When an element gets a new value, its
callback procedureis called. Note that if no hooks are set, the handle to the callback
(call_cbks_p) handler remainsnull, anditisnot caled at all.

Entering the wait state

If the system executes anidle step, it isin a stationary condition. At this point, the main task
releases the CPU by calling a system service that blocks it from running until some external
stimulus occurs. The external stimulus can be either an event/data change, or atimeout.

The decision whether to enter await state or not should be handled carefully, since once the main
task blocksitself, only external input will wake it. Therefore, the pr pause procedurethat actualy
blocks the cannat be uninterrupted to prevent the following scenario:

main task timer

1| CHECK_FOR_WAIT

Checksfor changesin last tw

steps or if timeout expires. 9] GENERATE TIMEOUT
If none, it decides to sleep. ] -
{ A timeout expired; hence.. .}

3§ TRY TO WAKE MAIN TASK

butif it doesnot sleep yet; so
{thisisawasted call }

ﬂ WAIT

Main task enters await
mode, instead of reacting to} \ 4
the timeout

This scenario leads to adeadlock condition. Since the timeout isignored by the system, the main
task has already “decided” to hibernate itself but has not yet done so and the “wake” call islost.
The pr_pause procedure will apply the test-and-wait in amutually exclusive manner.

Thepr pause procedure will be discussed |ater, sinceit is dependent on the underlying operating
system.
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Main Task: Partition and Flow Control for C

Structure of a Behavioral Module

In this example, the moduleiscalled light .c:

#include
#include

#include
#include

#include

“types.h”
“<gds name>.h"

“light.h”
“<compilation profile names>main.h”

“user activities.h”

Headers of other modules:

¢ typesh — Basictype definitionsfor condition, events, data-items etc.

¢ <gds_name>.h — If you used Global Definition Setsin the design, the GDSs will have
corresponding header filesin the generated code. They are included by all modulesin the

code.

¢ light.h — Header file for the local module.

¢ <compilation_profile_hame>main.h - Definition of all intermodules shared data. Note
that all the data elements shared by more than one modul e are defined in the main module.

¢ user_activitiesh - Prototypesfor the user-written activities for which stubs were
requested in the profile.

Interface Section

This section documents the inputs and outputs flowing into/out of the module. It is useful for
reusability purposes to understand the interface of the module.

/* Inputs */
/* event CAR; */
/* event ADVANCE; */

/* Outputs */
/* condition YELLOW C; */

Status Types

Every non-basic or-state has a status variable that indicates what substate is currently active. The
status type is actually an enumerated type, defined at the beginning of the module.

typedef enum {nota Chart TMODES, st LIGHT MODES} tp Chart TMODES states;

State Variable Definition

tp Chart TMODES states st Chart TMODES isin =

nota_ Chart TMODES;

Rational Statemate
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Definitions of Data/Control Elements

In this section all the LOCAL data-items, events and conditions are defined. The word LOCAL
means that the elements are not used outside the module scope. Note that activities are also
alocated a status variabl e of type activity, which is an enumerated type that contains the possible
activity statuses.

activity acy INPUT TASK = nonactive;
condition GREEN C = FALSE;

Definition of Fictive Events/Conditions

Thefictive events are events not explicitly defined in the model. Thus, they can be thought of as
“ Statemate-generated events.” They are essentially timeout events, enter/exit state events, and in-
state conditions. Fictive events are generated only when necessary, i.e., only if the model uses

en (STATE) andtheenst_sSTATE event isgenerated.

event enst CHANGEl = FALSE;
event tmenst_ CHANGE3 = FALSE;

Definition of Truth-Table Elements

The following lists the code generated out of a Truth-Table:

¢ Theexpression of the format: “if(<Boolean>==true)” is generated as “if(<Boolean>).”
¢ Theexpression of the format: “if(<Boolean>==false)” is generated as “if(!<Boolean>).”

¢ Theexpression of the format “if(true)” generates the expression under the “if” without an
“if” statement.

Schedule Timeouts Procedure

This procedure executes every execution-cycle, and evaluates what timeouts should betriggered in
the particular module. All timeout triggers are evaluated, and the necessary timeouts are
SCHEDULED using the timing module service sc_tmo.

static void schedule timeouts()
if (enst_ CHANGE3)

sc_tmo (&tmenst CHANGE3, 0.3 * SEC);
} /* schedule timeouts */
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Action Procedures

In some cases actions are tranglated into procedures (depending on the modularity style). In this
case, a C procedure represents the Rational Statemate action DO BLACK.

void exec DO BLACK()

setc (&YELLOW C, FALSE);

} /* exec_DO BLACK */

State Enter/Exit Procedures

Depending on the modularity style, the enter/exit (including history enter) sequences are grouped
into procedures. The example shows the default entering sequence (i.e. entering via atransition
that goes to the edge of the state) for the NIGHT date

¢ Change parent datus varisbleto n1chT .
¢+ Generaetheevent en (NIGHT) represented aSenst NIGHT.

void entdef st NIGHT ()

st LIGHT MODES isin = st NIGHT;
gen (&enst NIGHT) ;

} /* entdef st NIGHT */

State EXEC Procedures

void EXEC st LIGHT MODES ()
switch (st LIGHT MODES isin)

case st2 NIGHT
EXEC_st2 NIGHT() ;
break;

case st2_ STD_BY

} /* EXEC st LIGHT MODES */
void EXEC_st Chart TMODES ()

switch (st_Chart TMODES isin) ({
case nota_ Chart_TMODES
case st LIGHT MODES :
EXEC st LIGHT MODES () ;
break;
default:

} /* EXEC_st_ Chart TMODES */
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The EXEC procedureis actualy the heart of the behaviora logic as described in the Satecharts. Every
non-basic Sate has an EXEC procedure that activates dl the state-logic within asingle execution cycle.
TheEXEC procedurewill take care of in state trangition, static reactions, and activation of substate EXEC
procedures.

Thetraversal is done hierarchically, starting at the very top state in the module, going down
towards the basic states. In case of an “and” state, the orthogonal components are traversed
sequentially one after the other but on the same semantic step utilizing the double-buffering
mechanism.

Module Initialization Procedure

The module initialization procedure is called once the executable is started, before running
through any execution cycle. It initializes all local data of the module. The procedure also
establishes tasks that implement basic activitiesif there are such:

void light init ()

tp_acy INPUT TASK=
sched create task(user code for input task,
0,stop_acy INPUT TASK) ;

}

Theinit procedure is one of the two procedures that the module exports, and it is called by the
lo_init procedure.

Module Execution Procedure

void light EXEC all()

schedule timeouts() ;
EXEC_st_ Chart_ TMODES () ;
} /* light EXEC all */

This procedure activates a single execution cycle (step), once being called by 10 _main inthemain
module. It activatesthe schedule timeouts procedureto schedule potentia timeouts, and most
importantly, is activating the hierarchical traversal of the state EXEC procedures by activating the EXEC
procedure of the top-level Statechart.
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Structure Of The Generated Code

The Code Generator writes the generated source code into a designated directory in the workarea.
The organization of the code directories in the workareais as follows:

<WORKAREA>
71\
prt
71\
<CompilationProfilel>  <Compilation Profile2> <Compilation Profile
/ | \ 7|\ 7|\

For every code generation, the codeis placed in a subdirectory of the “prt” directory based on the
compilation profile name (unless you specify another Output Directory.

In the figure above, <workarEA> Standsfor the root of the workarea directory, and <compilation
Profile 1>, <Compilation Profile 2>, 8Nd <Compilation Profile 3> represent directories
corresponding to different profile names.

Structure of the Output Source Files

The generated files can be partitioned into six categories:

*

Control Modules - Thesefiles carry the model’s logic and scheduling and are the most
significant part of the model.

Modulesfor Subroutines Defined in Model - For each subroutine, a separate fileis
generated.

User Supplemented Code (templates) - These files contain hooks and frames used to
interface the behavioral model with the environment or any other user-supplemented
modules. As opposed to subroutines, this code is not stored in the model.

Interface M odules - Interface code for panels and the Debugger.

M akefilesand Compilation Scripts - These are scripts used to automate the process of
building an application (compile & link) from the sourcefiles.

Thelnfo File - Contains cross reference information.

Rational Statemate 31



Architecture of Generated C Code

Control Files

There are two types of control files: behavioral modules and atop-level module.

Behavioral Modules

The behavioral modules are the heart of the code and implement the logic as described by the
statecharts and mini-specs. The specification is partitioned into behavioral modulesin the
compilation profile. For each specified module, two files are generated based on the user-defined
module name.

The following header file exports all the specification objects defined in the module (for use by
other modules), and the module execution procedure.

<module name>.h

The following module body defines al the local objects (events, conditions, data-items), and the
procedures that implement the logic of the statecharts and mini-specs.

<module name>.c

The Top Level Module

The top-level module identified as <compilation profile name>main.c “wraps’ al
the behavioral modulesinto a single behavioral unit. It also defines all the global elements, i.e.,
those elements used by more than one module. It defines two procedures:

¢ 1o init - Initiaization of al the participating modules

¢ 1o main - Execution of asingle step of all modules.
The header file exports the globa elements, the initialization and the execution procedures. The
filenameis:

<compilation profile name>main.h
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Implementation of Subroutines

User

This section describes how the Code Generator implements subroutines in the model’s database.

For information on how to supplement generated code with subroutines, refer to Adding User-
Written Code.

For each subroutine that the model uses (i.e., either called or referenced in the callback or user-
added code bindings), a separate file is generated. Thisfile, named <subroutine name>_ sc.c
contains a code that implements the subroutine.

The Code Generator implements the subroutine in one of the following ways:

¢ Handwritten code (in C or Ada), which is stored in the model

+ Trandation of Rational Statemate Action Language, Procedural Statechart, or Truth Table
(when a subroutine isimplemented using one of these languages)

In the following cases, the Code Generator only produces atemplate for the subroutine;

+ Noimplementation at all is given for the subroutine in the model.

+ Someimplementation exists, but it is disabled by setting the “ Select Implementation”
option in the Properties window to “None.”

+ Selected implementation does not match the Code Generator’s target language. For
example, if your model has a C-code implementation of a subroutine and you are
generating Ada, the Code Generator will ignore it.

In addition to *_sc.c files, the Code Generator creates afile called

<profile name>_envelopes.c. Thisfile contains“envelopes’ for al the subroutinesin the
scope. The envelopes ensure that the Rational Statemate execution rules are properly mapped into
those of C or Ada.

Supplemented Files (User_activities Stubs File)

The stub method adds code to the generated C or Ada code by modifying the user activities
files. For more information on this method, refer to the Software Code Generator Interface
Manual.

The Code Generator automatically creates the following two files:

user_ activities.c (user_activities.c_temp)
user activities.h (user activities.h temp)

These filesinclude all the stubs generated for the basic activities according to the compilation
profile. Once the user-activities stubs file exists in the output directory, it is not overwritten, and a
file user activities.c temp isgenerated. The stub fileincludesacorresponding header file, which
isaso not overwritten.
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Interface Modules

Debugger Symbol Table File

Thisfileis generated only when the debug option is enabled. It includes symbolic information
about the original model that is used by the debugger.

<profile names>.dbg

Panel Interface Files

Thefollowing files are generated only if there are panels attached to your code. Thisis actually the
code that glues the panel to the behavioral modules.

panel transmitter.c

panel displays.dat

Makefiles and Compilation Scripts

The following files compile and link the code on UNIX platforms where the “make” utility is
available:

* Makefile
¢  User_Makefile
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Info File

Theinfo file (format below) contains information about the translation process, the relevant
portion of the model, and the generated modules.

<profile name>.info

Thisfile contains the following information:

¢ Compilation Profile Parameters

¢ Errorsand Warnings

* Cross Reference Table - The cross reference table contains al the elements in the code

and the original elements they represent. Thisinformation is useful when supplementing
the generated code. In cases where the same name is used for different model, this cross-
reference table is the only way to identify which code-element mapsto the spec-element.

Interface Report - The interface report is a graphical diagram that shows the flow of

information and control among the behavioral modules, and among the environment and
the rest of the model
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This section describes the procedure and environment for compiling, linking, and porting compiled
C code.

The Rational Statemate code generator supports the generation of both ANSI C and the traditional
Kernighan & Ritchie style of C code. Select between these two styles of C when you define the
Global Profile Settings in the compilation profile. Refer to Selecting Code Parameters for more
information.

Library Location

The sourcefilesfor the Kernighan & RitchieC librariesare stored in $stv _ROOT/etc/prt/c.
The source filesfor ANSI C librariesare stored in $sTM ROOT/etc/prt/ansic.

The Code Generator allows amix of different stylesof C. For example, if the target language is
K&R C, the Code Generator includes any subroutinesimplementsin ANSI C, or viceversa. In
these cases, in addition to Makefile for the target language, the Code Generator produces another
file for compiling the subroutines that were implemented in adifferent style of C. Thisfileiscalled
C Makefile OF ANSIC Makefile respectively.
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Compilation Command

The default compiler statements for each of the supported Rational Statemate platforms are listed
in the following table:

Sun SunOS acc

Sun Solaris acc

HP HPUX cc -Aa -D_HPUX_SOURCE
Windows NT cl

If the C compiler you are using differs from the default for your platform, then customize it by
editing themakefile anduser Makefile. Thesefilesare produced whenthe codeis generated.

Sugplementing the Rational Statemate Model with C
Code

When supplementing the Rational Statemate model with handwritten C code, the additional
compilation statements will be automatically added to the user Makefile. Thisfileis produced
when the code is generated.

Thefollowing is an example of theuser Makefile for ANSI C generated code.

CC = acc

OBJECTS = user_ activities out.o

CFLAGS = -o -ansi -pedantic -Wstrict-prototypes
-I$STM ROOT/etc/prt/ansic
-I$STM ROOT/etc/prt/ansisched

all : out lib.a

out_lib.a : $(objects)
ar rvu out lib.a $(objects)
ranlib out lib.a

Add all objectsthat require compiling to the elements list.
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Details of Compilation and Linking

This section describes the UNIX and PC compilation environments.

UNIX Compilation Environment

The prototype executable consists of three components:

¢ Code generated by the Code Generator that reflects the Rational Statemate model.

+ Additional user-provided source files and libraries.

+ Runtime library modules (refer to the following table).

File

Description

Code Generator Intrinsics:

libintrinsic.a

for K&R C

libaintrinsic.a

for ANSI C

Scheduler Library (not always needed):

libscheduler.a

for real time

libsim_scheduler.a

for simulated time

Debug

ger Module:

libdbg.a

needed only when using debug
facilities

PC Compilation Environment

Refer to the Rational Satemate Administrator’s Guide for the supported Windows compilation

environment.

Library

Description

libdbg.lib

Debugger library

libintrinsics.lib

Intrinsics library

libscheduler.lib

Scheduler library

libsim_scheduler.lib

Scheduler for simulated-time
library

libpgertl.lib

Panels run-time library
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Locating Rational Statemate Libraries

The libraries for your Rational Statemate platform are pre-compiled and located in $st™_rooT/
11ib. If you wish to compile and link your prototype on a platform that is not your Rational Statemate
platform, you will have to compile these libraries from the provided sourcesin $sTv_RoOT/etc/prt/c.

Sources for building of scheduler and sim_scheduler libraries are located in the $stv rooT/etc/
sched.

For ANSI C, sources are located in the ssTM _ROOT/etc/prt/ansic and $STM ROOT/etc/
ansisched.

Using make to Link and Compile

The compile and link phase compiles the generated code and handwritten codeinto alibrary called
out_lib.a, andlinksit with the runtime modules and the user-specified librariesinto an executable
prototype.

Every time you modify your specification and generate code, you have to follow this procedure.
The mechanism that manages this process is the make.

The advantage of make on “flat” compilationsisthat it can manage incremental compilation. That
is, compiling only what is necessary due to the latest changes.

Theinput to make aretwo dependency files. Makefile andUser Makefile. They containlistsof files
and dependenciesthat determine what has to be re-compiled after every changein the sourcefiles.

Thewmakefile listsal the generated files that should remain intact. The user Makefile compiles
theuser activities template and additional files added by the user.

Makefile Settings

You can enter the compilation command, flags, and libraries you want linked to the prototype by
selecting Options > M akefile Settings. Refer to Selecting Code Parameters for more information.
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Adding Files to the Prototype

Thefollowing isan example of the user _Makefile on UNIX.

CC = acc
OBJECTS = user_ activities out.o

CFLAGS = -0 -IS$S$SSTM _ROOT/etc/prt/c\
-I$$STM_ROOT/etc/sched -DPRT

all : out lib.a
out lib.a : $(objects)

ar rvu out_lib.a $(objects)
ranlib out lib.a

Assume that youwishto add afilemyfile.c andaheader myfile.n tothe prototype. The
User_MakefileShomd|00k“ke

CC = acc
OBJECTS = user_ activities out.o myfile.o

CFLAGS = -0 -I$SSTM ROOT/etc/prt/c\
-I$$STM_ROOT/etc/sched -DPRT

all : out_lib.a
out_lib.a : $(objects)

ar rvu out lib.a $(objects)
ranlib out_lib.a

myfile.o : myfile.h
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The following is an example of the user Makefile onaPC.

CC = cl

OBJECTS = user_ activities.obj

CFLAGS = /nologo /MTd /W3 /zd /Os
/I “$(STM_ROOT)\etc\prt\c”

/I “$(STM_ROOT) \etc\sched”

/D “PRT”

/D “LIB4WIN NT”

all : tmp out 1lib.lib
tmp out lib.lib : $(OBJECTS)

1ib $ (OBJECTS) /OUT:tmp_out 1lib.lib

user_ activities.obj : user_ activities.h)\

garage c_profmain.h\

garage_door.h

Executable Image

The resulting executable files are created:

*

*

Without the Debugger option selected in the profile:

<profile name>

With the Debugger option selected in the profile:

<profile_name>_dbg
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Exporting an Executable Image

To export a Rational Statemate-generated executable so it will run in a different directory or even
on adifferent computer, you just have to copy the contents of the output directory. At a minimum,
you have to copy the following files:

¢ Executableimage — <profile names Of <profile name> dbg depending on whether
the Debugger was requested in the profile.

+ If the Debugger was requested in the profile, select the following files

<profile_name>_dbg This file contains a symbol table needed to run the code with
the Debugger. If this file is not copied, you can still run the
executable, but Debugger facilities will not be available to
you.

help.dat Needed only if during execution you wish to use Debugger’s
online help.

+ If the compilation profile contains a panel, select the following files

<panel_name>.pnl This file is an ASCII representation of the panel.
stm_color_base Contains information on colors to be used during the panel
execution.

panels_displays.dat | Needed when the profile specifies that the panel is to be
displayed on a non-default terminal (for example., not the one
executing the code).

Note

To run the code on an operating system other than the one it was originally created on, you
must compile the source code aswell as al of the Rational Statemate libraries for that
particular operating system.
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Building the Runtime Modules on Foreign Platforms
The runtime modules consist of four libraries:

¢ libscheduler.a - timing and multi-threading
¢ libsim_scheduler.a - timing and multi-threading for simulated time mode
¢ libintrinsics.a - double buffers and callbacks support
¢ libdbg.a - the debugger.
The sources for the libraries are located in two different directories:

¢ The sourcesfor the scheduler arein $sTM ROOT/etc/sched.
+ The sources for the intrinsics and the debugger arein $sTM ROOT/etc/prt/c.

Supported Platforms

If you wish to build the libraries on any of the Rational Statemate supported platforms, there are
scripts that will compile and create the libraries in the source directories.

In the scheduler directory thereis a script that builds the scheduler library for a supported
platform. Specify the platform in the script’s argument. The following example creates a shell on
the Solaris platform:

create_sched sol

Theintrinsicslibrary is created with the following script, which islocated in stTM_rRooT/etc/prt/
c. Thefollowing example creates an intrinsics library on the Solaris platform:

create intrinsics sol
The debugger library is created with the following script, which islocated in sTM_RrRooT/etc/prt/

c. The following example creates a debugger library on the Solaris platform:

create_dbg sol
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Unsupported Platforms

The scheduler library, which supports tasking (multi-threading) and timing services, is platform
dependent. If you do not use tasking in your user _activities, Which isthe common case, then
you have to customize the software interrupts (signals) used for the timing services.

Implementation of the Timing Control

All the timing mechanisms areimplemented in thefile t imer . c. The scheduler usesthe UNIX signd
mechanism to implement these software interrupts. If your system isUNIX compliant, then you do not
have to modify the code. If your system does not support these cals, you haveto replacethe set
timer calswith other softwareinterrupt calls available on your system.

Implementation of Tasking Services

You have to implement the tasking system if you choose to:

+ |Implement primitive activities as tasks
¢ Useenvironment tasks

The heart of the multi-threading system is the context switching mechanism between threads. This
mechanism is not fully supported by C and involves machine-level coding. The context switching
isdone by the context switch routine, which you have to implement.

On some systems, the C setjmp, longjmp mechanisms perform context switching (on some
systems longjmp refuses to jump to higher stack addresses), but the initial thread setting must be
donein machine code. On some systems, there are vendor supported multi-threading libraries (for
example, lightweight processes on SUNOS) that provide library services for these purposes.
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Adding User-Written Code

This section describes supplementing Rational Statemate-generated code with handwritten code
(also called “user-written” code) You may include handwritten code as part of your Rational
Statemate model, and this code become part of the generated code, as well as part of simulation.

In cases where most of the code you are using is handwritten or from third parties, refer to Adding
STM Code Modules.

The Code Generator enables you to extend the Rational Statemate model by supplementing the
model with handwritten code. This means that you can implement those elements and aspects of
the system’s behavior that have not been explicitly defined by the controlling Statecharts and mini-
SpEcs.

You may want to use this feature to accomplish the following:

¢ Describe a particular function programmatically.
+ Interface to your own or athird party’s library.
+ Usecodethat already exists.
There are several ways to supplement the generated code:
¢ Attach existing code to the model through the Properties Editor and select one or more
languages in which to implement it (K&R C, ANSI C, or Ada).

¢ Write new code directly in Rational Statemate using the Rational Statemate Action
Language.

¢ Useagraphic to define afunction or procedure in a Procedural Statechart.

¢ Create a Truth Table to implement a subroutine, define a*“named action,” or describe an
activity’s behavior.

These methods enable you to add code that is used by both the Simulator and the Code Generator.
Rational Statemate stores the code in the model’s database and automatically includes it when you
run simulation or code generation.
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Supplementing the Model with Subroutines

The following sections explain how to add handwritten subroutines (functions, procedures, or
tasks) to your Rational Statemate model.

The method for adding all three subroutines in the Properties Editor is similar. The major
difference is that functions require a Return Type.

Note
In addition to storing subroutines in the Properties Editor, you can also store their formal
parameters.
{ STATECHART_TEST (Generic statechart) S x
|0 BB X B 5% [0 e
Mame: | Tefined In | Type | Def ;| Hode  [|=]
STATECHART _TEST StatechartiGy  Yes Update
i
General Definition |ﬂttributes e IDescription |§m;55"=nt»
GOS Usage...l
Paranster/Port || Tupe || Hode I Insert

Insert |
lelete |
Choose, .. |
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Entering Handwritten Code

Rational Statemate does not check your handwritten code. It is your responsibility to ensure that
the code islegal and compilable. You can usewith, use, include statements or any other
mechanism supported by the language to reference packages or include files. Rational Statemate
makes no attempt to interpret the code; it merely passes it on to the appropriate compiler.

To add your handwritten code to the template correctly, make sure you abide by therulesin the
following sections:

*

*

Referencing model elements in the code (Refer to Referencing Model Elements).

Mapping Rational Statemate types (primitive or user-defined) into C types for variables
and subroutine parameters (Refer to Mapping Rational Statemate Types into C).

Using synchronization services in tasks (Refer to Synchronizing Tasks).

Using Subroutines

After you define a subroutinein the Properties, it becomes part of Rational Statemate and is stored
as part of the model. Then, you can use the subroutine in the following ways:

*

*

*

*

Called in Rational Statemate actions and expressions.
Bound to a primitive activity of the modeled system, thus providing their implementation.
Bound to an external activity to describe behavior of the environment.

Bound as a callback to atextual or graphica element in the model, and called when the
element changes its value or status.

Disabling Subroutines

To disable a subroutine, open the Properties Editor and select Select | mplementation > None.

Rational Statemate does not implement the subroutine, and only generates atemplate (empty stub).
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Supplementing the Model with a Procedure

This section explains how to add a handwritten procedure to your Rational Statemate model by
showing the following:

+  Windows and how to complete them
+ Template that Rational Statemate produces
+ Template filled in with an example of handwritten code

Note

Rational Statemate also provides templates for functions and tasks. The subroutine’s
template is aresult of mapping the declarations into its C representation. This includes
mapping the parameter types and, in the case of functions, the returned value.

Complete the following steps to add a handwritten procedure:

1. Click O in the Properties Editor.
The New Element window opens.

D NewElement x|

Element. Hame:i

Chart Mame: IHETIHITY_EHHRT_TEST ‘:J Cancel |
Element Type: Data—Ttem = | _IHEIP

2. Enter the name of the new element.
3. Sdectits Chart Name.
4. Select Subroutine as the Element Type.

The Properties Editor appears with the name of the new subroutine.
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| ' REAR_DEFOG (Subroutine)
| W

STATECHART_TEST StatechartilG) Yez Update
FEAR_TEFOG STATECHART_TEST Subroutine Yez Update

5. Definethe Type as a Procedure.
6. Enter the procedure’s parametersif you want to store them.

7. Select aparameter and click Properties.

The Parameter window opens.
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Using Globals

If you wish to use the same parameters for multiple activities, you may want to define them as
globals. If so, click Globals Usage.

The global Usage window displays:

x
Hame || Hode ||_;|

Inzert |
Delete |
Ehuuse...l

=l

0K | Cancel | Help I

Globals are elements that are external to the subroutine, but are not listed as parameters. The
reading or writing of global datais called a side effect.

Writing more than once to aglobal element is considered racing. However, thisracing differsfrom
general racing where you have no way of determining which value will be assigned. In this case,
the final value will be the resulting value of the global element. Therefore, it isyour responsibility
to ensure that the subroutine writes to global elements only a single time during its execution.

Note

It is strongly recommended that you do not write global datain afunction called in atrigger
expression. Side effects written as part of atrigger will behave differently between
simulation and code.
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Producing a Template for a Procedure

To produce atemplate for a procedure, open the  mplementation menu to select alanguage for

the code. This example uses K&R C.

=
IDESE XB e B% 189
Mame ]DeFined Ln ]T pe: I]]E'F '] Hode ];l

INITIALIZE

DATABAME_TEST

Subroutine

vid BB
" Implementation ||_
v k&R C Code
AMSI C Code
Ada Code
Flowchart

Procedural Statechart
Statemate Action Language
Truth Table

LaookUp Table

External Tool

Best Match

External Code/MNone
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Rationa Statemate opens an editor and provides atemplate for you to attach your handwritten
code (refer to the following figure).

—| xedit I
Quit|Save|Loadlfth/fBAAaG9134
Use Control-5 and Control-R to Search. -
File /tmp/fBAAa09134 opened read - write.
»—
ftmp/ fBAAa09134 Read - Write -
IE
* Procedure: ADD_JOB_TO_RQ
*
* project:ALFHA_ 12
*
* author{s) :mikeh
* Creation date:May 5, 1997 13:53
*
*/
J*
* Global wvariables that are used by this Procedure:
* READY_Q In/Out
* RQ_TATL In/Out
*
*/

void ADD_JOB_TO_RQ(BUF_JOB)
PROCESS_CONTROL_BLOCK * BUF_JOB; /* Input Parameter */

{
} /* End of ADD_JOB_TO_RQ. */
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Filling in the Procedure’s Template

The following example shows the template filled in with handwritten code for a complete

procedure.

~| xedit

<[]

Quit|Save|LoadLfth/fCﬂﬂaO9134

Use Control-5 and Control-R to Search.

File ftmp/fCAAa09134 opened read - write.

ftmp/fCARA09134 Read - ¥Write
I
* Procedure: ADD_JOB_TO_RQ
*
* project:ALPHA 12
*
* author({s) :mikeh
* Creation date:May 5, 1997 14:17
*
*/
J*
* Global wvariables that are used by this Procedure:
* READY_Q In/Out
* RQ_TATL In/Out
*
*f

void ADD_JOB_TO_RQ({BUF_JOB)
PROCESS_CONTROL_BLOCK * BUF_JOB; /* Input Parameter
{

READY_Q [RQ_TAIL] = (*BUF_JOB);
RQ_TATL++;

} /* End of ADD_JOB_TO_RQ. */

*f

1t
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Subroutine Binding

To connect subroutines, open the Properties Editor for an activity and click Subroutine Binding
(refer to the following figure).

DATABANK_TEST.ACTIVITY#6 (Basic Activity)

DEEE X e %% i 58 s
Mame
DATABAME_TEST .ACTIYITY#E DIATABAMNE_TEST Activity ez Update

Gemeral Definition Iﬂttributes IDesign Attributes IDescriptiun IImplementation

Termination Tupe: IReactiue—Enntml led j

Selected Implementation:lﬁest Match | Truth Table: Edit...l Delete

Mini-Spect

Subrontine Binding.. | Conb, Assigrment.,.. |

The User-Added Code Binding window opens when you enter the name of the
subroutine, which is to be bound to the activity (refer to the following figure).

User-Added Code Binding i x|
Enable — |

Uzer-Added Code Binding:

TIMITIALIZE(A,B,C)
Ok | LCancel | Help |
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Supplementing the Model with a Task

This section explains how to add a handwritten task to your Rational Statemate model by showing
the following:

+  Windows and how to complete them

+ Template that the Code Generator produces
+ Template filled in with an example of handwritten code

Note

Rational Statemate also provides templates for functions and procedures. The subroutine’s
template is aresult of mapping the declarations into its C representation. This includes
mapping the parameter types and, in the case of functions, the returned value.

Complete the following steps to add a handwritten task:

1. Select File> New in the Properties Editor.

2. Namethe new element (in this example |O_RECEIVER), then select its Chart Name.

3. Select Subroutine as the Element Type. The New Element window opens.

Flement Mame: |ID_RE|:EWEﬁ

Chart Name: |STATECHART_TEST - Cancel

Element Tupe: Subroutine = nell?

1)

The Properties Editor window opens with the name of the new subroutine.
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I0_RECEIYER {Subroutine) N x|

DESB X4 % i85 MW =
Mame ||]]eFined In ||T5pe ||]]eF :|Hnde ||;|
REAR_DEFOG_TEST STATECHART_TEST  Subroutine fes  Update T
REAR_DEFOG_TEST_2 STATECHART_TEST  Subroutine Yes Update

/ER STATECHART_TEST Subroutine ez Update

I|:|_F.:E|::EI'I.

General Definition |F1ttr‘il:uutes Dezign Attributes |Description Implement‘atinnl

Type: IF‘r‘Dcedur‘e j
Select Impler_ﬂentatian:IBest Match j Global Usage,Hl

Parameter || Data Tupe || Made ||_ Inzert |

Delete I
Properties,,, I
Chooze, , ., I

4. Definethe subroutine Type asa Task (refer to the following figure).

5. Enter the task’s parameters if you want to store them in the . Select a parameter and click
on Propertiesto display the Parameter window..
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Using Globals

If you use the same parameters for multiple activities, you may want to define them as globals. If
s0, click Globals Usage.

' INITIALIZE (Subroutine)
0

INITIALIZE TATABANE_TEST Subroutine fes -|_|Fll:|.E|tE=

Inplenentations |ANST C Cods - 6
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Global Usage )

Mame || Mode ||_;|

Inzert
Ielete

Choose, , .

A

8 | Cancel | Help

Glaobals are elements that are external to the subroutine, but are not listed as parameters. The
reading or writing of global datais called a side effect.

Writing more than once to aglobal element is considered racing. However, thisracing differsfrom
genera racing where you have no way of determining which value will be assigned. In this case,
thefinal value will be the resulting value of the global element. Therefore, it isyour responsibility
to ensure that the subroutine writes to global elements only a single time during its execution.

Note

It is strongly recommended that you do not write global datain afunction called in atrigger
expression. Side effects written as part of atrigger will behave differently between
simulation and code.
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Using the Template for a Task

Select the Implementation tab to select alanguage for the code. Each available optionislisted in
the menu as shown in the following figure.

IR
DEBB XBE D% il 8 M e
Name ]DeFined In ]T pe ]]]eF '] Mode ];I
INITIALIZE DATABANK_TEST Subroutine Yes lUpdate
Bl
General |Definition Iﬁttributes Design Attributes IDescription Implementation |
N |0 B B
" Implementation ||_
v K&R © Code
AMSI C Code
Ada Code
Flowchart

Procedural Statechart
Statemate Action Language
Truth Table

Lookllp Table

External Tool

Be=t. Match

External Code/None

Note
Thisexample usesK&R C.

Rationa Statemate opens an editor and provides atemplate for your use to attach your handwritten
code as shown in the following figure.
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—| xedit [ -]
Quit‘Save‘LoadL/th/fCﬂﬂaog332
Use Control-5 and Control-R to Search. -
File /ftmp/fCAAa09362 opened read - write.
-
Jtmpf fCARaD9382 Read - Write
= “
* Task : IO_RECEIVER
*
* Project : OS5_SCHEDULER
*
* Author(s) : mark
* Creation date : May b, 1997 11:54
x
*/

*
* Global wariables that are used by this Task:

* TO_WATIT_Q In/Out

* T0_WQ_TATL In/Out

*/

i*

* Parameters that are used by this Task :

* PROCESS_CONTROL_BLOCK REQ_JOB; Input Parameter
* event I0_REQUEST; Input Parameter
*/event REQ_JOB_IN_TO_0O; Output Parameter
*

void TO_RECEIVER({)
Y /* IO_RECEIVER */
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Filling in the Task’s Template

The following figure shows an example of the template filled in with handwritten code for a

complete task.

Note
The edited template must be saved when compl eted.

— xedit

L1

Quit|Save|Loadlftmp/fBﬂﬂaO9382

Use Control-5 and Control-R to Search.

File ftmp/fBAAa09382 opened read - write.

Tt

ftmp/ fBAAA09352 Read - Write
*
j: Task : I0O_RECEIVER
: Project : 0S5_SCHEDULER
* Author{s) : mark
* Creation date : May 5, 1997 11:54
Y

*
* Global wvariables that are used by this Task:

* TO_WAIT_OQ In/Out

* TO_WQ_TATL In/Out

*f
/*

* Parameters that are used by this Task :

* PROCESS_CONTROL_BLOCK REQ_JOB; Input Parameter
* event ID_REQUEST; Input Parameter
* event REQ_JOB_IN_TIO_0Q; Qutput Parameter
k3

void IO_RECEIVER()
while {1}
{

wait_for_ewvent (I0_REQUEST) ;

/** got request for an I/0 service;

I0_WQ_TAIL = TO_WQ_ TATL+1;
TO_WATT_Q(IO_WQ_TATL).IO_WAITING_JOB = REQ_JOB;

f** after a short delay,

generate the confirmation event: **/
task_delay {(0.5);
REQ_JOB_IN_T0 Q = 1;

H
} /* IO_RECEIVER */

move the requesting job into If0 waiting queue:

TO_WALT Q{IO_WQ_TAIL).IO_REQUEST SATISFIED = false;

**/
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Synchronizing Tasks

This section discusses how primitive activities are integrated into the generated code.

User-written procedures are called when the system starts the corresponding activity (i.e.,
gl(<activity>)). In generd, the user code and the generated code share the CPU time. That is, when the
user code is executed, the Statechart’s code (or other user activities) are suspended.

Tasks

The task mechanism allows you to integrate continuous or synchronized code into the primitive
activity. For this purpose, the Code Generator provides a special library that extends the C
language to support tasking or multi-threading. (Refer to Scheduler Package, for details). Tasks
can be bound to either a primitive or an external activity.

The scheduler package allows you to define C functions as concurrent routines or co-routines. An
activity that you choose to implement as atask is started by the control code as a co-routine, which
is executed concurrently with the rest of the prototype. Since we are dealing with serial machines,
concurrency means that the control is switched between these co-routines without interrupting
their thread of control. That is, when the co-routine gets the control back, it resumes executing
with the exact context it was before.

This mechanism allows the activity to use delay statements, wait for events, and perform
continuous cal cul ations without blocking the rest of the code from continuing execution. When a
task is executed, however, the rest of the code is frozen. Thus, synchronization points are
introduced. They allow the rescheduling of other tasks (or the control code) to proceed and actions
(stop, suspend) to take effect.

Synchronization

There are three types of synchronization calls:

+ wait_for_event(event)

+ task delay(delay time)

+ scheduler()
Each of these calls will suspend the calling task and reschedule another task or themain task
(statechart) on around-robin basis.

Thewait for event cal suspendsthe activity until the specified event isgenerated. Itisaway to
synchronize the activity with other activities either user-implemented or statechart-controlled. When the
event is generated, the code resumes execution after the wait call.
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Example:

void sense start ()

while (1) ({
wait_ for event (SENSE) ;
/* here you are supposed to check status.*/
printf (“Time generated\n”) ;

} /* end sense start */

The task_delay Statement delaysthe activity for thetime specified inthecall. It isuseful to implement
polling processes that periodically perform checks on atime basis.

Example:

void poll input ()

while (1) {
mouse input = read input from mouse() ;
if (mouse_ input) {
. Do Something .

task delay(0.1); /* delay 0.1 seconds */

}

The scheduler () cal isused when you have a cal culation which istoo long to be executed non-
preemptively. For example, if you have to multiply two 10000x10000 matrices, you do not want the rest
of the system to be blocked dl that time.

The scheduler () cal will allow other activitiesto proceed and the calling activity will resume
execution in the next available time slot unless a stop or suspend command was issued. The call
should be placed in aloop in which one cycle can be executed without preemption, but an outer
loop may take too long.

Note
No synchronization call should be used by a procedure-implemented activity.

Example:

void multiply ()

for (i = 1; 1<=10000; i++) {
for (j = 1; j<=10000; j++) {
/* internal loop is short
enough to complete */

scheduler () ;
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Scheduler Package

The user can specify that some of the primitive activities are to be implemented astasksin the
Profile Editor. The tasks are actually C functions started as co-routines. The Statechart code itself
isatask, which runs concurrently with the other running tasks.

Controlling all those tasksis the responsibility of statecharts, which issue different actions to the
different activities (i.e., start, stop, suspend, resume). All thisis handled by a scheduler package,
which is supplied with the Code Generator and is available on Rational Statemate platforms only.
This package supports multi-tasking programming within the context of a single process.

Below we describe how the user may add his own tasks, apart from those created for each task-like
primitive activity, and how to use the scheduler for controlling them.

Status of a Task

Each task may be in one of four states:

¢ Current - Thetask is executing
¢ Ready - Thetask isready for execution
¢ Delayed - Thetask iswaiting for some event to occur
¢ Sopped - Thetask is not active
The calls that change the status of atask are described in the following section.
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Scheduling Policy

The context switch between tasks is done only in the following synchronization points:

*  When atask explicitly callsthe scheduler. Thisis done by calling the following routine:

scheduler ()

If there are other ready tasks - one of them (chosen in around-robin manner) becomes

current, while the calling task becomes ready. If there is no other task ready, the calling
task continues its execution.

¢ Whenatask issuesadelay request by calling task delay. Thecalling task then
becomes delayed.

*

When atask calsawait for event service. The calling task then becomes
delayed.

wait for event (EVENT)
event *EVENT;

+ After the task function performs areturn, it stops.

Restrictions

Any call to process blocking functions (for example, sleep, scanf) of the operating system from a

task will hibernate not only the calling task, but the whole process. Using fork () and Sgnadsisaso
not alowed, since it might confuse the scheduler.
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Binding Callbacks

Callbacks are a powerful mechanism that enable you to connect user-actions or proceduresto any
changein aRational Statemate element during execution. This mechanism isvery useful when you
wish to tie your external environment to the behavior represented by the generated code.

Callback Binding

To connect elements such as events, conditions, data items, and user-defined types, use the
following procedure:

1. Select the element in the Properties Editor

2. Select the Implementation > Callback Binding .

Callback Binding __ = il
Enable —l|

Callback Binding
il

Ok | Cancel | Help |

Note
Thefollowing figure is an example of a Callback Binding

68 Code Generation Reference Manual



Binding Callbacks

Callback Binding ____ il

Enahle — |

Callback Binding

X

FRIMTLINT“TIRR (0% "
FRIMTLINTC TIRR (1"
FRIMTLINT TIRR 23"
FRIMTLINT TIRR (37
PRIMTIIMT TIAR (43"
FRIMTLINT{ TIRR (527 ¥
PRINT_MTH_INT{”DAR”, OLD_N,DAR{OLD_M3 3]

SRR
CIARGL
CIARGZD 0
AARGZ
SRR
ARG

*
*
*

(I8 I

Cancel |

Help |

Callback Statement

The connection and binding statement syntax for callbacks consists of:

proc_name (<“element_ identifier”>,param_1,param 2)

Wherethe <element identifiers isrequired when and only when the callback is
connected to an aggregate element. An aggregate element is an array, record, union, user-defined
type, or any element referenced in a generic or instance. The <element_identifier> specifies what

part of the aggregate element the callback is to be connected.

Disabling Callbacks

To disable a callback, change the Enable option in the Callback Binding dialog to Disable. This
causes the Code Generator to generate code, but it “breaks’ the code’s connection with the

element.
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Callback Example

Thefollowing exampleillustratesthe Rational Statemate callback utility. It shows two subroutines
that are bound to the callback DAR. Every time the DAR element changes, Rational Statemate
executes both of these subroutines.

To create a subroutine, start with the steps shown in Supplementing the Model with Subroutines.

CCPRINT NTH INT (Subroutine) x
DES B XS5 Q405 e
Mame | Tiefined In | Tupe | Def || Hode  ||.ad

PRINT_MTH_INT

General Definition II’-‘Ittr‘iI:uutes Dezign Attributes I]]esu:riptiu:n Implementatiunl

Type: IPrDcedure j

Select Implementati-:un:lBest Match j Glabal Llsa-_gm”l

Farameter || Data Tupe (| Hode ||_ Inzert |

IDENT String In G |
PARAM Integer In
Choose, , . I

The following figures show the code for the subroutines. The first oneisthe PRINT1INT
procedure; the second oneisthe PRINT NTH INT procedure.
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= xedit |-
Quit|Save|Load¢/tmpffD333001J2
Use Control=5% and Control-R to Search.

-
File /tmp/fDARAa001T2 opened read - write.
-
Jtmp/ fDAAAQ01T2 Read - Write
7* -
* Procedure: PRINT1INT
+*
: project:ALPHA_12
* author(s):stango
* Creation date:Mar 27, 1997 18:43
ko
*/

*

* Global wariables that are used by this Procedure:
* None
k3

*f

void PRINT1INT{IDEHNT,VALUE)
char * IDENT; /* Input Parameter */
int VALUE; /* Input Parameter */

pfintf(" The new value of %s is %d \n", IDENT, VALUE);

} /* End of PRINT1INT. */
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*

* Global variables that are used by this Procedure:
* Hone
*

*/

void PRINT_NTH_INT({IDENT,N,VALUE)
char * IDENT; /* Input Parameter */
int H;
int VALUE; /* Input Parameter */

} /* End of PRINT_NTH_INT. */

—| xedit gl
Quit|Save|LoadlftmpffBﬂﬁaOOODX

Use Control-8 and Control-R to Search. -
File ftmp/fBAAa0OODX opened read - write.

.
ftmp/ £BAAaQOODX Bead - Write

[ ]
* Procedure:PRINT_NTH_TINT
*
* project:ALPHA_12
k3
* author({s) :stango
* Creation date:Mar 27, 1997 16:43
k3
*/

pfintf{" The %dth element of DAR changed to %d Yn", N, VALUE);
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Referencing Model Elements

Communication between the handwritten code and the generated code is accomplished through the
semantics of the following information elements:

¢ Events

¢ Conditions

¢ Dataitems

¢ User-defined types
It isimportant to understand how to access the values of these elements and how to modify them.
Each element has the following representation in the C target language:

¢ Conditions are represented as bytes

¢+ Dataitems are represented as integers, reas, strings or unsigned

¢ User-defined types are derived from primitive data-types
When you wish to pass structured elements (such as records and unions) from Rational Statemate
to your handwritten code, you must define these elements as user-defined types.

When you write code in the templ ate, refer to all elements by the names you assigned in the model.
This applies to parameters of the subroutine, itslocal and global variables, to names of types,
constants, and any other subroutines that you may use for the implementation.

Note
Write all element names in uppercase.

Referencing Events

Events are primitive elements and are special in the sense that software languages do not support
them directly. Events are not allowed in subroutines as inputs, outputs, local variables, or
accessible as global elements.

Events, in relation to handwritten code, are used in the following manner:

¢ Callbacks- You can associate a callback with a Rational Statemate event.
¢ Tasks-Youcanusethewait for event cOmmand to react to a Rational Statemate event.
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Where Elements are Defined

An element can be local to amodule or global to aprofile. The element is globally defined when it
is referenced by more than one module, for example, defined in the top-level module. Each
module “exports’ al itslocal elements as externalsin its header file.

This allows other user modulesto access them. If you want to reference an element you must refer
to its scope by including the appropriate header file. An example is shown below.

Example:

If you want to reference (for example) an element BAUD_RATE in modul e display, you should
include the header file “display.h” to make the element visible.

/* my module */
#include “display.h”

br = BAUD_RATE ;

Accessing an Element Value

Since the element is a simple language element, it can be easily accessed by referring to its name.
Example:

my data = XXX + YYY ;
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Mapping Rational Statemate Types into C

The following table shows how Rational Statemate maps primitive types into corresponding C

types:

Note

Rational Statemate Types C Type
Conditions char (byte O-false, 1-true)
Integer int

Real double

Bit bit_array[1]

Bit array unsigned int

User Type struct

Record struct

Union struct

Enumerated Types typedef

All Rational Statemate elements of type string are trandated into alocated C elements.

Records

Records become C constructs. For example, a record | N\VO CE_TYPE
might become a structure defined as:

typedef struct | NVO CE_TYPE {
char NAME[ 80+1] ;
char |1 TEM 80+1];
real AMOUNT;
} INVO CE_TYPE;

Note that the name | NVO CE_TYPE is normally named the same as the
User-Defined Type name. If, however, the Rational Statemate model
contains multiple textual elements with the same name, the C code names
will be modified to make all the names unique. This name mapping
information is listed in the .info file.

Unions

Unions become C unions with a declaration that is similar to the construct
definition for records.

Arrays

Elements of all arrays in C are enumerated starting from 0. In Rational
Statemate, there is no such restriction.
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Enumerated Types

An Enumerated Type is a user-defined type with a finite number of values.

Enumerated values and other textual items cannot have the same name
within the same scope. For example, data-item SUN cannot be declared in
the same chart where an enumerated value SUN is declared.

Enumerated range and indices of arrays are not supported in C. The C code
generator shall approximate this capability in the generated code.

There are two constant operators and five general operators for enumerated
types:

Constant Operators

en_first(T) First enumerated value of T
en_last(T) Last enumerated value of T

Parameters to these constant operators are user-defined types that were
defined as enumerated types.

General Operators

en_succ([ T ]VAL) Successor enumerated value of
T

en_pred([T'] VAL) Predecessor enumerated value
of T

en_ordinal ([T ] VAL)

Ordinal position of VAL in T
en_val ue(T, 1)

Value of the i'th elementin T
en_i mage([ T' ] VAL) String representation of VAL in T

Parameters to these operators are either enumerated values (literals) or
variables. The T'VAL notation is used for non-unique literals.

Bit Arrays

Bit-arrays are stored in unsigned ints. Since unsigned ints can hold a
maximum of 32 bits, bit-arrays larger than 32 bits are stored in arrays of
unsigned ints. Arrays of bit-arrays are stored in two dimensional arrays of
unsigned ints. Notice that multiple bit-arrays smaller than 32 bits are NOT
packed into the unsigned int.

Data-ltems*

Results in these
structures

BAlis array 1 to 10 of Bit-array 31 t0 0 bit_array BA1[10][1]

BA2 is array 1 to 10 of Bit-array 48 to O bit_array BA2[10][2]

BA3 is array 1 to 10 of Bit-array 3t0 0 bit_array BA3[10][1]

*In $STM_ROOT/ et c/ prt/ c/ types. h you will find the statement:
typedef unsigned int bit_array
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Bit-Array Functions

bit array *AND(bal, 1 bal, froml, tol, ba2, 1 ba2,
from2, to2)

bit array *bal;

int 1 bal;

int froml;

int tol;

bit array *ba2;

int 1 ba2;

int from2;

int to2;

bit_array *NOT (bal, 1 bal, froml, tol)
bit array *bal;
int 1 _bal;
int froml;
int tol;

bit array *OR(bal, 1 bal, froml, tol, ba2, 1 ba2,
from2, to2)

bit array *bal;

int 1 _bal;

int froml;

int tol;

bit array *ba2;

int 1 _ba2;

int from2;

int to2;

bit array *XOR(bal, 1 bal, froml, tol, ba2, 1 ba2,
from2, to2)

bit array *bal;

int 1 bal;

int froml;

int tol;

bit array *ba2;

int 1 ba2;

int from2;

int to2;
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The following bit array function names are mapped through macros to their internal names,
because these names are used by Adaruntime libraries, therefore they cannot be defined as
functionsin the intrinsics. (These same intrinsics are used by C and Ada environment.) It is

important to include the types.h header containing these macros.

#define
#define
#define
#define
#define
#define
#define
#define
#define
#define
#define

The functions are:

ASHR ashr

LSHL 1shl

LSHR 1shr

BITS OF bits of
CONCAT_BA concat_ba
EXPAND BIT expand bit
SIGNED signed b
MINUS minus_ b

NAND nand_b

NOR nor b

NXOR nxor

bit_array *concat_ba

(bal,1 bal,
bit

int
int
int
bit

int

int
int

bit array *lshr (ba,
bit_

int
int
int
int

bit array *1lshl (ba,
bit_

int
int
int
int

int signed b(ba_val,
bit_

int
int
int

bit array *ashr (ba,
bit .

froml,
array *bal;

tol, ba2, 1 ba2, from2,to2)

1 bal;
froml;

tol;

array *ba2;
1 ba2;
from2;

to2;

len ba, from, to, shift)
array *ba;

len ba;

from;

to;
shift;

len ba, from, to, shift)
array *ba;

len ba;

from;

to;

shift;

len, from, to)
array *ba val;

len;

from;

to;

len ba, from, to, shift)

array *ba;
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int len ba;
int from;
int to;

int shift;

bit array *nand b(bal, 1 bal, froml, tol, ba2, 1 ba2,
from2, to2)

bit array *bal;
int 1 _bal;

int fromil;

int tol;

bit array *ba2;
int 1 _ba2;

int from2;

int to2;

bit array *nor b(bal, 1 bal, froml, tol, ba2, 1 ba2,
from2, to2)

bit array *bal;
int 1 _bal;

int froml;

int tol;

bit array *ba2;
int 1 _ba2;

int from2;

int to2;

bit array *nxor(bal, 1 bal, froml, tol, ba2, 1 ba2,
from2, to2)

bit array *bal;
int 1 bal;

int froml;

int tol;

bit array *ba2;

int 1 _ba2;
int from2;
int to2;

Use the following functions to convert between integer and bit-array types:

bit array *int2ba(int_ wval)

int int val;

int ba2int (ba, len, from, to)

bit_array *ba;
int len;

int from;

int to;
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Rules for Mapping into C
The following table summarizes the rules of mapping into C for:

* Types of parameters for procedures and functions
¢ Returned type of functions

Note

¢ Thefirst level of al arrays should be defined asuser-defined type inorder to restrict

the “second” dimension.

Unrestricted strings and bit-arrays are not allowed as returned type of afunction.

Numeric Input parameters can be mixed up i.e., integer, real and bit-arrays can be mixed

when used as actual and formal parameters.

Type Function Type In Param Out/InOut Param
Primitive (*) int f(); int P; int *P;
UDT defined as Primitive | UDT f(); UDT P; UDT *P;
Record/Union rec *f(); REC *P; REC *P;
String char *f(); char *P; char *P;
UDT defined as String char *f(); UDT P; UDT P;
Bit BIT_ARRAY *f(); BIT_ARRAY *P; BIT_ARRAY *P;
Bit-array BIT_ARRAY *f(); BIT_ARRAY *P; BIT_ARRAY *P;
UDT defined as Bit-array | BIT_ARRAY *f(); BIT_ARRAY *P; UDT *P;
UDT Array of Primitive int *f(); UDT P; UDT P;
UDT Array of String -- lllegal -- UDT P; UDT P;
UDT Array of Bit-array -- lllegal -- UDT P; UDT P;
UDT array of direct R/U -- lllegal -- UDT P; UDT P;
UDT array of UDT2 UDT?2 *f(); UDT P; UDT P;
Array of Primitive -- lllegal -- int *P; int *P;
Array of Record/Union -- lllegal -- -- lllegal -- -- lllegal --
Array of String -- lllegal -- char *P; char *P;
Array of Bit-array -- lllegal -- BIT_ARRAY *P; BIT_ARRAY *P;
(*) Primitive type is one of: integer, real, condition, or enumerated type. In the above matrix,
integers are taken as example.
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Running User Code on Solaris 2.9 or 2.10

Running user code on Solaris 2.9 or 2.10 needs a specia treatment regarding the libraries
libscheduler.so and libsim_scheduler.a.

These libraries should be replaced with the following ones - libscheduler2_9.so and
libsim_scheduler2_9.a.or libscheduler2 10.s0 and libsim_scheduler2_10.a.

¢ Running Generated Code

In order to compile and run generated code on Solaris 2.9 or 2.10, the Solaris target file
should be modified by replacing the following library options:
¢ Ischeduler2_9 or Ischeduler2_10
¢ libsim_scheduler2_9aor libsim_scheduler2_10a
¢ Running a Simulation with User Code
No changeisrequired. The correct library is selected automatically according to the
operating system.
¢ Compiling Runtime Libraries

Runtimelibrariesfor Solaris 2.9/2.10 must be compiled on a Solaris 2.9 or 2.10 system. In
addition, the following compilation flags are required:

“-D MAKECONTEXT V2 SOURCE -DSOLARIS 29"
or

“-D_MAKECONTEXT V2 SOURCE -DSOLARIS 210"
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To obtain awaorking prototype of the system, you can extend your handwritten code with Rational
Statemate code modules. Use this option when most of your model consists of handwritten code,
but you want to supplement it with some Rational Statemate-generated code.

Note

When the majority of your model consists of Rational Statemate-generated code, refer to
Adding User-Written Code.

This section explains how to generate Rational Statemate (or STM) code modules. The module’s
format makesit easier to take the generated code out of Rational Statemate and incorporateit into
your handwritten code.

Normally, Rational Statemate-generated code consists of an entire executable that includes the
main, scheduling, data management, interrupt handling, and all other necessary services. Since you
are supplying these services, you only need a self-contained module. This option generates a
module of code rather than the entire executable.

These modules are as follows;

+ Cadlable from the handwritten code
+ Accept and return values
+ Perform either a step or a super step when started

Modules, however, do not communicate or synchronize with any other Rational Statemate
modules. Your handwritten main body must perform the communication or synchronization
functions between Rational Statemate-generated modules.
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Generating Modules of Code

Complete the following steps to generate a self-contained module instead of an entire executable:

1. Select the Options > Global Profile Settings menu item from the Profile Editor’s main
menul.

The Global Profile Settings window opens.

x
Language: K&k C | Tlouble-Buffer Dptimizatinn...l
Hodularity Style: Balanced Mixture — | ¥ Uith Debugger
Generation of main: Entire Executable = | r-Graphical Back Animation
Infinite Loop Limit:W Tarts ININIIEINSNT j

Target Directoryt I

Packagez/Headers for External Subroutines:

Truth Table Executioni Upon Change .Jl
Ok | Cancel | Help |

2. Select Module Procedures Only from the Generation of main field.
3. Click OK.

Note

Because the modules are not executabl es, the Code Generator disables Main Setting, With
Debugger, and Graphical Back Animation. The Panels button in the Profile Editor main
screen is also disabled.
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Setting Module Parameters

After selecting M odule Procedures Only, you can set the parameters for an individual module.
Complete the following steps to set parameters:
1. Select amodulein the profile.

2. Select Options> M odule Settings from the Profile Editor’s main menu.

The Module Settings window opens.
x
Module Mame: REAR_DEFOG
I_ Swpar st Flle oper Bnotecharn

Farameter Settin9+.+|

K | Cahcel | Help

Note: Because you selected M odule Procedures Only in the previous procedure, the
Code Generator disables Separ ate File per Satechart, and enables
Parameter Setting.

3. Click Parameter Setting. The Parameters for Module xx window opens.

" parameters for Module REAR_DEFOG x
Parameter || Type |Itads ||
Inzert |
Delete |
Ehoose...l
i
K | Cancel | Help |

Note: The order in which you enter the parametersis very important since thisisthe
order in which they appear in the <module name> init function.
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4. Enter the Type (Data-Item, Condition, Event) and M ode (IN, OUT, IN/OUT) parameters
for the selected elements.

5. Click Choose to select additional parameters. The Selection of Module Parameters
window opens
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Generated Procedures and Files

When you generate code with M odule Procedures Only, each module generates the following
procedures and files.

Generated Procedures
Modules generate the following procedures:

¢ <module name>_init () initializesthe module. If the moduleis already active, calling it
again re-initializesit. This procedure accepts all the elements that communicate with the

modul e as parameters. Calling the module with these parameters performs the actual-to-
formal binding.

¢  <module name>_exec () callsthe module and executes either asingle or a super step
depending on how the module is called.

* <module name>_status () returnsthe module’s status which can be in one of the
following states:

¢ return module stable
¢ return module terminated
¢ return module_working

Generated Files
Modules generate the following files:
¢ <module name>.c - Containsthe code for the module, al the procedures listed above,

and the declarations for all the textual elementsin the procedures.

¢ <module name>.h - Istheincludefilethat includesall typesand externa declarations
defined within the MODEL scope of the related module.

¢ <procedure name>.c - Containsthe code for functions/ procedures. Thisis consistent

with the rest of the generated code where separate files are generated for each function
and procedure used within the related model scope.

¢ TOP <module name>.h - Containsdeclarations of types defined outside (above), but
used within the modul e scope.
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Sample Code Module

The code samples show what the code looks like when you perform the following tasks:

*

*

*

*

Generate code with M odule Procedures Only selected. Refer to example.c.
Generate the makefile. Refer to Generated Makefile.

Generate the makefile and then modify it to work with your handwritten code. Refer to
Modified Makefile for more information.

Include the main in your code. Refer to my_main.c for more information.

The Statechart in the following figure describes the sample module.

ZCOUNTER : =THPUT_VALUE 3
ONTIHUE ;=0

[LOOPCOUNHT=101

CLOOPCOUNT{101/
LODPCOUNT ;=LOOPCOUNT+13
COUHTER :=COUNTER+1

[CONTIHUE=11/
CONTIHUE ;=0

[INPUT_VALUE/=991/ = .
COUNTER:=INPUT_YALUE; LINPUT_YALUE=331
LODPCOUNT ;=0
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example.c

The following code sample illustrates how the generated code |ooks when you select M odule
Procedures Only.

/* o *x/

/* Created: 16-MAY-1997 */

/* Compilation Profile: profl */
/* File Name: example.c */

/* o x/

void example init module (instance, INPUT VALUE, COUNTER, _CONTINUE)
sw_module ptr *instance;
int *_INPUT_VALUE;
int * COUNTER;

int * CONTINUE;

} /* example init module */
sw_module status example exec (instance, single_ step)

sw_module ptr instance;

boolean single step;

} /* example exec */
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sw_module status example get status(instance)

sw_module ptr instance;

Generated Makefile

The following shows the generated makefile.

all : out lib.a
CC = cc

OBJECTS = \
job_man_dictionary.o\
example.o\
init_queue_tail sc.o\
job_priority sc.o\
remove_ job_sc.o\

empty queue_sc.o

CFLAGS = -O -IS$SS$SSTM ROOT/etc/prt/c -I$$SSTM ROOT/etc/sched -DPRT -
Dsparc

out lib.a :$(OBJECTS)
ar rvu out lib.a $(OBJECTS)

ranlib out_lib.a

example.o :example.h
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Modified Makefile

The following shows the makefile that has been modified to work with handwritten code.

all : my main
CC = cc

OBJECTS = \
example.o \
my main.o

CFLAGS = -g -I$$STM ROOT/etc/prt/c -IS$S$STM ROOT/etc/sched -DPRT -
Dsparc

out lib.a :$(OBJECTS)
ar rvu out lib.a $(OBJECTS)

ranlib out_lib.a
my main : out lib.a Makefile
$(co) $ (CFLAGS) -o $@ \
my main.o example.o \
-L$$STM_ROOT/1lib -lintrinsics -1lscheduler -1m

my main.o

example.o :example.h

Rational Statemate
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my_main.c

/* my main.c */

#include <stdio.h>
#include “types.h”

#include “example.h”

main ()

int CONTINUE=0;
int ACTUAL DI=0;

int COUNTER_INIT=0;

sw_module ptr MODULE HANDLE=0;

sw_module status MODULE_STATUS;

example init module(
&MODULE HANDLE,
&CONTINUE,
&ACTUAL DT,
&COUNTER_INIT) ;

while (MODULE_STATUS != module terminated)

{

The following shows a sample .c file that you would have to write. It contains the main for
example.

These include files enable you to:
e Print

¢ Access Rational Statemate’s type
definitions ($STM_ROOT/etc/
prt/c/types.h)

* Access the model’s type
definitions

These variables map to the model’s
parameters.

These are the handle and
status variables for this
model.

This call initializes the module and
“binds” or “maps” the parameters
that you defined when you created
the profile.

Loop until module terminates.

printf (“Enter value to initialize counter (99=quit)\n”);

scanf (“%d”, &COUNTER_INIT ) ;

CONTINUE=1;

Get an initial value for the counter.
Notice that to set the input
parameters, there are no Statemate-
specific calls.
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while ((MODULE STATUS == module working) || CONTINUE)

{

MODULE STATUS = example exec (MODULE HANDLE,

Loop as long as the module is
working or the CONTINUE variable is
true. Set CONTI NUE after changing
the inputs to the module.

1);

Execute a single step. The second
parameter is true (1) for a single
step, and false (0) for a superstep.

printf (“Counter value = %d \n”, ACTUAL DI);

printf (“Module Status - %d \n\n”, MODULE_STATUS) ;

printf (“ Statemate module has terminated \n”);

Print the desired variable and status.
Notice that there are no Statemate-
specific calls.

To reach this point, the module must
return a module_terminated status,
which means it reached a
termination connector.
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The Code Generator Debugger helps you find errors in the specification in amanner similar to
symbolic debuggers used for conventional high-level programming languages.

The Debugger can locate specification errorsin terms of the Rational Statemate specification
objects (states, activities, events, conditions, and data-items), rather than in terms of the generated
code. In fact, most users of the prototype code do not know the structure and content of the code.

This section explains how to:

+ Control the execution by stopping at chosen breakpoints (e.g., when selected events occur)

+ Monitor the execution by examining the current status of states and activities, values of
events, conditions, and data-items and by inspecting scheduled timeouts

+ Affect execution by modifying event, condition, and data-item values

+ Create execution trace files for off-line analysis by choosing specification objects to be
traced

The Debugger has an interactive command language through which you control the debugging
session. Predefined command sequences can be stored in files and started during the session.

The Debugger also has an online help facility. It provides information on command syntax and
usage.
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Generating Prototype Code With Debugging Facilities

To enable the Debugger and produce prototype code with debugging facilities, check the With
Debugger option under the Options menu. Refer to Selecting Code Parameters for moreinformation.

Compilation and link of the generated code result in an executablefile called
<profilename> dbg. By default, the Code Generator storesthisfilein your workareaunder the “prt”
subdirectory.

A program generated with the Debugger facility consumes more memory and is slower to execute.
Therefore, at the point in the specification development that you no longer need the debug facility,
you may want to generate a prototype without the Debugger to obtain code with better
performance.

A Debugging Session

A debugging session consists of alternating modes of operation when the prototype is executing
and when the prototype pauses its execution and allows debugging commands to be entered. When
the prototype is executing, it behaves as defined in the specification. When the execution pauses,
you may enter debugging commands.

The executing prototype enters the debug mode in the following cases:

+ Whenyou first invoke the debugging prototype

+  When abreakpoint event occurs

+ After completing a specified number of steps through the execution
+ By explicitly interrupting the execution with Control-C
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Prototype Behavior In Debugging Session

Switching from execution mode to debug mode and entering debugging commands can have
unintended side effectsin areal-time system. Thisis because, in debug mode, input events are not
processed and the Debugger commands may put the system into a status that could not have
otherwise been reached. More specifically, during the time the debugging prototypeisin debug
mode, the following takes place:

¢ Controlsof all nonprimitive activities remain in their current state configurations
¢ Each primitive activity remains at one of its synchronization points

+ All changes of events, conditions and data-items produced by the specification’s
environment are ignored. In debug mode, these elements can be changed only via
debugging commands.

¢ Systemtimeisnot advanced. Asaconsequence, time-out events and scheduled actions are
delayed. They progressin time only when the execution is not in debug mode.

Note that in many practical situations, you may have enough control of the actual environment to
avoid the loss of events and values. For example, assume that the interaction with the prototype is
performed via a graphic control panel and events are generated by clicking the mouse on graphica
buttons. Inthis Stuation, no events are generated and lost if you refrain from clicking any of the graphical
buttons while in the debug mode.

Also, if necessary, you can explicitly enter the events and other value changes that are needed to
get correct prototype behavior manually, viathe appropriate Debugger commands (SET EVENT,
SET CONDITION, and SET DATA_ITEM). Thismust be done with caution since dl these events
and va ue changes are considered as happening smultaneoudly, at the first step that followsthe
resumption of the execution.

Switching from execution mode to debug mode does not, by itself, cause any change in the current
status. Entering debug mode is different from the Rational Statemate suspend action. In particular,
conditions of type hanging(A) do not become true. Similarly, resuming the execution does not
make these conditions false.
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Debugger Command Conventions

The Debugger commands, which are described in detail later in this section, are divided into four

groups.

Session Control

QUIT

Exits the debug mode.

GO

Starts or resumes execution of the prototype.

STEP

Executes a number of steps of the prototype.

LOAD

Reads and executes Debugger command files.

SET OUTPUT

Logs a transcript of the session to a file and/or the
terminal.

HISTORY

Re-executes previously entered commands.

HELP

Provides on-line help for Debugger commands.

Monitoring and Modifying Object Values

LIST Lists the specification objects.
SHOW Displays the status of the objects.
SET Modifies the status of the objects.
PUT, UPUT, FLUSH Modifies the status of queues.

Creating Trace Files

SET TRACE

Instructs the Debugger to report every time an
object changes its status.

SHOW TRACE

Shows which objects are being traced.

CANCEL
TRACE

Cancels a previously requested trace.

SET TIME

Puts time stamps in trace messages.

CANCEL TIME

Cancels time stamps in trace messages.
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Handling Breakpoints

SET BREAK Instructs the Debugger to pause the
specification’s execution and enter debug mode
when a specified event occurs.

SHOW BREAK Shows which breakpoints are active.

CANCEL BREAK Cancels previously set breakpoints.

Reference to Rational Statemate Objects

This section describes how to refer to Rational Statemate objects in Debugger commands.

Rational Statemate Objects Classes and Subclasses

Different Rational Statemate objects can be manipulated in different ways in the debugging
prototype. In Rational Statemate specifications there are nine basic classes of objects:

Action Activity Condition
Data-item Event Flow Line
State Transition User-Defined Type

Some classes of Rational Statemate objects are further subclassified. Some Debugger commands
work only with specific subclasses. The following table summarizes the classes and subclasses:
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ACCESSIBLE IN
CLASS SUBCLASS DEBUGGING
PROTOTYPE
Activity Primitive Yes
Non-Primitive
Condition External Yes
Internal
Data-item External Yes
Internal
Event External Yes
Internal
State Basic Yes
Non-basic
Action No
Flow-line No
Transition No
User-Defined Type Yes

States

You can review the moddl’s current state by typing the SHOW STATE command. You cannot
change the configuration to be a set of specific sates by directly naming those states.

Subclasses: Basic/Non-Basic - astate is basic if it is not decomposed into substates.
Activities

The status of activities can be inspected while in debug mode viathe SHOW ACTIVITY
command. Thereis no direct way to sart, op, suspend and resume an activity from the Debugger.

Subclasses: Primitive/Non-Primitive - an activity is considered primitive in one of the following
Cases.

* [tispart of the lowest level of decomposition in the activity-chart, i.e. it does not contain
any subactivities and has no controlling statechart.

+ |t contains subactivities and/or has a controlling statechart but the user has requested that
it be treated as a stub when creating the prototype.

For primitive activities, the Code Generator generates only templates. These templates must be
completed manually with the code describing their behavior.
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Events, Conditions and Data-items

User-

You can refer to events, conditions and data-items by name, and inspect the values of any event,
condition or data-item (with the exception of structured data-items). You can modify the values of
any primitive condition or data-item as well as generate any primitive event. An event that is
generated is said to be active.

Subclasses: External/Interna - Events, conditions and data-items produced by an external or
primitive activity are external. If produced by a control activity, then they areinternal. Notethat it is
possiblefor an event, condition or data-item to be both internal and external. When you modify the
value of anitem that does not come from the environment, then you are cheating and changing the
model’s behavior. If you change data coming from the environment, then you are simulating the
environment.

Defined Types

User-Defined Types can be accessed by name. The SHOW and the L1 ST commands can be used
to view the type and its structure. User-Defined Types cannot be modified from the Debugger.

Actions

Flow

There isno way to invoke a Rational Statemate action by its name. Most of the action syntax is
available through the appropriate SET command. Only scheduled actions and actions on activities
cannot beissued from the Debugger.

Lines

Flow linesin activity-charts are not modeled in the prototype. Flow lines signify that data from
one activity are available to another activity; they do not model a specific channel through which
the data flow. Therefore, though the data that flows through the flow lines is accessible to the
Debugger, the flow lines themselves are not. The existence of flow linesin the activity-chart
determines the externality of the element and whether it is available for use by the environment
and primitive activities.

Transitions

You cannot command the prototype to perform a particular transition. However, you can set the
proper events, conditions and data-items so that the trigger of atransition leading from a currently
active state becomes enabled - and the transition is taken in the following step. Also, thereis no
guery of available transitions or relevant object.
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Names and Synonyms

In Debugger commands, you refer to al objects by name. If the object has a synonym, then you
can also refer to it by synonym. For example, if an event POWER ON hasthe synonym P_ON, you
may generate this event with either of the following commands:

SET EVENT power_on:=true

SET EVENT p on:= true

You may also refer to a particular element by its namein one command and its synonym in another
command.

You can use the name of the chart the objects belongs to as a prefix to its name with a separating
colon.

For example:

SET EVENT ews:p on:=true

Whenever names are displayed, either in trace messages or in the output of the Debugger, this last
convention, including the chart name, is used.

If asynonym also exists, it is printed in parentheses next to the name. For example, in response to
the input:

Pdb > LIST EVENT

you would get:

List of events

ews :power_on (p_on)
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Referring to Unnamed Objects

Rational Statemate objects need not be assigned a name. Thisis an acceptable practice in many
situations. For example:

¢ Orthogonal components of an and-state may not have a name since you usually refer to
substates of such components but not to the components themselves.

¢ Expressions are often used in transition triggers without giving names to events and
conditions they represent. For example, atransition may be triggered by the event
entered(S) without this event having a defined name.

Note

Recall that an instance state or an instance activity has no explicit name (for example, was
labeled as @CHART NAME), then this element is given adefault name cearT NaMe. Hence,
such elements are not considered as unnamed in the following discussion.

Unnamed Activities and States

For dl charts that you did not name, the Debugger assigns internal names. This alows you to
reference them when using Debugger commands. Internal names of unnamed states and activities
are constructed as follows:

STATE#id number

ACTIVITY#id number

Using the Debugger command L1ST STATE resultsin the following display:

ews:ST_OUT
ews: STATE#1201
ews:ST_IN

ews : STATE#1202

Since the hierarchy of the states is used in formatting the output of the LI ST STATE command, it
iseasy to seethat the unnamed gtate within st_ouT hastheinternal name sTaTE#1201.

You can use the internal name to reference the state or activity. For example:

Pdb > SET BREAK bp entered(STATE#1201)
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Unnamed Events and Conditions

Unnamed basic events and conditions may be referred to exactly asin the specification. For
example, you may define a breakpoint on a basic event:

Pdb > SET BREAK user stopped(A)

even if this event was not referenced at all in the prototyping scope.

Resolving Name Ambiguity

Two or more elements may have the same name. For example, the specification might contain an
and-state on with two orthogonal components rReaping and MoNTITORING, each of them containing a
substate called wa1T. Another example istwo events with the same name E defined in two different
charts.

Many Debugger commands operate on a group of elements (L1ST, SHOW and the different
TRACE commands). If such acommand is given with anon-unique object name, thenitisappliedto all
the objects with that name.

However, there are commands which expect the argument to be uniquely defined. If these
commands are given a non-unique object name, they are ignored and an error message is
displayed. To make the reference unambiguous, you can either use the chart name as described
above and/or prefix the object’s name with its ancestor(s) name(s) separated by periods, up to a
point where the full pathname given is unique.

In our example of the ON dtate, we could uniquely identify the two orthogonal componentsin a show
gdate command by entering the following:

Pdb > SHOW STATE reading.wait

Pdb > SHOW STATE monitoring.wait

In another example, to uniquely identify a specific event E, precedeit with the name of the chart in
which it is defined:

Pdb > SET EVENT chartl:e:=true
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Wildcard Abbreviation (*)

In al Debugger commands, you can abbreviate the names of objects and breakpaints.

To abbreviate, you type awildcard symbol (*) anywhere in the name. The symbol means that any
sequence of characters may replaceit. The specified command isthen applied to all objects, whose
names match the pattern. For example, the command sets a trace on all the states whose names
begin with the letter “s” including the state whose nameis S.:

Pdb > SET TRACE STATE s*
The following command sets atrace for al states whose names begin with the letter “a” and end
with the letter “t” and which belong to charts whose names begin with the letter “¢e” .

Pdb > SET TRACE STATE e*:a*t

The command deletes al breakpoints whose names contain the letter “b” immediately followed by
the letter “p”.:

Pdb > CANCEL BREAK *bp*

Note

The use of SET BREAK requires explicit use of the breakpoint name. No wildcards are
permitted.

Subobjects Operator (")

To apply a Debugger command to a hierarchical object (activity or state) and all its descendants,
type the subobjects operator “/” character immediately after the name of the state or activity.

For example, in response to the command:

Pdb > SHOW STATE S*

the Debugger lists the state s and dl its currently active substates.
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Referencing Multiple Rational Statemate Objects in Commands

As aready mentioned above, many of the commands can operate on more than one Rational
Statemate object. In addition to the above ways of specifying more than one item (the use of non-
unique hames, wildcards and subobjects operator), you may just list the object names separated by
commas. Spaces on either side of the comma are optional.

Some examples follow:

Pdb > SHOW STATE x1, x2, X3
Pdb > SET TRACE CONDITION p*, cc, *a*, *w*:*

Pdb > LIST ACTIVITY actl”, act2

(Recll‘g;encing Records and Unions in the Rational Statemate Debugger
P

User-Defined Types can be referenced in generated code debug using the standard form of naming
conventions described earlier in this section. Use of partial namesisalowed. For example, if an array of
20 invoices was defined, where invoice is arecord, the command:

SHOW data INVOICE(0..2)

might produce the output

(array of INVOICE TYPE) USAGE TEST:INVOICE(0) .NAME = ’‘Fred B’
.ITEM = ’Biscuit’
.AMOUNT = 2.45
(1) .NAME = ’'Joe M’
.ITEM = 'Milk’
.AMOUNT = 0.69
(2) .NAME = ’Jim M’
.ITEM = 'Toothpaste’

.AMOUNT = 1.55

and the command:

SHOW data INVOICE (0) .NAME

might produce the result

(array of INVOICE TYPE) USAGE TEST:INVOICE(0) .NAME = ’'Fred B’

Union structures are displayed in the same way, but fields that are not current may show unusual
values. It isonly the field that had its value assigned most recently that shows avalid result.
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The command interface has been extended to allow types to be shown, so using the previous
example, the command...

SHOW TYPE INVOICE

would give the result:

USAGE TEST:INVOICE is array (0..19) of Record
INVOICE_TYPE
end of record

and the command...

LIST TYPE INVOICE TYPE

will give the result:

INVOICE TYPE record
NAME is string(80)
ITEM is string(80)
AMOUNT is real
end of record

Referencing Queues in the Rational Statemate Debugger (Pdb)

Commands to allow queues to be displayed and modified in the debug environment are:

PUT <QUEUE name> QUEUE element value

UPUT <QUEUE name> QUEUE element value

FL <QUEUE_name>
The existing command SHOW DATA can be applied to queues, and lists the elements of the
gueue. The queue element tagged number 1 isthe top of the queue, and the highest number is the
end of the queue.
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Keywords

There are no reserved words in the Debugger. It is clear from the context whether aword isused as
an object name or a Debugger keyword. For example:

Pdb > SET BREAK br label go

Here, “go” is obviously the name of an event and not a command keyword.

However, in some of the Debugger commands there are cases where both a Debugger keyword
and an object name may be given. This occursin all the SHOW, L1ST and TRACE commands-
where you can give either an object name or akeyword that denotes a subclass of Rational Statemate
objects (for example, “basic,” primitive, etc.) as an argument.

If an object exists whose name is the same as a keyword, and the user wishesto specify this object
in a command, its name must be specified within quotes. For example:

Pdb > SET TRACE ACTIVITY PRIMITIVE

means trace all the primitive activities, while

Pdb > SET TRACE ACTIVITY “PRIMITIVE”

means trace all the activities whose name is PRIMITIVE.

Generally, each of the keywords used in Debugger commands may be abbreviated. If the
abbreviation is ambiguous, then an error message is displayed followed by the list of possible
meaning for abbreviation. For example:

Pdb > L

causes the following response:

Ambiguous keyword abbreviation: L. Possible meanings:
LIST

LOAD
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Debugger Commands

The following sections describe the debugger commands.

Activating the Debugger
You activate the debugging prototype by invoking the executable file called profileg name dbg.
The Debugger responds:

Welcome to Debugger of Generated Code

A prompt is displayed to show that the Debugger is ready to accept Debugger commands:
1 Pdb >
Each prompt is preceded by its sequence number, thus enabling the identification of every

command entered during the debugging session. This allows you to easily re-enter these
commands using the HISTORY option.

You may then start the execution of the prototype by typing the GO or STEP command.

Quitting the Debugger

To terminate a debugging session, use the QUIT command:

Pdb > QUIT

This stops the execution of the prototype code. To aso stop those tasks that you might have added
in the user-written code, the command performsacall to the profile name user quit routine
Thisroutineresidesinthefileuser activities. Before creating the debugging prototype, you may
want to edit thisroutine' stemplate.

Rational Statemate 109



Debugger

Entering Debugger Commands

You can enter Debugger commands any time the Debugger prompt is displayed:

+ At the beginning of the debugging session

+  When the execution reaches a breakpoint

+ After the prototype finishes executing a step command

+  When prototype execution is interrupted viathe Ctrl-C interrupt

There are two ways of entering commands. One way is by interactively typing them at the
terminal’s keyboard. Each command can be up to 256 characters long. No special symbol is
required in order to continue the command on a new line. You can use abbreviations of command
keywords. Compl ete the command by pressing carriage return.

Another way of entering commands is via pre-existing command files. If there is a sequence of
Debugger commands that you frequently use, you can collect them in afile and invoke the file
from the Debugger using the LOAD command:

Pdb > LOAD file name

The Debugger reads the commandsin the given file and executes them. After reading the last
command of the file, the Debugger displays its prompt - at which point you can type in more
commands.

You may 1.oap asmany command filesin one session asyou desire. Command files can themselvesload
other command files, up to anested level of ten calls.

Theargument file name can beafull pathname explicitly specifying the directory in which thefile
resides. If no pathnameis provided, the Debugger searchesfor thefilein the current directory (the one
from which the debugging prototype was started).
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The HELP Facility

The Debugger comes with its own on-line help. When the raw prompt is displayed, you can get alist
of available commands, their syntax, and usage. To activate the help facility and display atable of
topics and commands for which help information is available, simply type:

Pdb > HELP
TOPIC COMMANDS

Break SET BREAK, CANCEL BREAK, SHOW BREAK

Execution GO, STEP, INTERRUPT, QUIT

Help HELP

History HISTORY nunber, !nunber, !text, !!

Input LOAD

Output SET FILE, SET OUTPUT, CANCEL OUTPUT

Time SET TIME, CANCEL TIME

Trace SET TRACE, CANCEL TRACE, SHOW TRACE

Values SET OBJECT, SHOW OBJECT, SHOW SCHEDULE.
PUT QUEUE, FLUSH QUEUE

CE Evaluation SET CE_UPDATE, CANCEL CE_UPDATE

List SHOW CE_UPDATE

Notes LIST OBJECT

Help is organized hierarchically, from overall help to topics and from each topic to the commands
that belong to it. After choosing atopic, the Help facility displays a general explanation of the
topic and lists its corresponding commands. You can get further information about an individual
command by referring to its name.

If you know exactly which topic or command you want help, you can avoid successively going
through all hierarchical steps. Instead, ask for the needed help directly from the Debugger
command level. For example:

Pdb > HELP TRACE

gives you general information on the topic of tracing, while:

Pdb > HELP CANCEL TRACE

provides specific information on the CANCEL TRACE command.
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Starting and Controlling Execution

As mentioned earlier, when you activate the debugging prototype you get the prompt Pdb >. The
debugging prototype is in the debug mode and execution of the prototype has not yet started. At
this moment:

* Sdlected conditions, data-items, and events are initialized in accordance with the
definitions you put into the program_name_user init routine.
¢ All activities of the model, as well as states of their controlling statecharts are non-active.
For all objectsnot initialized in the program name user init routine, thefollowing holds:

¢+ Eventsare not generated.

+ Conditions have theinitial value “false.”

+ Numeric data-items have the initial value zero.
¢ String data-items are empty.

Use the STEP and GO commandsto start or resume execution of the prototype whenever the
debugging prototype isin debug mode. The main function of STEP isto execute a number of steps
and stop at the beginning of the next step. The main function of GO isto execute the prototype
until suspension at the next breakpoint. There is also the interrupt option providing immediate
suspension of the execution.

STEP Command

The STEP command provides the most elementary way of advancing and suspending the
execution. You need not define any breakpoints. As areaction to this command, the model
executes the specified number of steps, passing from its current configuration to another, where
the execution is again suspended. The command is entered as follows;

Pdb > STEP number

If no number is specified, one step is taken.

In particular, you can start the proper run of the code by using STEP asthefirgt execution command
in the debugging sessions. Asaresult, the modd entersits default configuration and performsaal actions
attached to the corresponding default transitions.
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GO Command

The GO command ingtructs the prototype to execute. If the prototype was suspended, GO resumes
execution. The syntax of the GO command is:

Pdb > GO

Asaresult, aseries of successive stepsis executed until a breakpoint is encountered. The
Debugger then displays a message:

Stopped at breakpoint BP_NAME on event :
EVENT_NAME

Several messages may appear when several events, on which you have set breakpoints, occur
simultaneously (in the same step).

You can use GO not only to resume execution after the prototype was suspended, but to start prototype
execution. You usudly begin the debugging session by defining the required breakpoints and then issue
the GO command. The difference between using the ST EP command for this purposeisthat, here, the
execution is not suspended after entering the default configuration.

The GO command can aso be used without any breskpoints. This option is useful when you want to
perform a prototype run containing debugging facilities without suspension of the execution, check of
object’s status, etc. Though any run of such code causes activation of the Debugger, you can perform
such arun by typing GO asthefirst and only command in the session.

In all cases, when you issue a GO command, the execution continues until one of the following
occurs:

¢ A breakpoint is reached

¢ Aninterruptisissued

¢ Theroot activity terminates on its own
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Interrupting Prototype Execution

Interrupting the prototype execution causesit to immediately pause, thus enabling the Debugger to
read and execute debugging commands. The execution of the controlling statecharts is paused, as
are al primitive activities, each of which pauses at its next synchronization point.

When interrupted, the prototype execution is not stopped in the middle of a step but finishes the
current step and only then the Debugger prompt appears, allowing you to enter debugging
commands. When thisis done, you can resume the execution of the prototype using the GO or
STEP commands.

To interrupt the prototype execution, use Ctrl-C. Issuing an interrupt while the Debugger prompt
is displayed does not produce any results.

For example, suppose that the specification enters aloop of transitions in which there are no
breakpoints and you decide that you want to trace certain objects while in the loop. You can
interrupt the prototype, turn on traces to the desired objects and then resume execution.

HISTORY Command

The HISTORY command alowsyou to easily invoke any previoudy entered Debugger command.
Each time the Debugger prompt appears, asequential number isdisplayed. You can later use this number
to reference the command entered at the prompt. To seethelist of commands used in the session, perform
thefollowing:

Pdb > HISTORY

The Debugger then displays the most recently entered commands, up to a maximum of 20, with
their reference numbers.

To re-enter a specific command, enter the following:

Pdb > !command number
where command number isthe command reference number.
For example, if, in the course of the debugging session, you gave the command:

90 Pdb > SET CONDITION cstop := true

You could re-execute this command later by entering:

103 Pdb > 190
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To re-enter the last performed command, enter:

Pdb > !!

Another way to execute a previous command is to enter:

Pdb > !text

where text isatext string uniquely matching a previoudy entered command.

For example, if, after the command number 90, no command starting with the letter “s” was given,
then you can execute this command by entering:

Pdb > Is

LIST Command

The LIST command ingtructs the Debugger to output alist of objects belonging to the prototyped
specification. You can choose whether to ligt all the objectsin the specification, or to select only those of
acertain class, subclass or name. The listing does not show the values or status of the objectsin the
current prototype execution. It merely lists those objects that are within the prototyping scope.

The LI1ST command can be used in each of four basic forms:;

Pdb > LIST
Pdb > LIST object_class
Pdb > LIST object class subclass

Pdb > LIST object class list of objects

For example, the following are valid LI ST commands:

Pdb > LIST EVENT EXTERNAL
Pdb > LIST DATA input value, y*
Pdb > LIST ACTIVITY

The order in which the information is displayed is hierarchical for activities and states and
alphabetical for events, conditions and data-items. Remember that the command showsall objectsin
the system, regardless of their current Statusin the execution.

For example, the command: Pdb > LIST ACTIVITY PRIMITIVE lists the names of al
primitive activities in the specification, regardless of which ones are currently active.
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Similarly, if you type:

Pdb > LIST STATE NON BASIC

the Debugger lists all the non-basic statesin al the controlling statecharts in the prototype scope—
not only those states which belong to the current configuration.

When applied to non-graphical objects (events, conditions, data-items), the L1ST command
displays the requested information and, in addition, marks all compound objects asin the
following example:

Pdb > LIST EVENT S*
(c) chartl: signal
chart2: switch

(c) chart2: scroll

The compoundness attribute allows you to easily identify those elements to which command SET
OBJECT cannot be applied.

SHOW Command

In the Debugger, you can monitor the status and value of objects using the SHOW command.
Unlikethe L1ST command, SHOW displaysthe actua value or status of the Rationd Statemate object
at the current execution point. Thus, at abreakpoint, you can examine the values of different objects such
asdataritems, conditions and records to check if their actual values correspond to the expected values.

Using the SHOW command, you can modify the values of conditions and data-items, or generate and
reset events. When you resume the execution of the prototype, the new values take effect.

You can also check which time-outs and scheduled actions are currently pending with the SHOW
SCHEDUL E command.

The SHOW command can be used in the same basic form asthe L1 ST command:

Pdb > SHOW
Pdb > SHOW object class
Pdb > SHOW object_class subclass

Pdb > SHOW object class SHOW of objects

This provides great flexibility in limiting your request to only the information that you need.
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SHOW with no arguments gives you the most complete information about the current status of the
system. Thisinformation includes the following:

¢ Current step number.

¢ Statusof all activities (active, suspended, nonactive), organized by the activity’s hierarchy.
Descendants of nonactive activities are not shown explicitly, since they are all nonactive.

¢ Current state configurations of all controlling statecharts of active and suspended
activities, ordered according to activity and state hierarchies.

¢ Current values of al conditions, in aphabetical order.

¢ Current values of al data-items, in aphabetical order.

¢ Currently active events, in alphabetical order.
The second form of the SHOW command provides you with information on all objects of the selected
class. To get thisinformation, use one of the following commands.

¢ SHOW ACTIVITY

¢ SHOW STATE

¢ SHOW CONDITION SHOW DATA ITEM

¢ SHOW EVENT

¢ SHOW TYPE
Additionally, the current step number is displayed by entering the SHOW ST EP command.

Thethird form of SHOW alowsyou to restrict the displayed information to asubclass of aparticular
object class. For example:

Pdb > SHOW ACTIVITY PRIMITIVE
Pdb > SHOW STATE NON_ BASIC

Pdb > SHOW EVENT EXTERNAL

The fourth form of SHOW redtricts the information to specific objects of acertain class. You providea
list of object names as acommand argument. You may use wildcard abbreviations and the subobjects
operator.
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For example:

Pdb > SHOW DATA signal level, y*

would display the values of the data-item signal_level, aswell asthe values of al data-items
beginning with the letter “y”.

Pdb > SHOW ACTIVITY act*"

displaysthe status of each activity that starts with letters “act” and al of their descendants, until it
reaches nonactive activities.

SHOW SCHEDULE Command

The SHOW SCHEDUL E command shows you which timeouts and scheduled actions are pending
and how much time remains until the expiration of each one. A timeout is pending from the moment
the event which triggersit is generated, until its delay time elapses.

It isimportant to remember that the timeouts measure the elapsed time while the prototypeis
actually executing. Therefore, when the debugging prototype is in the debug mode, the system
time is frozen. The measuring of elapsed time resumes when the prototype execution is resumed.

For each pending timeout and scheduled action, the Debugger displays the:

+ Name of the timeout or scheduled action, if it has a name in the specification.

+ Name of the event on which the timeout is defined (the timeout’s trigger), in case this
event was given aname, and if not, its expression.

+ Origina length of the timeout, both in time units and seconds.
+ Amount of time remaining until the timeout or scheduled action elapses
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SET OBJECT Command

To change the current value of a condition or a data-item, or to change the current status of an
event, use one of the following three forms of the SET command:

Pdb > SET CONDITION condition name := boolean expression
Pdb > SET DATA ITEM data item name := data_ expression
Pdb > SET EVENT event_name := event_expression

Note that the command is applicable only to primitive objects; you cannot change the value or the
status of a compound object.

On the right-hand side of an assignment, you can put any legal Rational Statemate expression
whose type corresponds to that of the object on the left-hand side. The value on the right-hand side
of the assignment is evaluated, and assigned to the object whose value is being set.

Examples:
Pdb > SET CONDITION cl := true
Pdb > SET DATA ITEM int _var := 5*y
Pdb > SET DATA ITEM str_var := “new string”
Pdb > SET EVENT el := e2 or e3

To generate event eindependently of other dements statuses, type:

Pdb > SET EVENT e := true

or

Pdb > SET EVENT e

To turn off or, reset event e, type:

Pdb > SET EVENT e := false

The SET command does not impose the redefinition of the system’s object. In the example above that
Stsevent e1, the current statuses of e2 and e3 are examined immediately, and if either event is
generated, then e1 becomes generated thistime only. Later intherun, having e2 or e3 generated does not
cause el to be generated. Thus, e1 remains primitive and is not redefined by the command asa
compound event.
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The SET OBJECT command isavery powerful command to usein debugging sessions when you
discover an error in the specification, and you want to continue debugging, without first correcting the
specification. Thiscommand can be combined with the breakpoint operations to temporarily correct
mistakes in the specification.

Suppose, for example, that there is a static reaction on entering state S which refersto condition C
defined as:

C = (X=1)

and the correct definition should have been:

C = (X=1 and Y>0)

You can then enter the following:

Pdb > SET BREAK bp entered (s)

DO SET COND c:=(x=1 and y>0); GO END

The prototype then behaves asif the error is fixed, allowing you to concentrate on looking for
other problems. Later you should correct the definition of C using the Properties Editor.
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PUT QUEUE Command

To add an element to the “back” of a queue, use the following command:
Pdb>put QUEUE NAME VALUE
The VALUE must bealegal dataritem for that queue. The put command placesthe value at the end of

the queue opposite from where the next get retrieves values. Using put and get commandsin a Rationa
Statemate modd, treats the queue as afirg-inffirg-out (FIFO) type of queue.

UPUT QUEUE Command

To add an element to the “front” of a queue, use the following command:
Pdb>uput QUEUE NAME VALUE
The VALUE must bealegd data-item for that queue. The uput command placesthe value at the end of

the queue where the next GET retrievesvaues. Using uput and GET in aRationd Statemate modd,
treats the queue as alast-in/last-out (L1FO) type of queue.

FLUSH QUEUE Command

To completely empty a queue use the following command:

Pbd> flush QUEUE NAME

This insures that the queue is completely empty at the end of the upcoming model step. If queue
put (or uput) statements are executed, either within the model or through the Pdb debugger,
within the same step as the FLUSH, the FLUSH command takes precedence.
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TRACE Command

The Debugger can provide atrace of the prototype execution. If the trace modeis on, the Debugger
issues a message whenever a change occurs in the system. You can restrict the Debugger and have
it report only certain types of changes. The trace is a history of how the system performed in its
actual execution.

The TRACE facility reports whenever atraced object changes value or status. Specifically, it
reports:

¢ Starting, stopping, suspending and resuming activities

¢ Entering and exiting of states

¢ Generating events

¢ Changing values of conditions

¢ Changing values of data-items
You can optionally have each trace message contain a time stamp specifying when the reported
change occurred.

Sincethe definition of the system’s behavior is based on the notion of step, it might be useful inthe
course of debugging to see step bounds. For this, you use an additional trace option - step trace. In
this case, messages are issued upon starting and ending each step.

By storing atracein afile, you can perform a post-run analysis and check whether the actual
behavior matches the expected one. Since the trace refers to specification objects, it is easy to
interpret the results of the code run in terms of the original Rational Statemate specification.
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SET TRACE Command

The SET TRACE command has six forms

Pdb > SET TRACE
Pdb > SET TRACE object class

Pdb > SET TRACE object class subclass

Pdb > SET TRACE object class list of objects
Pdb > SET TRACE STEP

Pdb > SET TRACE SCHEDULE

Similar tothe L1ST and SHOW commands, the SET TRACE command can be started on all system
objects or restricted to only specified objects. The rules of naming object classes, subclasses and object
lissarethesameasintheL|ST and SHOW commands.

For example, the command:

Pdb > SET TRACE EVENT INTERNAL

sets atrace for all internal events and conditions.
Another command:
Pdb > SET TRACE STATE sampling”™, c*, disconnected
setsatrace for sampling and al its substates, all states beginning with the letter “c” and the Sate
disconnected.

The Debugger displays trace messages on the terminal screen and/or stores them in afile (when
used in conjunction with the SET FIL E command).

Format of Trace Messages
The format of the trace messages is shown in the following examples:

Activity trace:

Activity ews:SET UP started

Activity ews:SET UP stopped

Satetrace:

State ews:0FF entered

State ews:0FF exited
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Condition trace;

Condition ews:IN CONNECTED changed value to
TRUE

Condition ews:IN_CONNECTED changed value to
FALSE

Data-item trace:

Event ews:SET _UP generated

Event ews:HALT reset

Sep trace:

[ \starting step 1

A e /ending step 1

Timeout events are a special case. Each timeout event causes two trace messages. The first
message is printed when the timeout is triggered and the second message is printed when the
timeout expires and the corresponding timeout event is generated.

For example, suppose that the specification contains an event TMO defined as “timeout(E,5)”
where E is external and that tracing of eventsis requested. Assuming that the time unit specified is
2.5 seconds, whenever event E occurs, the following message appears:

Event ews:E generated

Timeout ews:TMO on event ews:E started for 5
time units (12.5 seconds)

and then, after 5 time units elapse and the timeout occurs:

Timeout ews:TMO on event ews:E ended after 5
time units (12.5 seconds)
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SET TRACE SCHEDULE Command

The SET TRACE SCHEDULE command traces scheduled actions. Scheduled actions are a
specia case similar to timeouts. Each scheduled action causes two trace massages. Onewhen it is
scheduled, and one when the scheduled timeis up and the action which was scheduled is executed.

Schedule Trace:

Schedule action CHART1:D1 of PROCESS ONE
started for 200 time units

Schedule action CHART2:COMM of FFT started
for 5 time units

Schedule action CHART2:COMM of FFT ended
after 5 time units

Schedule action CHART1:D1 of PROCESS_ONE
ended after after 200 time units
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SHOW TRACE Command

To see what objects are currently traced, you use the SHOW TRACE command in one of the
following forms:

Pdb > SHOW TRACE

Pdb > SHOW TRACE object_ class

Pdb > SHOW TRACE object class subclass

Pdb > SHOW TRACE object_class list of objects
Pdb > SHOW TRACE STEP

The Debugger presentsalist of all the traced objects of the requested class. For example, in
response to the first of the previous commands, the following could be displayed:

Activities traced:
system:SAMPLE DEVICE
system:SET_ UP

Conditions traced:

Data-items traced:
ews : SAMPLED DATA

Events traced:
system:DISCONNECT
ews :OUT_OF_RANGE
ews :RESET
system:TIME CLICK

States traced:
ews :MONITORING

Step trace: OFF

In each group of objects, the names are displayed in a phabetical order. An empty group means no
object of the corresponding class was traced, asin the case of conditionsin the above example. For
step trace, its current statusis either OFF or ON.

If you requested atrace and used abbreviations to specify which objectsto trace, the list showsthe
actual names of all the objects being traced, rather than the original abbreviation.

For example:

Pdb > SET TRACE EVENT s*
Pdb > SHOW TRACE EVENT

This produces:

Events traced:

ews : SAMPLED
system: STUCK

ews : SWITCHING
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CANCEL TRACE Command

The CANCEL TRACE command alowsyou to turn tracing off for some or al objects previoudy set
by one of the SET TRACE commands. You may turn tracing back on by re-entering the appropriate
SET TRACE command.

Specify which traces to cancel by using the same syntax as when they were set (using SET
TRACE). For example, here are some valid commands to cancel traces:

Pdb > CANCEL
Pdb > CANCEL
Pdb > CANCEL
Pdb > CANCEL

disconnected,

Pdb > CANCEL
Pdb > CANCEL

TRACE
TRACE
TRACE

TRACE
c*

TRACE
TRACE

ACTIVITY
EVENT INTERNAL
CONDITION

STATE sampling®

STEP

The commands to cancel traces do not have to exactly correspond to the commands that turned

them on. For example:

Pdb > SET TRACE EVENT e*g, power on, s*

Pdb > CANCEL TRACE EVENT energizing,

submerging

Pdb > CANCEL TRACE EVENT *g

would leave atrace on for the event power on and all events that begin with “s’ and do not end
with “g”. Request to cancel atrace that was not set isignored.
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SET TIME Command

The SET TIME command tells the Debugger to put time stamps on each trace message and specifies
theformat of these tamps. A time stamp shows the € gpsed time since the prototype execution began. As
noted previoudy, timeis not incremented when the prototype being debugged isin the debug mode.

This command has three forms:

¢ Pdb>SET TIME
¢ Pdb>SET TIME SECONDS
¢ Pdb>SET TIME FORMATTED

Thefirst two forms are the same with format SECONDS being default. Time stamps are printed in
thiscaseas SS.LLL, where SSissecondsand LLL ismilliseconds.

For example:

AT 00:00:01:530 : Data-item ews:FAC changed
value to 1

AT 00:02:03:890 : Condition ews:C changed
value to FALSE

CANCEL TIME Command

To disable display of time stamps within the all trace messages, use the CANCEL TIME
command:

Pdb > CANCEL TIME

To renew time stamps in the trace messages later in the debugging session, you may re-enter the
SET TIME command.
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The Set File, Set Output And Cancel
Output Commands

You can record a transcript of the entire debugging session (or any portion) in alog file. This
transcript includes the Debugger commands you entered during the session. It aso includes the
corresponding Debugger output and trace messages. You can control whether the Debugger output
iswritten only to thisfile or also displayed at your terminal. The appropriate commands are;

¢ SETFILE
¢ SETOUTPUT
¢ CANCEL OUTPUT

The saved transcript can be used for off-line analysis of aprototype’s execution. It can also be used
as a Debugger batch (command) file, since the Debugger is able to extract commands from the
saved transcript. This batch file can be loaded using the LOAD command in alater execution of the
same or a corrected debugging prototype. This savesyou from having to recreste the same scenarios that
were aready tested in previousruns. It aso facilitates comparison of two runs. Inthisway you can easily
check that a specification error detected in the first run has been properly corrected for the second run.

SET FILE Command

The SET FILE command specifies the name of thefile in which the debugging sessionisto be
recorded. Thisfileiscalled thelog file. To actualy start therecording, usethe SET OUTPUT
command. The command is started as.

Pdb > SET FILE file name

As an argument, you enter any string which isalegal £ile name for your environment. If no
file name isgiven, the default name becomes debug. 10g.

The file name can be afull pathname explicitly specifying the directory in which the file resides.
Otherwise the file is created in the directory from which the prototype was run. You must have
appropriate write privilegesin this directory.

When you use multiple SET FIL E commandsin the same session, the recording iswritten into thelog
file specified in the most recently entered command. Moreover, in such acase, you lose the ghility to log
information into the former file sincethe fileisrecreated each timethe SET FILE command isissued.
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SET OUTPUT Command

The SET OUTPUT command determines where the output transcript iswritten.
The command has three forms:

¢ Pdb>SET OUTPUT FILE

¢ Pdb>SET OUTPUT TERMINAL

¢ Pdb>SET OUTPUT
In thefirst case, the transcript is written to the file whose name was specified inthe SET FILE
command. If the SET FIL E command was not yet issued, then thefile debug. 1og isused.

The second form directs the output to the terminal. This impacts trace messages only, since the
transcript of user commands and corresponding Debugger responses are always displayed at the
terminal.

Note

If you do not use the SET OUTPUT command, trace messages are sent to the terminal, but
not to any file. Therefore, it isreasonableto usethe SET OUTPUT TERMINAL command
only after the commands CANCEL OUTPUT and CANCEL OUTPUT TERMINAL to
renew the full display of the Debugger output on the screen.

Finally, the form SET OUTPUT without any parameters directs output to both the file and the
terminal.

Format of a Log File
Each record in alog file is one of the following:

¢ Command entered in the debugging session.

+ Immediate response of the Debugger to the command (for commands such as stow,
LIST, HISTORY, HELP).

* Trace messages.
+ Breakpoint occurrence message.

Only entered commands and various forms of the Debugger’s responses are recorded in the log
file. Outputs produced by the prototype code itself (and printed on the screen and/or in afile) are
not recorded in the log file.

While commands are recorded as entered, all Debugger messages are preceded by a double
hyphen “--."

130

Code Generation Reference Manual



The Set File, Set Output And Cancel Output Commands

For example, the following commands were entered in the debugging session:

Pdb > SET OUTPUT

Pdb > SET BREAK br reset
Pdb > SET TRACE EVENT
Pdb > GO

Pdb > SHOW DATA *bound

Pdb > SET DATA lower-bound := 25.0

The transcript of the session isrecorded in the file debug . 1og and appears asfollows:

SET BREAK br reset

SET TRACE EVENT

GO

-- Event ews:EXECUTE generated

-- Event ews:GO generated

-- Stopped at breakpoint BR on event: ews:RE
SET

SHOW DATA *bound

-- Current values of data_items:

-- system: LOWER BOUND = 20.5
-- system:UPPER_BOUND = 84.7
SET DATA lower bound := 25.0

Using a Log File

One possible use of the log fileisfor an off line analysis of the prototype run. You use the saved
transcript to see what events occurred in the run and in which order. Relationships between various
other elements can aso be examined. For example, you can check whether two specific activities
were ever active simultaneously in the run. Such post-run analysisis very helpful inlocalizing
errors in the specification.

You can also use the log file as a command file in another run of the same or corrected debugging
prototype. For this, you simply refer to the log file's name in the LOAD command. For example:

Pdb > LOAD debug.log

As aresult, the Debugger reads and performs in turn all commands recorded in thefile. The
Debugger easily extracts the commands from the entire transcript since they are not marked by a
double hyphen. Thus, you can save a debugging scenario and then re-use it in several runs of the
prototype.
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Recording Comments in a Log File

Whenever the executing prototype pauses and enters the debug mode, you may enter not only
Debugger commands, but also comments. Comments have absolutely no influence on the
execution. However, they are recorded into the log file as part of the debugging session transcript.
This option supports a better understanding of the saved transcript contents in a post-run analysis.
You can use comments to:

+ Describe the scenario of the environment’s behavior under which you are going to check
the system’s reactions

+ Explain your motivation for entering various commands, especially those which change
values of specification elements

+ Expressyour immediate impression concerning certain aspects of the observed prototype
behavior

Comments are extremely helpful when the transcript is not analyzed immediately after the run or
by persons other than those performing the run.

A comment is afreetext string starting with a hyphen. You enter it when the Debugger prompt is
displayed:

Pdb > - free text

Comments are recorded in the log file literally, including the hyphen.

Toillustrate the use of comments, suppose that in the above example of the debugging session, you
entered the following comments between the commands SHOW DATA and SET DATA:

Pdb > - ***** The difference between the bounds

Pdb > - ***** ghouldn’t exceed 60.0

Then the corresponding portion of the log file appears as:

SHOW DATA *bound

- Current values of data items:

- system: LOWER BOUND = 20.5

- system:UPPER_BOUND = 84.7

- **%*%*%* The difference between the bounds
- *%%** ghouldn’t exceed 60.0

SET DATA lower bound := 25.0
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CANCEL OUTPUT Command

To stop recording the debugging session, you usethe CANCEL OUTPUT command in one of the
following three forms:

¢ Pdb>CANCEL OUTPUT FILE
¢ Pdb>CANCEL OUTPUT TERMINAL
¢ Pdb>CANCEL OUTPUT

The first command stops recording into the most recently used logging file (either specified by a
SET FILE command or debug. 10g).

The second command stops displaying trace messages on the terminal.
Finally, the third command halts the logging of the session in the file and at the terminal.
Remember that in all cases, the commands and Debugger’s responses continue to be displayed.

For example, you enter:

Pdb > SET OUTPUT

This causes all the output of the Debugger to be written into the file debug . 10g aswell as
displaying it on the screen. If later in the session, you invoke:
Pdb > CANCEL OUTPUT TERMINAL

then, from that moment (until changed by other commands), the session log is only written into the
file.
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Breakpoints

Breakpoints specify which events cause the prototype execution to pause and enter the debug
mode. You can trigger a breakpoint on every event and condition used in the specification.

The normal cycle for working with breakpointsis:

*

*

*

*

SET the breakpoints where you want the execution to pause.
Execute the prototype with the GO command to advance from one breakpoint to another.

When a specified breakpoint occurs, inspect and/or modify the prototype using the
SHOW, SET or other Debugger commands.

Repeat the cycle.

When stopping at a breakpoint, you can enter any Debugger command and define new
breakpoints, or check the status and values of objects. Also, when setting a breakpoint, you can
associate it with a sequence of commands which are performed automatically when the breakpoint
occurs, with or without actually stopping the prototype execution.

At any moment in the debugging session, you can ask for alist of all the currently active
breakpoints and cancel any of them.
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SET BREAK Command

You define a breakpoint with the SET BREAK command:

Pdb > SET BREAK breakpoint label trigger expression

The execution is suspended each time the event specified by the t rigger expression occurs
that is after the step in which the event was generated and before the step inwhich it is actually sensed.

The breakpoint label is used to refer to the breakpoint in the SHOW BREAK and CANCEL
BREAK commands.

In cases where the label is used more than once, the latter one takes effect, overriding the previous
definition of the breakpoint.

The second argument of the SET BREAK command isany lega Rational Statemate trigger
expression using the same syntax used for trangitions. These consst of the:

+ Named events and conditions defined in the specification of the prototyped system

+ Unnamed basic events and conditions (except the “timeout” “read” and “written” events)
referring to the specification’s objects

For example:

Pdb > SET BREAK label 1 TRUE (ACTIVE(A))

As aresult, the execution is suspended each time the activity Aisactivated, while after:

Pdb > SET BREAK label 2 ENTERED(S) or
E [ACTIVE (A)]

it is suspended when either the system enters the state S or event E occurs and activity A isactive at
the same moment.

Finally, after:

Pdb > SET BREAK label 3 [ACTIVE(A)]

the execution isfirst suspended when A isactivated, and then, after each successive stepinwhich A
remains active. Thisdiffersfrom the case of the breakpoint 1abe1 1 abovewhich occursonly when A is
activated but not in the next stepsunless A isreactivated.
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DO Clause

With each breakpoint, you can associate a sequence of Debugger commands to be performed each
time the breakpoint is reached. You can also specify whether you want the prototype execution to
pause after performing these commands, or to continue. To define the command associated with
the breakpoint, use the DO clause when setting the breakpoint:

Pdb > SET BREAK label trigger expression

DO sequence_ of commands END

The DO clause can contain any sequence of Debugger commands separated by semicolons.

For example, each time event e1 occurs, you want to stop and check the current values of conditions
and data-items. Instead of retyping in the same commands on each arrival of the breakpoint, you enter
them only once when defining the breakpoint:

Pdb > SET BREAK bp 1 el DO SHOW COND;

SHOW DATA END

Immediately upon reaching the breakpoint, the Debugger suspends the execution and displays the
reguested val ues:

Stopped at breakpoint BP_1 on event: El1
Current values of conditions:
chartl:CONNECTED = FALSE
chart2:NORMAL = TRUE
Current values of data-items:
chart2:X =1
chart3:Y = 2.3

It then places the debugging prototype into debug mode. After examining the values, you may
perform more Debugger commands.

If you want to perform the DO clause without suspension of the execution, you put GO asthe last
command in the DO sequence.

For example:

Pdb > SET BREAK bp 1 el DO SHOW COND; SHOW DATA; GO END

differs from the previous one in that the execution is not stopped after displaying the values. You
would not be able to enter more commands at breakpoint bp 1.
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If ina DO clause, the GO isfollowed by other commands, they areignored by the Debugger.
DO clauses can, themselves, set breakpoints. This may result in nesting of DO clauses, asfollows:

Pdb > SET BREAK bp 2 d2 DO SET BREAK bp 3 e3

DO SHOW DATA x END END

There are no restrictions on the depth of nesting.

A breakpoint can be reached only after the end of the step in which itstrigger occurred. Thisisalso
the point where the DO clause isinitiated. At thistime, al that occurred during the last step is
availablein the DO dause.

At each step, all breakpoints are checked according to the alphabetical order of their labels.
Consider, for example, triggers of two breakpoints named a and b which occurred in the same step. If
thefirst hasa GO command inits DO clause, the second breskpoint is not reached.
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SHOW BREAK Command

To seethelist of all active breakpoints, use the SHOW BREAK command in one of two forms:

¢ Pdb>SHOW BREAK
¢ Pdb>SHOW BREAK breakpoint list

Thefirst form allows you to see the list of all active breakpoints. The Debugger displays each
active breakpoint, the corresponding trigger expression, and the DO clause, asin thefollowing
example:

Breakpoint LABEL 1 on event : TRUE(ACTIVE(A))
Breakpoint NEW on event: El1 or E2
Breakpoint LABEL 3 on event: [ACTIVE(A)]
Breakpoint BP_! on event: El

reaction: SHOW COND; SHOW DATA

The second form displays only selected breakpoints. For example, in response to:

Pdb > SHOW BREAK lab*, bp 1

the Debugger displays the following list:

Breakpoint LABEL 1 on event: TRUE (ACTIVE(A))
Breakpoint LABEL 3 on event: [ACTIVE (A)]
Breakpoint BP_1 on event: E1

reaction: SHOW COND; SHOW DATA
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CANCEL BREAK Command

To delete breakpoints that become unnecessary for controlling the prototype execution, use the
CANCEL BREAK command with aligt of breakpoint |abels asthe argument.

For example:

Pdb > CANCEL BREAK label*, new

deletes all breakpoints whose name starts with “label” and also the breakpoint “new.”

Note

Canceling a breakpoint does not mean that the effect of its associated DO clause is also
automatically cancelled.

Consider again the following breakpoint definition:

Pdb > SET BREAK bp 2 e2 DO SET BREAK bp 3 e3
DO SHOW DATA x END END

Suppose that bp_2 iscancdled after it wasreached at least once, that is, after its DO clause was
executed. Then breakpoint bp 3 remains active, until explicitly cancelled by another command.
Another example:

Pdb > SET BREAK bp 4 e4 DO SET TRACE ACTIVITY;
CANCEL BREAK bp 4; GO END

Here, activity tracing is started after the first occurrence of event e4, and continues until explicitly
cancelled.

To delete al breakpoints, enter:

Pdb > cancel break *
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Rational Statemate allows designers to graphically model, smulate, analyze and verify the
functionality and behavior of complex embedded systems. However, the ultimate verification of
any embedded devel opment project is to run the specification in the form of code on a prototype
target system, typically a development system designed to allow convenient hardware and
software modifications as the project develops. To facilitate this, Rational Statemate has been
enhanced to alow the rapid development of code based on the simulated model that can be
downloaded into a prototype target development system. The sections in the rest of this manual
describe how to use these new Embedded Rapid Prototyping features.

Background

The major reason for Rational Statemate users to perform Embedded Rapid Prototyping is to
verify that the model functions properly in area world environment. Today with Rational
Statemate, when amodel istested it must simulate the environment that the system ultimately
interacts with. Often the environment is very complex and difficult to completely describe via
modeling, test vector files or programs. In the final analysis, the most accurate description of the
target environment that insures the accuracy of the specification is only found by bringing the
specification (i.e. model) to the actual target environment. Thisis the essence of Embedded Rapid
Prototyping.

The following figure illustrates one such application of embedded rapid prototyping. Here, the
engineer is able to run the Rational Statemate software on a laptop computer placed within the
passenger compartment of atest vehicle. The laptop is linked to a convenient rack mounted
embedded prototyping system located in the back of the vehicle. This embedded devel opment
system uses standard CPU hardware and embedded operating system (frequently aReal Time
Operating System, or RTOS) with amix of standard and specialized |/O interface cards connected
(by cable or bus) to, and acting as the control components for, some prototype subsystem of the
test vehicle.
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The Rational Statemate model is used to generate code which is compiled and downloaded to the
development system. When executed, the prototype code's features can be observed both in the
target hardware and in the Rational Statemate software. When a change needs to be made, the
engineer simply changes the Rational Statemate model, regenerates code, compiles and downloads
it to the target system. The next test is then ready to begin. This process can be repeated as many
times as necessary until the model has been refined to the point where an accurate and complete

specification can be finalized.

Goals of Embedded Rapid Prototyping
There are three things that must be verified when running such an embedded prototype:

+ Thebasic specified functionality is correct for the target system.
¢ Theinteraction between functionsis correct.
¢ Thetimelinesfor the execution of these functions is correct.
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Embedded Rapid Prototyping Process Model

The Process Model for embedded rapid prototyping is slightly different than the classic Rational
Statemate model. The following figure shows the process as a flow chart. Each step in the
flowchart is described below.

START

Create Function
System Model
with Rational

Statemate

l

Verify System
Model with

— Rational

Statemate

Errors

No Errors

1. Modeling and Simulation - First you create a functional system model using Rational
Statemate. Next, you simulate this model to verify that the functionality is correct. If
during simulation any errors are found, you correct these errors in the model and re-
simulate. This ssimulation/model correction loop continues until you are satisfied that the
model functions correctly.

2. Embedded Rapid Prototype - The code and prototyping unit now is hooked up to the target
hardware (or in some cases a test bed).
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3. Atthispoint in the process, you next move to verify this functionality in an environment
that is closer to the actual product environment than that which was used for simulation.
This requires the use of a hardware/software prototyping system which can be hooked up
to the actual target product’s hardware and act asits control system. See the sidebar
discussion in The Embedded Prototyping System regarding embedded prototyping
systems.

a. Thefirst step in moving to the prototyping unit isto capture information (target O/S,
I/0 mapping) which is specific to the prototyping unit.

b. Next, codeisgenerated from the model.

c. Thecode and prototype unit information is then compiled and downloaded to the
embedded rapid prototyping unit.

Execute
Prototype Code

and Analyze
Results

Go To Start

Acceptable

Acceptable

4. Andysisis performed on the execution runs to verify that the functionality, behavior and
timing for executing the functions are correct.
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The Embedded Prototyping System

The embedded prototyping system will vary from product to product (and
even from project to project) but will typically consist of a processor-
based hardware devel opment system. Such a system requires four major
elements:

boot source code

device drivers

some |/O interfacing capability

custom software needed to interface the application code and real
time operating system (RTOS) to the target hardware

Such systems may be rack mounted in a bus-based card cage, or be self-
contained on a single board computer with I/O components added/
modified as necessary. It could even be atotally custom devel opment
system. The Board Support Package (BSP) is the name typically givento
such a prototyping system because it encompasses more than just the
development system hardware.

If any changes need to be made, the model is updated and resimulated as needed. Code isre-
generated, compiled and downloaded to the embedded prototyping system. This updated prototype
is then again executed and analyzed. This iterative cycle continues until the user is satisfied with
the results of thetest runs. At that time the specification (based on the model) will be handed off to
software designers for implementation of the production version of software. This code can be
tested against the test criteria generated from the model to verify that it meets functional
specifications.

The next three main sections will examine each step of this processin detail, as well asrelated
design issues. Simple Embedded Code Example presents a example of asmall rapid embedded
prototyping project to demonstrate how all of these elements come together.
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Embedded Rapid Prototyping in Rational Statemate

Rational Statemate implements four major features relating to embedded rapid prototyping:

*

Retargetable to different target platforms

Flexible signal mapping to any 1/0 card

Target trace facilities for debugging

Remote connection to different support tools such as:
¢ Panels
¢ Graphical Back Animation (GBA)

Note

Embedded Rapid Prototyping is essentially an extension to the standard Rational Statemate
C code generator (refer to Generating Native Code) All other standard features of Rational
Statemate remain unchanged.
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The most significant variable in any embedded application is the nature of the target hardware and
its operating system. Because the Rational Statemate rapid embedded prototyping capability is
designed to work with many different target hardware/OS combinations, it is necessary to
communicate the nature of the target hardware/OS so that appropriate code can be generated. This
section examines how to communicate this information to Rational Statemate.

The many possible configurations of target system hardware and software requires a means to
configure Rational Statemate to the specific details of the system used. The following items are
critical to successfully generate and compile working code:

¢ RTOS boot file

¢ Driver software

¢ |/O port assignments

¢ Terminal communications capability to monitor test system’s operation
Other items may be necessary for a specific prototype, but these are required by virtually all
systems.
To configure Rational Statemate for this kind of information requires three specific items:

¢ A communications link for data upload/download between the Rational Statemate host
system and the prototype development system; commonly an ethernet link, an RS-232C
link, or an RS-485 link

+ A target file that specifies details of the target RTOS and hardware environment
¢+ Anl/Ofilethat specifies the configuration of all I/O port assignments
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Describing Different Target Platforms

The Embedded Rapid Prototyping Code Generator supports an open set of user defined targets. All
target-related parameters are defined and maintained in an ASCI| file named <os names.rtrgin
the prt /rprt directory. Files are currently provided for the following targets:

*

*

*

*

Unix
Solaris
Windows
VxWorks

This selection of the target platform and all other parameters for a specific project are created and
maintained using the Rapid Prototyping Compilation Profile Editor.

To start the editor, click this 3 icon, found on Rational Statemate’s main screen.

Thefollowing is an example of the Profile Editor screen.
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Compilation Profile Management

Compilation Profiles for embedded rapid prototyping projects function in much the same way as
they do in normal C and Ada projects (refer to Generating Native Code and Ada Code Generation
for more information). Descriptions of most of the menu items and speed buttons are provided in
the on-line help files. A summary of the Profile Editor’'s menusisillustrated in the following
figure.

Typicaly, Compilation Profiles must betailored to the requirements of a specific target system and
the prototyping system interfacing to it. Many of these parameters may be standardized and (if this
isthe case) should be available from your project leader. Otherwise, you will need accessto
information relating to the exact configuration of the prototyping system and the target hardware.
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Creating the Profile

Each of the following tasks must be performed to create a successful profile.

Scope Definition

To define the scope, the user must declare the modules, add the charts, and add the panels into the
scope using the workarea browser.

Target Definition

Thelist of targets containsthe . rtrg file names detected in the <workareas/rprt directory. If itis
necessary to add, replace or delete some flags, libraries, compiler name, etc. or add custom
modules (e.g. objects or/and libraries), you must change the . rtrg file appropriately.

For example, an I/O card driver object file may be added into the #Intrinsics library:
paragraph. It would then appear something like:

#Intrinsics library:"$ (STM_ROOT) /lib/VxWorks/libintrinsics$ (CPU) .a :/tmp/io/
rprt/onyx.o"

If the full path of the target output directory differs from the host output directory path (for
example, if the host directory is Unix-like /stmw.ga/qa_20 and the same target directory on
Windowsisq:\ga_20), youwould need tofill out the Target Directory field of the Global Profile
settings dialog form.

Using Remote Panels

It is possible to use remote panels by setting the toggle button With Remote Panel Server on the
Global Profile Settings dialog form.

Note
Resetting this button does not cause deletion of panel(s) from scope.
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Input/Output Mapping

1/0 mapping isthe main feature of the Rapid Prototyping Code Generator. It allowsyou to map the
textual elements of a Rational Statemate model into the input/output signals of 1/0 card.

The mapping process consists of the following steps:
1. 1/O card description file creation
2. 1/O card driver functions creation
3. /O mapping
4. Polling rate selection
5. Input card task(s) parameters set

Thetwo first steps are usually made only at the beginning of the process. The other steps may be
performed every time, when you want to change something in the model or in run time execution
of the model.

Writing the 1/0 card description and driver code are correlated processes. In fact, the . cxd fileis
input information for the driver functions, so the content of this file depends on the needs of the
driver. For example, the port offset field contains some string. In the example (the

onyx mm_dio.crd file shown in thefollowing figure), every element of the #port 1ist paragraph
corresponds with some port of the card. However, it is sometimes only necessary to take one bit of
the real port and to map it to some condition. In this case, it is more comfortable to declare every
pin as a separate virtual port and to use the #port offset field to declare the two information
elements: real port offset and pin number of the port. Then the driver can unpack this field and
read the two values as specified. It might look like the following string:

#port offset:"1:5"

where 1 isthe port offset, and 5 is the pin number.

Although such adriver tendsto be alittle more complicated, this approach sometimes makes sense
because it allows for the simplification of the model.

154 Code Generation Reference Manual



Describing Different Target Platforms

Example of the Driver Functions

The following is the real driver functions which are implemented
to support the ONYX—MM-DIO I/O card from Diamond Systems Corp.

#include <vxWorks.h>
#include <stdio.h>
#include <stdlib.h>
#include <syslib.h>
#include "types.h"
#include "symbols.h"

#include "string.h"

#define DIO 1A 0
#define DIO_1B 1
#define DIO_1C 2

#define DIO_1CR 3
#define DIO 2A

4
#define DIO_ 2B 5
#define DIO_2C 6

7

#define DIO_ 2CR

int onyx base addr; /* The card base address , converted into int
format */

/* -- generic card initializer for both input and output mapping */
void onyx init(card desc_p card p)

{ int addr;

sscanf (card p->base_addr, "$x", &onyx_base addr) ;

printf ("base addr = 0x%x\n",onyx base_ addr) ;

sysOutByte (onyx_base_addr+ DIO_2A,0x00); /* Reset of output
registers before setting of 2A port to be output */
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sysDelay () ;
addr = onyx base addr+DIO 1CR;/* control register 1CR address
*/
/* Port 1A , 1B and 1C set to OUTPUT/MODE 0 */
sysOutByte (addr, 0x80) ;
printf ("Ports 1A , 1B and 1C set to OUTPUT/MODE 0\n");

sysDelay () ;

addr = onyx base addr + DIO_2CR; /* control register 2CR address
*/
sysOutByte (addr, 0x9B) ; /* Port 2A , 2B and 2C set to INPUT/MODE 0 */

printf ("Ports 2A , 2B and 2C set to INPUT/MODE 0\n");

/* -- generic card driver for both input and output mapping */
void onyx in(report link elem)
{

genptr new_value = (genptr)elem->received val;

int b, offset;

sscanf (elem->pin offset, "%d", &offset) ;

b = sysInByte(onyx base addr+offset) ; /* input from 2A port */

switch(elem->elem type) {

case el integer:

case el_enumer:

case el _bit_array:
* (int*)new_value = b;
break;

case el _condition:

case el _event:
* (char *)new value = b;
break;

case el _real:
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case el real:
* (double*)new_value = b;
break;

default:
* (int*)new_value = 0;

break;

#define OUTPUT_BUF_SIZE 16
double output_buf;

void onyx out (report link elem)

{
void *actual val = (void*) &output buf;
int offset;

sscanf (elem->pin offset, "%d", &offset) ;

switch(elem->elem type) {
case el_integer:
case el _enumer:
case el _bit:
case el_bit_array:

if (elem->pin_inverse)

(* (int*)actual val) = ~(*(int*)elem->elem value) ;
else
(* (int*)actual _val) = (*(int*)elem->elem value) ;

sysOutByte (onyx base addr+ offset, *(char*)actual val);
to 1A port */

break;
case el_real:

(* (double*)actual val) = (*(double*)elem->elem value) ;

break;

/*

a=> output
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1/0 mapping itself is performed using the I/O Mapping dialog form shown above in the following
figure. It contains the mapping matrix and the Polling Rate pop down menu. Note that there are
four fieldsin every line of the matrix.

x
Nane || 140 Card ||Part Mame  |[I/0 ||
Insert I
Delete I
Ehoose“‘l
Single Polling Rate —
‘ 0K | Cancel | Help |

The name is selected by using the Choose window or by typing in the name directly from the
keyboard.

The l/O card field may be filled out by placing the mouse cursor over the cell in the desired row
and column and pressing the right mouse button. Then, a pop-down menu appears containing the
current list of . crd files detected in the <workareas/rprt directory.

When the card name is chosen, the user can choose the port name in the next field of the matrix.
Thisis done in the same manner as the previous field. The pop-down menu presents the list of
available ports.

When the port name is chosen, the 1/0 field is automatically filled out by the proper value for this
port. Usually thereis no need to change it, because this valueis an inseparabl e part of the 1/0 card
andisingaledinthe init_dariver function or built-in.

After the 1/O mapping is done, it's time to set the parameters of the INPUT tasks, (if input
mapping exists).
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You can define one or two tasks for the polling of 1/O cards. The second task is needed only if
there are more than afew 1/0O cards, all participating in the input mapping, and with different
polling rates. In this case, the code generator separates al of the I/O cards into two groups. one
group with high a polling rate and the other with alow polling rate. The mapped elements
belonging to the first group are polled by the aznpuT TASK, and the mapped elements from the
second group are polled by the LinpuT_TASK. The actual polling rate values can be set using the
Target Task Settings window shown in the following figure.

x
Tazk Mame ||Prinritg ||Palling Rate ||BuFFer zize "
tRPANEL _TASK 5 1 F00)

K | Cancel | Help |

Detailed View of 1/0O Card Description File

Type of Possible _
Key Word yp Description
Values

#card name string The name of the I/O card.

#card polling rate integer The size of time interval (in ticks) that should pass
between two consecutive card read operations.

#card number of ports | integer The number of ports in the card. The port list should
contain exactly this number of elements.

#card base address string The hexadecimal string defining the real address of
the 1/0 card on the bus. For example: “0x240".

#card init function string The name of the function that initializes the I/O
card. It is called once when the program starts

#card driver function string The name of the driver function that actually reads
data to, or writes data from the card.

#card closure function | string The name of the function that shuts down the card
when it is no longer needed. This routine performs
any housekeeping tasks that the 1/0 card might
require.
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Key Word Type of Possible Description
Values

#Port list list of strings The list of port descriptors. Fields that constitute the
port description are described below.

#Port name string The name of the port, it appears in the GUI when
users have selected a card in the I/O mapping
settings dialog, and they are choosing the port for
each I/O mapped model element.

#Port inverse logic yes/no If yes, the value read from or written to the port will
be inverted bitwise.

If no, the card driver function reads the value
directly.

#Port default mode in_mode/out_mode | The default input/output configuration mode of the
port.

#Port default buffer yes/no If yes, the output to the port is buffered.

#Port offset string The offset of the register, relative to the port’s base
address. It is expressed as a hexadecimal string.

Trace Settings

The trace settings option enables you to trace data items of basic type, conditions, events, states
and activities without using the Rational Statemate debugger in aless intrusive manner.

The selection of the traced elements is done using three matrices in the Trace Settings window of
the Options menu.The trace of every selected element can be turned off or on.

In addition, there is a pop-down menu that sets the format of the tracefile or disablesit. There are
two formats of tracefile:

¢ Compact format
¢ PDB-like format

You can supply your own function, which will be called every time that the traced element is
changed. It alows creation of the trace file in the format appropriate to different tools.

Thetracing text datais written to the <output directorys/<profile names.trc file by the
Remote Server that receives the messages from the Trace_Ttask via TCP/IP socket
communication, which usually has lower priority than the other tasks. It reads the trace lines from
the buffer, where they were put during execution between two sequential stepsin the TRACE TaASK.
It means that the buffer size, which the user can change, should be big enough. The buffer sizeis
set in the Target Task Settings window.

Infact, polling rate, priority and buffer size are interconnected. If the priority islow (e.g. 255isthe
lowest available priority for VxWorks), the buffer size should be as big as possible. If the polling
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rateishbig (i.e. it isanumber of ticks of the delay between two sequential stepsin atask loop), the
buffer size and the priority should be higher.

The run-time trace process is controlled by two conditional expressions: start trace and stop
trace. Thefirst isevaluated at the beginning of the step in model, and the second at the end of the
step. The empty start trace field is equal to TRUE. The empty stop tracefield is equal to FALSE.
This makes the trace continuous.

Target Task Settings
The new dialog can be started by the Target Task Settings... button.
Every linein this dialog corresponds to one task. Each task is created to support one of the
following features:
¢ Remote Panel client task
¢+ Remote GBA client task
¢ Tracetask

¢ Oneor two Input Card task(s)
Each line contains the task name, the priority, the polling rate and the buffer size fields.

Any of these lines will appear/disappear if the proper feature is enabl ed/disabl ed:

¢ With Remote Panel Server

¢ Graphical Back Animation (GBA)

¢ Trace Enable (and thereis at least one item to be traced)
¢ Input mapping list is not empty

Note

If the Single Polling Rate is set, only one task will appear in the dialog list; otherwise, two
tasks will be created.

You can establish the priority, polling rate, and the buffer size for any of these tasks. But be very
careful, because improper settings may cause unpredictable behavior of the generated code. For
example, if the priority of one of the tasksistoo high, the other taskswon’t work and the generated
code will hang. Too small a buffer size may cause the buffer to overflow and physically adjacent
data would be | ost.

Target Management

This section describes the target description file in detail. Some of the keywords are actually
strings that basically are copied to the makefile created along with the generated code. Their type
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is“makefile string.” The user of this feature should have certain basic knowledge about Makefile
language.

In particular, if the user wantsto put $STM_ROOT as part of the value of string or makefile string
keywords, the $ (for a Unix target) sign would be duplicated, like “$$STM_ROOT"” or write
“$(STM_ROOT).”

Some of the keywords contain OS paths. The user should be aware about proper directory
separator character.

Type of
Key Word Possible Sample Value Description
Values
#Link command makefile "LINK = $(CO)" Linker command on the target
string os
#System libraries makefile "SYS_LIBS = -Inf Standard system libraries for the
string target OS

#Library extension string Extension of precompiled library
files

#Executable extension | string Extension of executable files

#Output file keyword string Name of the parameter that
toggles the name of the output
file for target OS C compiler

#Intrinsics library string Where the Rational Statemate
intrinsics libraries are put in the
given Rational Statemate
installation

#Scheduler library string Where the (Statemate)
scheduler libraries are

#Simulated scheduler | string Where the (Statemate) simulated

library scheduler libraries are

#Debugger library: string Where the (Statemate) debugger
libraries are

#GBA library string Where the Rational Statemate
GBA library is put in the given
Statemate installation

#Panel library string Where the Rational Statemate
Panel library is put in the given
Statemate installation

#Additional libraries string Additional, perhaps user-
supplied, libraries that should
participate in the linking of final
executable
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Type of
Key Word Possible Sample Value Description
Values

#Object extension string Extension of object file on the
target OS

#Archiv command string Command that should be run
when building the output_lib.a
(on UNIX) library

#File deleting string Self explanatory. It is important

command that this command is not
supposed to be interactive.

#Make command makefile "$(MAKE) -f" Self explanatory

string

#Main file directory string Name of the directory where the
final executable should be put

#CPU name string Self explanatory

#Ranlib command string Self explanatory

#K&R C compiler makefile "CC = gcc” Self explanatory

name string

#K&R C compiler flags | makefile "CFLAGS = -¢g" Self explanatory

string

#ANSI C compiler makefile "CC = gcc” Self explanatory

name string

#ANSI C compiler makefile "CFLAGS = -g" Self explanatory

flags string

#Link flags string Linker-specific flags

#ADA compiler name | string Self explanatory

#ADA compiler flags string Self explanatory

#ADA linker name string Self explanatory

#ADA linker flags string Ada linker specific flags

#Download script string Name of the script/command

name that should be run to download
the final executable to the target
0os

#Remote exec name string Name of the script/command
that executes the final
executable on the target OS

Note

Theinternal double quote character should be replaced by the single quote character. For
example, theline“ /D “PRT” should be replaced with “ /D ‘PRT”.
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You can manually change or create anew <target names.rtrg file based on your project’s
specific target prototyping devel opment system.

Only the structure of the file and the names of the paragraphs should be unchangeable. So, the best
way to change or create anew * . rtrg fileisto copy the current file under anew name (e.g. the
name of your target) and to change only the valuesin each line of the file that is affected by the
new target.

Note

Each line of the * . rtrg file is terminated by a“hard return,” which means that each lineis
effectively aparagraph. Thisisimportant to the accurate parsing of the « . rtrg file.

Every linein the = . rtrg file affects a certain part of themakefile, whichis created during code
generation, or the running of the generated/compiled code.

Pay attention to the #run script name line. Itsvalue, if it is not empty, concatenates with the name
of executable and runs as a shell command after the user selects the Run Code option of the
Compile menu. So, users can write their own batch files that will take as a parameter the name of
the executable and do any required operation. Such atechnique is used to download and execute
the generated code in aremote manner (refer to Downloading and Execution)

The content of the vxworks . rtrg fileislisted for reference in Target Description File.

It is necessary to define the nature of the Target for the prototyping system. Theinitial step in this
processis done using the dialog screen shown in the following figure. It is started using the File >
Target Management menu item from the Profile Editor. The Target Management window opens.

x

Targets
CANDE Reaill
[51102
51103 Edit |
[51103_DEG
N Telete |
[IME_NT Copy, .. |
SOLARIS
VHMORKS Export... |
WINDOMSHT

Print
WINDOWS_MET LI

Dizmizs | Help

:
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There are several predefined targets presented in this dialog screen for you to choose from. Select
the desired target by clicking on it. The selection is highlighted.

Note
No special licenseisrequired for targeting to the different platforms.

Because the rapid prototyping code generator supports an open set of user-defined targets, the list
of supported targets can be supplemented with new targets or variations of existing targets. Thisis
possible because each target selection corresponds to atarget definition file using the naming
format <os names.rtrg. All of the target related parameters are defined in that file. The buttons
aong the right hand side of the dialog screen alow for management of thisfile.

Advanced users or project teams may decide to modify the target description files. Always work
with a copy of aworking fileif at all possible. Save it under an appropriate name and document
your changes so you can back up if something doesn’t work like you expected it to.

Note

Thetarget definition fileis similar to the file used for the standard C Code Generator, which
uses adifferent extension (.trg). Thefileisan ASCII text file.

Note that the targets listed here are the files' prefix. All of the targetslisted are those that are found
(i.e,*.trg/*.rtrg files) inthe prt/rprt directory.

I/O Card Description File Management

The /O Card Management window of the File menu should be run for this purpose. For the

description of the file structure, refer to the previous table and the sample code in /O Driver
Eunctions.

Describing Signal Mapping to 1/0O Cards

The embedded rapid prototyping code generator supports mapping of basic dataitems and
conditions, relevant to the current scope, to an open set of user defined I/O locationsin the
prototyping hardware. There is no support for events, user- defined types, array elements, records
and fieldsin arecord (except for enumerated types, which are regarded as integers).

The definition of an 1/0 card is done using an ASCI|I file, with the extension “. crd”. This .crd file
contains the definition of the I/O card’s configuration, including:

¢ available channels or ports
¢ card base address
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*

*

channel/port offsets
driver function name
initialization function name

Note: It isassumed that an 1/0O card will require initialization in order to set it up for
the desired port configuration, control mode, data handling, etc.

closure function name
minimal polling rate

The compilation profile editor’s Options menu lists amenu item for I/O Mapping. This menu item
invokes the 1/0 Mapping dialog (see the following figure). This dialog presents a mapping matrix
that is used to identify the basic identity and type for each I/O card included in the system. Using a
selection mechanism similar to that used in the Simulator, this mapping matrix guides the user in
selecting dataitems relevant to the current scope and saves selected filled linesin the <profile
name>.rgenset file. It doesthis by displaying a drop-down list of available selections when you
right-click on the matrix cell for a given row and column.

x
Hans || 140 Card ||Port Mawe  ||I/0 ||
Inzert |
Delete |
Ehoose.‘.l

Single Polling Rate —

‘ 0K I Eancell Help I

As previously discussed, the mapping matrix dialog contains the following fields:

Name String Describing the Name of the Port

I/O card name Displays all of the files named *.cr d in the <wor kar ea>/ rprt files

directory

Port

Displays all of the available ports described in the selected card
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‘ I/0 Specifies the In/Out mode of the port
Note

A single I/O card can have multiple ports. Each should be assigned a meaningful name.

At the bottom left corner of the window is abutton labeled Single Polling Rate allows sel ection of
one of two modes:

¢ Single polling rate

¢ Double palling rate

The definition of the polling rates is done using another menu item, Files>1/O Card
M anagement.
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Signal Mapping to I/O: Semantics

There are two issues here: oneisinputs, the other outputs.

¢ Inputs

Whenever asignal is mapped to an input port it is regarded in a function named
top_do_inputs (), if the Single polling rate is selected, or in two functions named
top_do_high inputs () and top do_ low_inputs (), if the Double polling rateis
selected. In case of two polling rates, each input signal is handled only in one of
top_do_high inputs () Of top_do_low_inputs () according to the polling rate specified
in the card definition file:

+ All input signals whose polling rate is lower than the high polling rate is handled
inthe top_do_low_inputs () function.

+ Others, whose polling rateis larger or equal to the high polling rate, are handled in
the top_do_high_inputs () function. Those functions are started from separate
tasks (onefor top_do_high_inputs (), the other for top_do_high_inputs() in
case of two polling rates, and one task in case of single polling rate). The new
values arein effect in the following step.

¢ OQOutputs:

There are three categories of dataitems:

+  Whenever anon-Double Buffered element is assigned with avalue, acall to the
output device is done immediately.

*  Whenever aSatic Double Buffered element isassigned with avalue, acal to the
output device is done at the end of the current step. The call will be from the
generated code, near the place where it swaps the next/current values. In order to
trace the writing event, aflag will be added to the generated code, near the
definition of the current/next variables.

+  Whenever aDynamic Double Buffered element isassigned with avalue, acall to

the output device is done at the end of the current step from the update() function
inside of RT library.
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Target Trace Facilities: Description

The rapid prototyping compiler supports tracing of basic primitive dataitems, conditions and
events. The user-defined types, array elements, records, and fieldsin arecord are not supported.
Enumerated types are regarded as integers.

Tracing is done through a buffer, meaning that the code, while running, sends report text to a
buffer. That report buffer is automatically flushed to the <profiles.trc filein the output
directory.

In the compilation profile editor, the menu item Options > Trace Settings... invokes the Tracing
diaog.

The Tracing dialog contains the following items:

¢ Traceformat

¢ Tracefor: States/Textual Elements/Activities

¢  Start Trace text field

¢ Stop Tracetext field
Thetracefile <profile names.trc iswritteninto the current directory where the generated code
isrunning. Its format depends on what the user has selected, such as:

¢ Compact format

¢ PDB-like format

¢ User-supplied format

In the latter case, the user defines the name of the trace function that is called every time the traced
element value changes. The function has the following definition:

char * user func (report link elem).

It returns a text message string which is then output to the <profile names.trc file.

Both the Sart Trace/Stop Trace fields are for defining trigger expressions. The goal hereisto
support compound expressions that are composed of panel bindings-like basic elements.

Using a selection mechanism similar to that for the Simulator, right-clicking on arow/column field
resultsin a pop-up list of available selections relevant to the current scope.
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Each row contains two fields:

+ An editabletext string identifying the data item name
+ Thetrace mode (trace of the element is enabled or disabled)

Note

It is also possible to start/stop tracing using two API functions. enable trace (), and
disable trace().
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Target Trace Facilities: Semantics

Trace messaging isimplemented is similar to the mechanism applied to the I/O output reporting.
Whenever the tracing is On, meaning the Start Event occurred, areport lineis added to the report
buffer and subsequently output to atext file:

¢ If anon Double Buffered element is assigned with avalue, the trace will be done
immediately.

¢ |f aSatic Double Buffered element is assigned with avalue, the trace will be done at the
end of the current step. The trace function will be called from the generated code, near the
place where it swaps the next/current values. In order to trace the writing event, aflagis
added to the generated code, near the definition of the current/next variables.

+ |f aDynamic Double Buffered element is assigned with avalue, the trace function will be
called at the end of the current step from the update () function.

Data Types Introduced to the Intrinsics Library

This section includes the following information:

¢ Data Types Related to the Data Items

¢ Report Elements for Output Mapping and Tracing

¢ Report Elements for Input Mapping

¢ Report Elements for Generic Charts

Data Types Related to the Data Items

For each element that is either traced or has 1/0O mapping associated with it, the instance of the
following data structure is generated:

typedef struct report elem {

/* -- general */

char* elem name; /* -- name of the reported element */
char* inst_name; /* -- name of the generic instance */
genptr elem value; /* -- pointer to the value of the

-- __model _ element */

el enum elem type; /* -- type of the reported element */
int str len; /* -- if non-zero - length of the

string */
genptr user_data; /* -- user defined misc data */

/* -- tracing */
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rep_ funcp trace func; /* -- trace function pointer */

boolean immediate; /* -- if TRUE bypass the list */

/* -- input/output mapping */

/* -- common for both in and out */

card desc_p card p; /* -- the card associated with this model --
element */

char* pin offset; /* -- offset off the base */

char* pin name; /* -- name of the pin */

int pin number; /* -- pin position within pin

array of card p, starting
from 0 */

/* -- input mapping specific */
rep funcp in func; /* -- for input mapping */
genptr received val; /* -- buffer for storing the new value of -- the
model element received from the -- card */
genptr new_value; /* -- double buffering info: -- if ZNIL then DB
is dynamic -- else the read value is directly -- written to *new value */
/* -- output mapping specific */
rep_ funcp out_func; /* -- for output mapping */
/boolean pin_inverse; /* -- if TRUE inverse the reported value bitwise
*
boolean buffered; /* -- if TRUE output is buffered */
/* -- list management */
report_link next_elem; /* -- next element of the list of reported

elements */

} report elem;

Thisdeclaration is copied from types . h of the Intrinsics library. The variable of thistypeiscalled
“report element”. It contains all information about dataitem and its tracing and

I/0 mapping specifics that at the moment seems necessary. The purpose of user_data field isto
provide users with the capability to add whatever datathey desire. It isimportant because report
elements are visible to the code that should be written by the user.

Each report element that is associated with apin of al/O card hasits card p field non ZNIL. This
allows Rationa Statemate to serve I/O mapping requirements in a per-element fashion.
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Report Elements for Output Mapping and Tracing

For each place where dataitem is changed, Rational Statemate generates the following
instrumentation: { X =5; add_report(&rep_X); }. By caling the ada_report () function, the
report element corresponding to X to the list of elements that were changed during the current step
is added. At the end of this step, a specia function passes the list and calls functions that do the
actual tracing and/or out mapping. If immediate field of report element istrue, the add report ()
function bypasses the list mechanism and calls immediately to the function that does the tracing.

If a the current step the tracing is switched off, the add_report () function does nothing. The list
of the report elementsis static; that is, there is no dynamic memory alocation. The list
management is done statically by manipulating the next _elem field of the report element.

All buffered tracing messages are sent to the trace buffer. The buffer has afixed, predefined size.
The same moment the buffer becomesfull, its contents are out and cleaned up. The sameisdone at
the end of each step, regardless of whether the buffer isfull. This processisrunin the low-priority
task.

In output mapping, the buffered field of the report element dictates the way the output message is
handled. Either it is buffered in the manner similar to tracing, or it is sent to the output card
immediately.

Report Elements for Input Mapping

If there are model elements that require input mapping, Rational Statemate generates the tree-like
structure of input mapping functions that is similar to thetree of init () functionsin the model.
Each such function callsto the in_func () field of those report elements that belong to the current
scope.

There are three fields of report element that control the input mapping mechanism:

¢ elem_value- The pointer to the actual value of the element. It is used in the input mapping
if the model element that corresponds to this report element is dynamically double
buffered and the set* () function must be called.

¢ new_value- The double buffering information. If this pointer isZNIL, the model element
is dynamically double buffered. Otherwise, the value received from the card is directly
assigned to the variable in the code referenced by this pointer.

¢ received_val - The buffer where the data read from the card is stored until it is assigned to
the model element. Thisfield is part of API between user-written card driver and
generated code. The card driver should put there the value that it reads from the card.
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Report Elements for Generic Charts

If atraced or 1/O mapped element is passed to some generic chart as a parameter, its report element
is also passed to the generic chart aswell. In this case, an additional parameter of the generic chart
is generated. All other attributes of dataitem in the generic are generated for the report element as
well. Thisincludes a macro for accessing the report element, its declaration, and so on.

Suppose now that user decides to do tracing or 1/O mapping for some local variable in some
generic chart. In this case, the user must provide the full name of the dataitem (including the
instance name) for every instance of the generic in the model. In this case, areport element is
generated within the generic and the context-switching mechanism ensures that each instance hasa
separate report element. The generated code ensures also that such report elements are initialized
separately for each instance of the generic.

Data Types Related to I/0O Cards

The following data structure describes the 1/0 card:

typedef struct card desc_elem {

card _drvp card _drv; /* -- card driver function */
card_ funcp card_init; /* -- card init functions */
card_funcp card_close; /* -- card closing function */
char* base addr; /* -- base of the target memory

location */

report link* pin array; /* -- array of pins of this card/
array of associated model
elements */

genptr user data; /* -- user-defined misc data */

} card_desc_elem;

This declaration is also copied from types . file of the Intrinsics library. The variable of thistype
iscalled “card element”. It contains all the information about the 1/0O card. The purpose of the
user data fieldisto allow usersto add whatever data they want to the card element, because card
elements are visible to user-written functions.
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Each card element contains information about all its ports. It is represented as an array of report
elements, each of which describes asingle port of the card. Thus, the cross-referenced data
structureis built in the generated code. Each report element involved in I/O mapping has a pointer
to its card element, whereas each card element has an array of pointers to the report el ements that
areits1/O ports. Thisdatarelation is static and isinitialized in the init () functions generated in
the code.

It is assumed that each card is controlled by three functions that do the following:

* |nitializesthe card.
¢  Savesasadriver. Itspurposeis basically to read datafrom, and write to, the card.

¢ Closes the communication with the card.

Remote Connection to Different Tools: Panels, GBA,
Tracing: Description

Rational Statemate rapid prototyping includes provisions that allow data exchange between the
executable that runs on the target, and a host. Thisis done while trying to minimize any negative
effects on the regular execution flow of the embedded code.

All communications between the executable embedded code and the host tools is done through
special, statically allocated buffers. Aslow-priority tasks, they are started periodically and/or
according to other criteria, sending the communication buffer’s contents to the host. The user
should run the remote panel server or Remote GBA server on the host machine before running the
generated code on the target system.

Note
Remote panels are not supported.
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BSP Configuration

Before configuring of the BSP, the user should change the config.h file based on the following
information:

¢ Network board type

¢ 1/O network bus base address

¢+ |IRQleve

¢  Target name

¢  Target IP address
After changing the configuration file, the user can run windconfig (part of the Tornado
development environment) to add or delete the options for the BSP build target.
The user must build the following:

¢  bootrom uncp
¢  VxWorks
¢  VxWorks.sym
Refer to the VxWorks Programmer’s Guide for a detailed explanation of how to do this.
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Environment, Directories, Libraries, Files

Just as with other Rational Statemate features, there are environment variables that must be
properly set. These include:

WIND_BASE Tornado home directory.

WIND_HOST_TYPE Host OS type (x86-win32,
sun4-solaris2).

STM_ROOT Rational Statemate home directory.

PATH The path. It should be added by:

%WIND_BASE%\host\%WIND_HOST_TYPE%\bin

Thefollowing libraries and object files can be used by the linker for the build of the target
executable:

libintrinsicsI80486.a
1ibdbgI80486.a
librpgert1I80486.a
libgbaI80486.a
libschedulerI80486.a
libsim_schedulerI80486.a
real mainI80486.0
real_main_dbgI80486.0
sync_mainI80486.0
sync_main dbgI80486.0

async_mainI80486.0

® 6 6 6 6 4 0 6 0 o 0o o

async_main dbgI80486.0

They are placed into the ssTmM_rRooT$\1ib\vxworks directory. If an aternate location is desired, it
is necessary to change the appropriate linesin the vxworks . rtrg file. Thisfileis created
automatically when the workareais created and islocated in the <workareas>\rprt directory.

Note

The rprt directory also contains the profilefiles (. rgenset), the target description files
(.rtrg), and I/O card description files (. crd).
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Getting Ready: Connecting the Target to the Host

Depending on the specifics of the prototyping system’s hardware implementation, it is necessary
to establish a communications link between the target and the host. Thisis usually a seria
interface such as an RS-232/485 port or an ethernet port.

If you are using the Wi ndRiver® Tornado devel opment environment, run the FTP server as
described in the Tornado User’s Guide. Here is the example of the .sh file, which can be used for
this purpose:

cd $WIND BASE\host/$WIND HOST TYPE%\bin
wftpd32.exe & -- The Windows FTP Daemon running

wtxregd.exe -V -- Tornado registry daemon running

You should add the name and | P network address of the host and target into the file called nosts,
which islocated into the \winnt\system32\drivers\etc directory (further details can be found
in the Tornado User’s Guide.
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Once the target requirements have been defined and the model designed, code can then be
generated and compiled. This section describes these steps, as well as general considerations of
coding for an embedded prototyping system.

Code Generation Sample Model Description

The following sections describe how to generate code using a sample model. This sample model
uses asingle 1/0 card on an x86 prototyping devel opment system running the VxWorks RTOS.
The following figureillustrates the I/O card configuration.
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Download APPLICATION CODE :

HOST PC . :
. PC104 (x86 CPU) -
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Report and Card Elements Declarations

Thefollowing codeis generated in r2main. c:

card _desc_elem card card 1 desc;

report_link pins_card_ 1 desc[2];

card _desc_elem card card 2 desc;

report_link pins_card_ 2 desc[2];

Corresponding extern declarations are generated in r2main.h. ASyou can see, this profile
includestwo I/O cards. Each of these cards has two pins. The number of pinsisexactly the number
of elementsinpins *arrays.

Initialization

The following is a sequence of initialization actions required for 1/O mapping:

¢ Initialize all card description elements. At thisstage, thepin_array fieldisset so
correspondence between card elements and their pin arrays is established.

¢ Initidlizeall pin arrays by O.

¢ For every module, initialize report elements that belong to the module. At the same
moment, the corresponding element of the pin array is set to be a pointer to the current
report element. The pin arrays are completely initialized. The card p field of the report
element isaso initialized. The cross-referenced data structure is built.

¢ (Cdl the card initialization routines provided by the user. Note that at this moment, all data
structures related to the 1/O mapping in the code are built.
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The following portions of r2main.c and m1 . c illustrate these points:

r2main.c:
void lo_init ()
{

init card desc(&card card 1 desc,
card generic driver, card generic_init,
“card 1",pins_card 1 desc);

init card desc(&card card 2 desc,
card generic driver,card generic init,
“card 2",pins card 2 desc);
memset (pins_card_1 desc,0,2*sizeof (report link)) ;
memset (pins_ card 2 desc,0,2*sizeof (report link)) ;
ml init () ;
dbg init () ;
(*card card 1 desc.card init) (&card card 1 desc) ;

(*card card 2 desc.card init) (&card card 2 desc) ;

ml.c:
int X_IN1;
report elem rep X INI1;
int X _IN2;
report_elem rep X IN2;
int X_OUT1;
report elem rep X OUT1;
int X_0UT2;
report elem rep X OUT2;

void ml_init ()
{
init int(&X IN1,0);

init_report (&rep_X_ IN1,"A2:X IN1","",&X INI,
el enumer,0,trace f,FALSE, &card card 1 desc,
"0x0012","1", 2, input mapf,NULL,NULL, FALSE, FALSE) ;

init_int (&X_IN2,0) ;

init report (srep X IN2,"A2:X_IN2","", &X IN2,
el enumer, 0,NULL, FALSE, &card card 2 desc,
”OX0012","l",2,input_mapf,NULL,NULL,FALSE,FALSE);

init_int (&X OUT1,0) ;
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init_ report (&rep X_OUT1,"A2:X OUT1","",&X OUTL,
el enumer,0,trace_f,FALSE,
&card card 1 desc,"0x0013","2",1,NULL,
NULL,output_mapf,FALSE,FALSE);

init_int (&X OUT2,0) ;

init report (&rep X OUT2,"A2:X_OUT2","", &X OUT2,
el enumer, 0,NULL, FALSE, &card_card_2_ desc,
"0x0013","2", 1,NULL,NULL,output mapf,
FALSE, FALSE) ;

init activity(&Al,activ,FALSE,0,0,0,0,0,"Al",FALSE);

Step Execution

Thepr make step( ) function does the following:

*

*

*

At the beginning of each step, it determines whether tracing should be enabled.

The function that goes through the list of report elements that were changed during the
current step and produces the output mapping and trace messagesis called.

At the end of each step, the stop trace condition is checked; if it holds, tracing is disabled.

The generated code is as follows:

r2main.c:

boolean pr make step ()

{

boolean step has changes = FALSE;

incr stepN() ;

if (X _OUT1 > 0)
enable trace() ;

lo main() ;

step_has changes = update() ;

garbage collect () ;

if (!step has changes && (!deb was update()))
return TRUE;

if (call cbks p)
(*call cbks p) (FALSE) ;
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update () ;
do_report () ;
if (X_OUT2 < 0)
disable trace();

return FALSE;

Input Mapping

You must build atree-like structure of functionsto perform input mapping. In the example, thereis
only one module other than main, so it looks like this:

r2main.c:
void do_inputs ()

{

ml_do_ inputs();

ml.c:
void ml _do_inputs ()

{
input mapf (&rep X IN1) ;

input mapf (&rep X IN2) ;

The input_mapf () function does the following:

+ Prepares aplace in memory for the value to be read.
¢ Cadllsto the card driver function to read the new vaue of the dataitem from the card.

+ According to the type of dataitem and double buffer settings within the report element,
assigns the read value to the corresponding model element.
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Starting Code Generation

Once code is successfully generated, it is ready for compilation.

Code is generated from the profile editor main screen. From an open profile, select the Compile >
Check Profile menu item to confirm that the profile is complete and ready to generate code. If an
error is reported, it must be reconciled before code can be generated.

To generate code, select the Compile > Generate Code menu item or click on the Generate Code
speed button. Thisinitiates the code generator and causes atext box to appear. It displays messages
about the progress of code generation.
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FASCIA

Mezsages

Procezzing Compilation Profile ...

Processing Workarea ...

Scope calculations ...

Gererating names ..

Generating expreszionsz,,.

Checking panel bindings,..

Generating Actions and procedures,, .

Writing code into  Eitvwwadsddhhair_cond_wadpriseverythingd

Creating  everythingmain.c ...
In addition, the following files were created:
g_steps.c + g_steps.h
all_1l,c + all_1,h
g_seven_segment_generic,c + g_seven_segment_generic,h
uger_activities,c + user_activities.h
Procezsing interface files ...
Writing ewerything,info ...
K& C code created.
#%% See info file for warnings.

|-
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Compiling Generated Code

The compilation and linking of code istotally dependant on the specified target. This means that
the user must supply the suitable compiler/linker for the desired target.

Compilation and Linkage.

The environment variableswinp_Base, wIND _HOST TYPE, and paTu must be set properly before
running Rational Statemate.

The compilée/link process can be started indirectly from within the profile editor. Thisis done by
using amake file, which isinitiated from the Compile > M ake Code menu item or by clicking

Compile Generated Code

This method allows the make file to be modified to accommodate the unique regquirements of a
specific compile/link process, including the downloading of compiled code into atarget embedded
prototyping system.

Downloading and Execution

After the target is booted and the generated code is compiled, you can run the executable. If you
intend to run the model directly on the embedded prototyping system target, you should start the
target server on the host machine, load the executable, and start it on the target.

Thetarget server can be started from the command line using the following command:

tgtsvr -V <target name>

L oad the executable using the following command:

1ld 1, 0, “<executable name>"

Run the executabl e using the following command:

vxmain

If you intend to run the model using the windsh remote shell, you must complete the following:
Start the target server.
Run windsh.

Redirect the standard 1/O files to the virtual console window.

A 0w Dd P

Download and execute the model on the target.
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These actions can be done using the run_windsh batch file, whose full name (including path)
should be printed into the #Run script name paragraph of the <targets.rtrg file. It looks

something like the following:

#Run script name:”%STM _ROOT%\bin\run windsh <target name>",

In the command, <target name> isthe name or TCP/IP address of the target machine.

Note

Thefiles run windsh.bat and run_windsh.csh arelocated in the encrypted VxWorks

distribution file.

The run_windsh batch file has two input parameters (target name and executable name) and looks

like the following:

For Windows host platforms:

#Creating of the file for model executable download and execution

echo ioGlobalStdSet (0,vf0)
channel 0

echo ioGlobalStdSet (1,vf0)
file

echo ioGlobalStdSet (2,vf0)
file

echo logFdAdd (vfo)™"
the virtual channel 0

echo 1d 1,0, "%2"
executable

echo vxmain
starting

)

>> run model.bat- reopening of the virtual I/O
>> run model.bat- designation of standard input
>> run _model.bat - designation of standard error

>> run_model.bat- sending logging output to
>> run_model.bat- download of the

>> run model.bat- model execution

start tgtsvr $1 -C -c%WIND BASE%/target/config/pc486/vxworks - target

server starting

#WindSh running

windsh -n -s run model.bat

%1 > null
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For UNIX platforms (Solaris):

#Creating of the file for model executable download and execution
#! /bin/csh -f

echo 'vfO=open("/vio/0",2,0)' > run_model.csh

echo "ioGlobalStdSet (0,vf0)" >> run model.csh

echo "ioGlobalStdSet(1,vf0)" >> run model.csh

echo "ioGlobalStdSet (2,vE0)" >> run model.csh

echo "logFdAdd (vfo)™" >> run _model.csh
echo 'ld 1,0, "'g2'"! >> run_model.csh
echo "vxmain" >> run_model.csh

windsh -n -s run_model.csh $1

Now the model system is ready for debugging.

Remote Panel

The following figure shows the remote panel dialog.

Remote
Panel
Feature
Select

" Global Profile Settings for REAR_DEFOG

Target
Output
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GBA

To open this panel, click Options > Global Profile Settings.

If the mode is set, the code generator creates a proper makefile and additional elementsin the
generated code. In addition, when you run generated and linked code using the Compile >
RunCode menu item, the profile editor sends the request to the main of Rational Statematein
order to run the Remote Panel/Trace Server. If the Tar get [output] Directory field is not empty,
the Profile Editor copies the rcomm. cfg file (created by the Remote Server) into the target output
directory where the code was generated. This configuration file contains the host name, the input
port and output port addresses, and the debug level number.

Thetarget output directory is defined by the appropriate entry in the Global Profile settings form.
It should be the same directory defined in the file selection box during code generation, but in
terms of the target file system. For example, the host output directory has the following path:

d:\tmp\io\rprt\io

The target output directory would be:

/tmp/io/rprt/io

If the target directory field is empty, the executable looks for the rcomm. cfg file in the workarea
directory. It should normally be seen from the target exactly with the same name as in the host
machine.

Next, run the generated code using the remote execution script whose name is defined in the
<target 0OS>.rtrg file.

The Graphic Back Animation (GBA) mechanism’s configuration functions are similar to those of
the remote panel feature. It uses the configuration file gba . cfg, which is created when the GBA
server runs. Thisfile contains the following information:

¢ Host name
* Port address
+ Debug level number (used for debugging purposes only)

After the configuration fileis created by the GBA server, the Profile Editor copiesit, and then
deletes it from the workarea. Thisfile is needed only in the first running of the generated code. If
you subsequently run the same configuration of the host and target, there is no need to recopy this
file. Generated code can use the existing file, so you can run it manually using the RunCode
command from the Profile Editor.

To start the GBA server, use the Tools > Open GBA menu item of the Profile Editor.
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Trace Facility

If some variables (states, dataitems, conditions, or activities) are selected to be traced, the trace
task is created automatically when generated code executes. This trace task uses the Remote
Server to output the trace message data into the <profile names.trc file, located in the target
output directory. Its reporting mechanism is the same as that used for the Remote Panel feature.
The basic mechanism allows the trace message data to be sent to the trace buffer, whose length is
user-definable in the dialog called by the Options > Trace Settings menu item.

You can aso define the format of the tracein thisdialog. The format information iswritten into the
.tre file

If you select the User Supplied function name, every time the variable value is changed, this
function is called instead of the standard trace function normally supplied by the 1ibintrinsics
library.

Trace Settings for REAR_DEFOG N 5[
Traces Pdb-Like = |

~Trace for States

State Mame || Enable " |

Ingert

Delete

Choosze

e

_Trace for Textual Elements

Textual Mame ||Enable |l =

Ihzert

Choose, ..

l

~Trace for Activities

O]

fictivity Name ||Enable ||

Ihzert

Choose, ..

l

o HREC O REE L HEE

Start Trace: E

Stop  Trace: I

0k I Cancel | Help
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User-written code is the term applied to any custom code added to the generated code and included
in the subsequent compilation. It is also called handwriiten code. This code may include
modificationsto the generated code, pretested and prequalified code modules, or special test or use
case routines.

The interface between the |I/O cards and the generated code is the responsibility of the user. This
means that the user must supply at least three functional modules/routines:

¢ |/O card initialization routines

¢ 1/O hardware driver routines

¢ /O card shut-down/closure routines

The card element data structure contains a descriptive paragraph with the details of the API that
generated code providesto its user. The card is a pointer to these three functions.

Card Initialization

The card initiaization function should have one parameter, which is a pointer to the card element
structure. When this function is called from the generated code, all internal data structures of the
generated code are initialized properly.

Card Driver

The card driver function should have two parameters. Thefirst is a pointer to the report element
structure. The second is an integer that defines whether to perform input or output mapping. It is
recommended that you use the constants stm_1n map and stm_out Mmap (defined in thefile
types.h Of the Intrinsics library) for this purpose. When you perform input mapping, the driver
should put the received value into the received vai field of itsfirst argument. Note that
information about the corresponding card is available from the card p field of the report element.
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Card Closure

The card closure function has one parameter—a pointer to the card element structure. Its purpose
isto perform the necessary actions upon finishing the work with the card. Refer to Ada Code
Generationfor an example.
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Because of the highly hardware dependant nature of embedded code, the following exampleis not
provided within the software. Neverthel ess, this section examines a simple example application in
terms of the hardware target and procedures necessary for setting up the system so that code can be
generated and downloaded into the target.

Use Case

The use case example that is the subject of the sample code presented here isa simpletail light
controller for an automobile. It is uses an x86 CPU based prototyping development system
equipped with a PC104 bus and one digital 1/0 card (i.e. ONY X-MM-DIO). The devel opment
system is equipped with an ethernet controller which is used as the serial link to the host system.
The RTOS is VxWorks and the compiler/linker/debugger is integrated into the Tornado
development environment. Rational Statemate is hosted on a Pentium laptop where all model and
code development is performed, as well as all remote terminal functions. The following figure
illustrates the basic system configuration, including 1/0 functions.
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I
FLASHER SWITCH ! FLASHER

LIGHT SWITCH ! LIGHT
BRAKE LIGHT SWITCH ONYX-MM-DIO BRAKE LIGHT
FOG LIGHT SWITCH FOG LIGHT

BACKUP LIGHT SWITCH BACKUP LIGHT

HOST PC

I/O Driver Functions

The following code sampleis taken from aworking driver file implemented to support the ONY X-
MM-DIO I/O card from Diamond Systems Corp.

Example Code:

#include <vxWorks.h>
#include <stdio.h>
#include <stdlib.h>
#include <syslib.h>
#include "types.h"
#include "symbols.h"

#include "string.h"
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#define DIO_1A 0
#define DIO_1B 1
#define DIO_1C 2

#define DIO_1CR 3
#define DIO 2A

4
#define DIO_2B 5
#define DIO_2C 6

7

#define DIO_2CR
int onyx_base_addr; /* The card base address , converted into int format */

/* -- generic card initializer for both input and output mapping */
void onyx init(card desc_p card p)

{ int addr;

sscanf (card p->base addr, "%$x", &onyx_ base addr) ;

printf ("base addr = 0x%x\n",onyx base addr) ;

sysOutByte (onyx_base_addr+ DIO_2A,0x00); /* Reset of output registers before
setting of 2A port

to be output */
sysDelay () ;

addr = onyx_base addr+DIO_1CR;/* control register 1CR address
*/

/* Port 1A , 1B and 1C set to OUTPUT/MODE 0 */
sysOutByte (addr, 0x80) ;
printf ("Ports 1A , 1B and 1C set to OUTPUT/MODE 0\n") ;

sysDelay () ;

addr = onyx_base addr + DIO_2CR; /* control register 2CR address

*/
sysOutByte (addr, 0x9B) ; /* Port 2A , 2B and 2C set to INPUT/MODE 0 x/

printf ("Ports 2A , 2B and 2C set to INPUT/MODE 0\n") ;

/* -- generic card driver for both input and output mapping */
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void onyx in(report link elem)
{
genptr new value = (genptr)elem->received val;

int b, offset;

sscanf (elem->pin_offset,"%d", &offset) ;

b = sysInByte (onyx base addr+offset) ; /* input from 2A port */

switch(elem->elem type) {

case el integer:

case el enumer:

case el bit_array:
* (int*)new value = b;
break;

case el condition:

case el _event:
* (char *)new value = b;
break;

case el _real:
* (double*)new value = b;
break;

default:
* (int*)new value = 0;

break;

#define OUTPUT BUF_ SIZE 16

double output buf;

void onyx out (report link elem)

{
void *actual_val = (void*) &output buf;
int offset;

sscanf (elem->pin offset,"%d", &offset) ;
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switch(elem->elem type)
case el integer:
case el enumer:
case el bit:
case el bit array:
if (elem->pin_inverse)

(* (int*)actual_val)

~(* (int*)elem->elem value) ;
else
(* (int*)actual_val) = (*(int*)elem->elem value);

sysOutByte (onyx base addr+ offset, *(char*)actual val); /* a=> output
to 1A port */

break;
case el real:

(* (double*)actual val) = (*(double*)elem->elem value) ;

break;
case el condition:
case el _event:
if (elem->pin inverse)
(* (char*)actual val) = ~(*(char*)elem->elem value) ;
else

(* (char*)actual val)

(* (char*)elem->elem value) ;
sysOutByte (onyx base addr+ offset, * (char*)actual val);
break;
default:

break;

void onyx driver (report_link elem, int map_mode)

{
if (map_mode == STM_OUT MAP) ({

onyx_out (elem) ;

}
else if (map _mode == STM_IN MAP) {

onyx_in(elem) ;

Rational Statemate 197



Simple Embedded Code Example

/* -- generic card closing function */

void onyx close(card desc p card p)

{

/* Some RESET calls for I/O card */

printf ("Card has been closed\n");

}

Target Description File

This section describes details of the target description file. Some of the key words are actually
strings that are basically copied to themakefile that is created along with the generated code. For
clarity, we call their type: makefile string. To use this feature, you should have certain basic
knowledge about Makefile language and syntax. Examples of possible values for important key
words are included in the sample code listing.

In particular, if you want to use ¢stm_rooT as part of the value of astring or a makefile string key
word, it is necessary to use aduplicate $ sign to correctly express the variable type. For example:
“$$STM_ROOT”

Note that some of the keywords contain OS path information. You should be aware of the correct
directory separator character to use for the target operating system.

The internal double quote character shown here should be replaced by the single quote character.
For example, theline “ /D “PRT” “ shouldbe *“ /D‘PRT’ “.

Example Code:

The following exampleis taken from the vxworks . rtrg file for the target OS. VxWorks.

#UNIX-1like target OS:yes
#Link command:"LINK = $(LD)"
#System libraries:""
#Library extension:".a"
#Executable extension:""

#Output file keyword:"-o "
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#Intrinsics library:"$(STM_ROOT) /lib/VxWorks/libintrinsics$ (CPU) .a"
#Scheduler library:"$ (STM_ROOT) /lib/VxWorks /libschedulers$ (CPU) .a"

#Simulated scheduler library:"$(STM_ROOT) /lib/VxWorks /
libsim schedulers$ (CPU) .a"

#Debugger library:"$ (STM_ROOT) /lib/VxWorks /libdbg$ (CPU) .a"
#GBA library:"$(STM_ROOT) /lib/VxWorks /libgba$ (CPU) .a"
#Panel library:"$ (STM_ROOT) /lib/VxWorks /libpgertl$ (CPU) .a"
#Remote panel library:"s(STM_ROOT)/lib/VxWorks /librpgertl$ (CPU) .a"
#Additional libraries:""

#0bject extension:".o"

#Archiv command:"$ (AR) $ (ARFLAGS) "

#File existing command:""

#File deleting command:"$ (RM) "

#Make command:"$ (MAKE) -f"

#Main file directory:"$(STM_ROOT) /lib/VxWorks/"

#CPU name:"CPU = I180486"

#Ranlib command:""

#K&R C compiler name:""

#K&R C compiler flags:

"STM_CFLAGS = -O -IS( STM_ROOT )/etc/prt/c -IS( STM_ROOT ) /etc/sched -DPRT -
DVxWorks™"

"TOOL = gnu"
"include $(WIND BASE)/target/h/make/defs.bsp"
"include $(WIND BASE)/target/h/make/make.$ (CPU)$ (TOOL) "
"include $(WIND BASE)/target/h/make/defs.$ (WIND HOST TYPE)"
"include $(WIND BASE)/target/h/make/rules.bsp"
"INCLUDE QUALIFIER=-I"
"CC_OPTIM += $(STM_CFLAGS)"
#ANSI C compiler name:""
#ANSTI C compiler flags:

"STM _CFLAGS= -O -I$( STM ROOT )/etc/prt/ansic -I$( STM_ROOT )/etc/ansisched -
DPRT - VxWorks"

"TOOL = gnu"

"include $(WIND BASE) /target/h/make/defs.bsp"

"include $(WIND BASE)/target/h/make/make.$ (CPU) S ( TOOL) "
"include $(WIND BASE)/target/h/make/defs.s$ (WIND HOST TYPE)"
"include $(WIND BASE)/target/h/make/rules.bsp"
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"INCLUDE QUALIFIER=-I"
"CC_OPTIM += $(STM_CFLAGS)"
#Link flags:"-r "
#Make script name:""

#Run script name:"%$STM_ROOT%\misc\VxWorks\run windsh mary"
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dSPACE Support

The Rational Statemate Embedded Rapid Prototyper (ERP) supports dSPACE models DS1102 and
DS1103. The dSPACE DS110* models are single-board solutions—the processor and 1/0 are
located on the same card.

The dSPACE interface enables you to do the following:
¢ Generate C code from the Rational Statemate model, compile the code, and download it to
the dSPA CE machine with asingle click.
¢ Map model elements to the board I/Os.

+ Automaticaly generate dSPACE TRC files for use with dSPACE ControlDesk layouts.

This section describes the required driver configuration and sample usage. The topics are as
follows:

¢ The dSPACE Package

¢ Before You Begin

¢ Using the dSPACE Interface

¢ Generating TRC Files

¢ /O Driver Configuration Settings
¢ Driver Tasks

¢ Signals

¢  Port Names

¢ Implementing User Tasks
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The dSPACE Package

The dSPACE package includes the following:

¢ Run-time library source code and batch files (which must be compiled on your machine).
Thelibraries are linked with the generated code and the resulting executableis
downloaded to the target. Refer to Before You Beginfor more information.

¢ |/Odriver library source code and batch file. The library performs the I/O calls according

to the ERP I/O mapping definitions. Refer to /0 Driver Configuration Settings for more
information.

¢ Automatic generation of TRC files, which are used for variable binding in the
ControlDesk. Refer to Generating TRC Files for more information.

Unsupported Rational Statemate Functionality

Currently, the following Rational Statemate functionality is not supported on the dSPACE
hardware:

¢ Graphical Back Animation (GBA) and the remote panel

¢ User tasks

When you define tasks, keep the following in mind:

* Thereisaspecia format for writing user tasks for dSPACE, which is different
from the one used for other targets. Therefore, you should modify existing models
in order to execute them on the dSPACE machine.

+ The main benefit of atask (running concurrently to the model) is effectively lost
on the dSPACE hardware—the behavior is no different from a normal Rational
Statemate subroutine defined as a procedure or function.
For more information, refer to Implementing User Tasks.
¢ Continuous diagrams (VISSIM)
+ Simulated synchronous and simulated asynchronous time model
¢ Double polling rate
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Unsupported I/O Signals
Thefollowing 1/0 signals are not supported on the dSPA CE model DS1103 hardware:

*  PWM3 generation (synchronized 3 PWM signals)
¢ PWMSV generation
¢ CAN
+ Synchronized reading of A/D converter (ADC) signals
¢ Serial interface
¢ Slave ADC
Refer to Signals for thelist of supported signals.

Before You Begin

Before you begin using the dSPA CE interface, perform the following tasks:
1. Editthe run_stmm.bat file.

2. Compiletherun-timelibraries.

Editing the Batch File

To use ERP on dSPACE hardware, you must edit the batch file ssTM_RrRoOT$\bin\run_stmm.bat.
Refer to the dSPA CE section of thefile for the list of necessary changes.

Compiling the Run-Time Libraries
The following sections describe how to compile the run-time libraries for the dSPACE boards.

¢ DS1102
¢ DS1103
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DS1102
To compile the run-time libraries for the DS1102 board, complete the following:

1. OpenaDOS shell.
2. Set the environment variable stM_ROOT.

3. Executethefollowing file:

$STM_ROOT%\etc\prt\c\create DS1102 intrinsics.bat

4. Execute thefollowing file:

$STM_ROOT%\etc\sched\create DS1102_ sched.bat

DS1103
To compile the run-time libraries for the DS1103 board, complete the following:

1. OpenaDOSshell.

2. Execute the following batch file:

$STM_ROOT%\etc\rapid\build DS1103_ libs.bat
<Statemate installation dir>

For example:

$STM_ROOT\etc\rapid\build DS1103_ libs.bat C:\IBM Rationall\stmm\4.6

When you execute the batch file, the following libraries and object files are created:

$STM_ROOT%\1lib\dspace\DS<xxxx>\libintrinsics.1lib
$STM_ROOT%\lib\dspace\DS<xxxx>\libscheduler.lib
$STM_ROOT%\etc\rapid\ds<xxxx>\obj\stm ds1103.1lib
$STM_ROOT%\1lib\dspace\DS<xxxx>\real main.obj
$STM_ROOT%\1lib\dspace\DS<xxxx>\sync_main.obj

$STM_ROOT%\1lib\dspace\DS<xxxx>\async main.obj
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To compile the remote debugger run-time libraries for the DS1103 board, compl ete the following:
1. OpenaDOS shell.

2. Execute the following batch file:

$STM_ROOT%\etc\rapid\build DS1103_ libs_dbg.bat <Statemate installation
dir>

For example:

build DS1103 libs dbg.bat C:\IBM Rationall\stmm\4.6
When you execute the batch file, the following libraries and object files are created:

$STM_ROOT%\1lib\dspace\DS<xxxx>\libintrinsics dbg.lib
$STM_ROOT%\1lib\dspace\DS<xxxx>\libscheduler dbg.lib
$STM_ROOT%\etc\rapid\ds<xxxx>\obj\libdbg.lib

$STM_ROOT%\1lib\dspace\DS<xxxx>\real main_ dbg.ob]j

Using the dSPACE Interface

The following sections describe how to use both the normal dSPACE interface and remote
debugger mode.

Normal Use

To use the dSPA CE interface, complete the following steps:
1. Open Rational Statemate and click the Embedded Rapid Prototyper icon.

2. Select Options > Global Profile Settings. The Global Profile Settings window is
displayed.

3. Enter stm_dspace.n in the Packages/Headersfor External Subroutinesfield.

4, Unselect_ the options With Debugger, With Remote Panel Server, and Graphical Back
Animation.

5. Select thetarget in the Target field. For example, DS1103.

6. Click OK to dismiss the window.

7. Click Options > Time Settings >Time model in the Profile Editor.

8. Select Real Time.
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0.

10.

Use the I/0O mapping tool (refer to Describing Signal Mapping to /O Cards) to map model
elements to 1/0O ports using the DS1103 card.

Refer to Setting the I/O Polling Rate for more information on |/O.

Generate, make, and run (load) the code. Two scripts are called in the process to make the
generate code and to load the executable.

Remote Debugger Mode

Remote debugger mode provides model-level debugging. The ERP interacts with the target using a
terminal program running on the host and communicating with the target via serial
communication.

Note the following restrictions:

*

*

I/O is not supported in remote debugger mode.
Remote debugger mode is not supported on the DS1102 board.

To use remote debugger mode, complete the following:

1
2.

Open Rational Statemate and click the Embedded Rapid Prototyper icon.

Select Options > Global Profile Settings. The Global Profile Settings window is
displayed.

In the field Packages/Headersfor External Subroutines, type stm dspace.h.

Select the option With Debugger, but unselect With Remote Pane Server and
Graphical Back Animation.

Inthe Target field, select DS1103_DBG.
Click OK to dismiss the window.

In the Profile Editor, click Options > Time Settings>
Time model. Select Real Time.

Connect the PC COM port to the DS1103 panel Slave RS232 connector. Usea“simple
null modem without handshaking” cable.
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9. Useaterminal program (such asthe Freeware console. exe) With the following settings:

¢ COM port—As actually connected
¢ Baud rate—9600 baud
¢ Parity—None
¢ Databits—8
¢  Sopbits—1
¢ Echo—No
10. Generate, make, and run (load) the code.

Generating TRC Files

The TRC file defines the variables that can be read to or written from the hardware by the dSPACE
ControlDesk at run time. The variables that are visible to the host are those defined in the C code
as global variables. (In the Rational Statemate generated code, all the model elements are actually
global variables.)

The variables are arranged in the TRC file in a hierarchy (groups) according to the model charts
hierarchy. This arrangement enables you to easily navigate in the Control Desk variables browser.

TRC file generation is enabled when the corresponding field in the target file (. rtrg) is set to yes,
asfollows:

#Generate dSPACE TRC file:yes

For ease of use, the TRC file has a separate group for each chart. All the defined variablesin a
chart are part of the same group in the TRC file.

In the Rational Statemate generated code, some variables are named differently from the model
name in order to solve a uniqueness problem. For those variables, the entry in the TRC fileisthe
Rationa Statemate model name (defined as an alias to the “ code name”).
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I/O Driver Configuration Settings

Some information regarding the hardware configuration (such as the frequency or the resolution
for the PWM port, or the range of the value read from the ADC port) is available to the driver at
run time. Until the information exists in the card file, it is hardcoded in a part of the driver source
code.

A C structure that holds all the required information isinstantiated in the file
stm_ds<xxxx> config.c, Where <xxxx> isthe model number of the board. The structureis
initialized to labels defined in the corresponding header file stm_ds<xxxx> config.h.

You must change the header file according to the actual card configuration, then compile thefile
with the rest of the driver libraries. Instructions for modifying the header file areincluded in the

stm_ds<xxxx>_ config.h file.

Setting the Timer Frequency

The timer interrupt frequency (timer resolution) is defined in the constant
DEFAULT TIMER RESOLUTION_ MS inthefile os_include.n. The minimum value for thisinteger
variableis 1; the default value is 10 milliseconds.

If you change this value, you must rebuild the run-time libraries to have your changes take effect.

Setting the I/O Polling Rate

You specify the 1/O polling rate using the command Files > |/O Card Management > Palling
Rate. A polling rate value 100 means that the I/O ports will be polled 100 times per second.

For more information on polling rates, refer to Target Requirements.
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Driver Tasks

The driver performs different tasks during initialization and model execution.

Initialization Tasks

During initialization, the driver performs the following tasks:

* Processes signal mapping information, which isread from the ERP data structure
+ Configures /O ports
¢ Cadlstheinitialization functions

Model Execution Tasks for the Driver
When reading from an input port, the driver performs the following tasks:

¢ Cadllstheinput function
+ Normalizesthe read value (to match the model value range)
+ Writesthe new value to the ERP data structure
When writing to an output port, the driver performs the following tasks:

¢ Reads anew value from the ERP data structure

+ Determines whether the value is in-range (according to the driver configuration)
+ Normalizes the value (to match the I/O port range)

¢ Callsthe output function
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Signals

The following sections list the supported signal types, and the mapping combinations of Rational
Statemate variables to signals on the dSPACE hardware.

Signal Types

The following tables lists the dSPACE signal types supported by the ERP driver. The signal type
names are used in the Rational Statemate ERP 1/0 mapping table. For example, if you map a
Rational Statemate variableto “ADC 17, it is mapped to the first A/D converter pin on the
dSPACE board.

Inthetables, “ADC" standsfor A/D converter, “DAC” standsfor D/A converter, and “|OP” stands
for input output port.

Note that the card file includes all the supported signals. You should change the in_port or
out_port for |OP signals only, because they can be configured as either digital input or digital
output.

Alternatively, you could make this change without editing the card file by following these steps:
1. MapanlIOPsignal.
2. Select In or Out in the 1/O column of the 1/0 mapping table.

Port Names

The port namesin the card file represent the port number in the dSPACE hardware.

For example, to map a Rational Statemate condition conpz to port “1OP 17 as output, configure the
second digital port on the hardware to be an output port and map conpz to it.

Similarly, to map a Rational Statemate bit array s1Tarr1 to port “1OP 1-3” asinput, configure the
second to fourth digital ports on the hardware to be input ports, and map each element of s1Tarr1
to the corresponding ports on the hardware.

Note

Digital ports can be either input or output ports. You should configure the ports before using
them.

The driver issues a warning message whenever information might be lost. For example, if a
Rational Statemate integer is mapped to an A/D converter (real), the driver issues a warning.
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Port Type Port Name Channel

Digital I/O IOP Oto 15

ADC 16-bit ADC lto2

ADC 12-bit ADC 3to4

DAC 12-bit DAC lto4

Encoder ENC l1to2

Encoder index ENCIDX lto2

PWM PWM 1to6

Thefollowing table lists the DS1103 signal types.
Port Type Port Name Channel

ADC 16-bit ADC 1to 16
ADC 12-bit ADC 17 to 20
DAC 14-bit DAC 1to 8
Digital I/O IOP Oto 31
Encoder position reading ENC_POS lto7
Encoder position delta reading | ENC_POSD 1to7
Encoder position writing ENC_POSW lto7
Encoder counter reading ENC_CNT 1to7
Encoder counter fine reading ENC_FINE_CNT 7
Encoder counter writing ENC_CNTW lto7
Encoder counter clearing ENC_CNTCL lto7
Encoder index reading ENC_IDX 1to7
Slave PWM generation SLV_PWM lto4
Slave PWM measuring period SLV_PWMD_PD lto4
Slave PWM measuring duty SLV_PWMD_DT lto4
Slave Digital 1/0 SLV_IOP Oto 19
Slave frequency generation SLV_DF lto4
Slave frequency measuring SLV_FD 1to4
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Mapping Rational Statemate Variables to dSPACE Signals

The following table lists the mapping combinations of Rational Statemate variables (integer, real,
and so on) to signals on the DS1103 board. The table uses the following abbreviations for the
dSPACE 1/0 types:

¢ ADC—A/D converter

¢ DAC—D/A converter

¢ | OP—Input output port

¢  PWM—Pulse width modulation

¢ ENC—Encoder

¢ Al and AO—Analog input and output

¢ DI and DO—Digital input and output

Note
As noted in the table, awarning isissued by the driver when information might be lost.

4SPACE 10 Type | STMM Integer | STMM | STMM |- STh | =1
Array
ADC (Al) Yes (warning) Yes No No No
DAC (AO) Yes Yes No No No
I0P (DI) Yes Yes Yes Yes Yes
IOP (DO) Yes (warning) No Yes Yes No
ENC_POS Yes (warning) Yes No No No
ENC_POSD Yes (warning) Yes No No No
ENC_POSW Yes Yes No No No
ENC_CNT Yes Yes No No No
ENC_CNTW Yes No No No No
ENC_CNTCL Yes No Yes Yes No
ENC_IDX Yes No Yes Yes No
SLV_PWM Yes Yes No No No
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SLV_PWMD_PD Yes (warning) Yes No No No
SLV_PWMD_DT Yes (warning) Yes No No No
SLV_IOP (DI) Yes Yes Yes Yes Yes
SLV_IOP (DO) Yes (warning) No Yes Yes No
SLV_DF Yes Yes No No No
SLV_FD Yes (warning) Yes No No No

Implementing User Tasks

User tasks originate from two sources—model subroutines that are defined as tasks, and activities
that are defined as tasks in the ERP Profile editor.

Normally, Rational Statemate user tasks can include some synchronization calls, including the
following:

* wait for event (<events)

¢ task delay(<delay times)

¢ scheduler ()

The synchronization calls suspend task execution and call the Rational Statemate scheduler. The
task resumes execution when a specific event occurs; execution isresumed from the point at which
it was stopped.

Note the following when using tasks on dSPACE hardware:

¢ Do not use an endless while loop to wrap the task code.

*  You should call the scheduler () routine asthe last command within the task. Do not call
it anywhere else.

¢ Donotusecalstowait for event () and task_delay () inyour task.
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The Rational Statemate ERP CANO0€® interface uses a CANoe AP (availablein CANoe 3.0 build
43) and an enhanced version of the Rational Statemate Embedded Rapid Prototyper (ERP).

It is based on the ability to describe a CANoe node behavior by an external DLL. The code
generated by Rational Statemate is compiled and packed in aDLL, which isthen executed by
CANoe.

The Rational Statemate model is generated in an enhanced Module Procedures Only mode. In this
mode, the model is wrapped within one function, and extra code is generated. The extra code maps
the model elementsto CANoe environment variables. The extra code that is generated is called
module interface code.

This section describes how to use Rational Statemate with the CANoe environment. Thetopics are
asfollows:

®  Specifying Profile Settings

¢ Code Generation

¢  Module Interface Code

¢ Using the Generated Code
Specifying Profile Settings

Before generating the code, you must define the modul e interface (which model elements are read
to, or written from, the environment), and the mapping between a Rational Statemate model
element and the CANoe environment variable name.

Complete the following steps:

1. Intherun stmm.bat file, uncomment the following line:

set GEN CANOE IF CODE=ON
2. Open Rational Statemate, and click the Embedded Rapid Prototyper icon.

3. Create anew profile (refer to Invoking the Profile Editor).
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4. Select Options > Global Profile Settings. The following window displays:

Global Profile Settings for REARDEFOG B x|
Language: K&R [ | Double-Buffer Optimization, ..
[ sge it
Hodularity Style: Balanced Mixture .Jl
Generation of maing | Hodule Procedures Only — | s
Interfaces

{ Generate CANoe Interface ( Generate Module Interface () Hore

Infinite Loop L1m1t:|E00 Treats ININDDNSNT .:J

Target Directory: I

PackagessHeaders for External Subroutines:

Truth Table Execution: Upon Change .Jl
0k | Cancel | Help |

5. Select M odule Procedures Only from the Generation of main: drop-down list.
6. Select Generate CANoe Interface.
7. Disablethefollowing options:

¢+ With Debugger

¢ With Remote Panel Server

¢ Graphical Back Animation
8. Specify amodule and scope. Do not include a panel.

9. Click OK.

10. Select amodulein the profile, then select Options > M odule Settings > Par ameter
Setting. The Parameters for Module <Name> window is displayed, as shown in the
following figure.
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" orameters for Module REAR DEFOG x
Parameter || Tupe || Hade ||;|

Insert |
Ielete |
Ehuuse,,,l

I«

0K | Cancel | Help |

11. Select the Type[Data-ltem (integer, real, string, or binary), Event, or Condition], and
Moaode (In or Out, but not In/Out) information for each parameter.

By default, if you have not specified values for the external symbols, Rational Statemate
uses the values of the attribute canoe_Env_var.

If you want to select additional parameters, click Choose.

12.  Set the mapped CANoe environment variable name as the value of the canoE _Env_var
attribute in the Prioperties entry of the element (using the Attributes mechanism).

Note: Currently, the interface supports only one module. Repeat Step 10 for every
element defined as part of the module interface.

13. Generate the code.
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Code Generation

Currently, the external mapped symbol isread from the canoe _Exv_var attribute.

The ERP CRD file includes a new message list section and ageneral port attribute list section. The
CRD templateis as follows:

{

#card name:""
#card polling rate:
#card number of ports:
#card base address:""
#card init function:""
#card driver function:""
#card closure function:""
#port list:
{

#port name:""
#port inverse logic:
#fport default mode:
#port default buffer:
#port offset:""

#port attribute list:

#key L

#value:""

}

#message list:
{

#message name:"”
#fmessage id: “”
#message period:
#message size:
#signal list:

{

#signal name:””
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#signal byte number:
#signal starts at bit:
#signal number of bits:
#signal attribute list:
{
#key:""

#value:""

}

The message list isstored in the card desc data structure, whereas the port attribute list is stored
inthe report_elem data structure.

Module Interface Code

When you use the CANoe environment, Rational Statemate generates module interface codein the
module file. The C macros used are defined in the stmm. h header file. The macro calls create an
array that defines the mapping between a Rational Statemate model element and the CANoe
environment, which is accessible by CANoe at run time. Note that the init module () and
exec_module () functionsare called by CANoe.

The module interface code is as follows:

/***%xx%* CANoe interface code **x***x/

#include "private\stmm.h"

sw_module_ptr MODULE_HANDLE = 0;
condition stm_BREAK PADDLE;
real stm_SPEED;

CN_ENVIRONMENT MAP BEGIN ()

CN_ENVIRONMENT_ ENTRY (&stm BREAK PADDLE,
el _condition, STM_OUT_MAP, "EnvBreakActive")

CN_ENVIRONMENT ENTRY (&stm_SPEED, el_real,
STM_IN_MAP, "EnvDashboardEngSpeedDsp ")

CN_ENVIRONMENT MAP END ()

void init module ()

{
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speed_init_ module (&MODULE_HANDLE,
&stm_BREAK PADDLE, &stm SPEED) ;

sw_module status exec_module ()

{

return speed exec (MODULE HANDLE, 1);

Using the Generated Code

The generated module files (<modules. c and <modules.h) should be part of a Microsoft®
Developer Studio® project, which includes source files and settings provided by Vector-Informatik
GmbH®.

When you link these modules, use the run-time library 1ibschedulercn.1ib instead of
libscheduler.lib. TO generate thislibrary, complete the following:

1. Setthe STM ROOT environment variable asit is set in the run_stmm.bat file before
running the batch file in the next step.

2. Runthe\etc\sched\create sched cn.bat batchfile.

For more information on using the CANoe interface, go to the Vector-Informatik Web site (http://
www.vector-informatik.de).
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This section shows examples where removing double buffers increases efficiency and other cases
where it may introduce errors.

Double-Buffered Statechart

The following Statechart helps to illustrate how the Double Buffer Analysis program works.

TOP_
LEVEL

4 LEFT © RIGHT

[X>51/¥1=K;

When you run the Double Buffer Analysis program on the above Statechart, it reports that you
only have to double buffer dataitems'Y and T. There is no need to double buffer X and Z.

The Double Buffer Analysis program uses the following rules to arrive at its recommendations:
In general, you need double buffering in two cases:

¢ When assignment and accessing a data value occur concurrently (read-write racing).
¢ When two assignments to a data value occur concurrently (write-write racing).
In both cases, the obtained result may depend on the order of execution of concurrent components.
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For example, suppose that upon default the Statechart enters the states L1 and R1 (X = 6 and
Y = 10). Then, the execution of a step may produce these results:

¢ If orthogonal component LEFT is executed before component RIGHT, then at the end of
thestepY =6and Z=7.
¢ If RIGHT isexecuted before LEFT, then at the end of thestep Y =6and Z = 11.

Similarly, after performing a step that involves transition from L2 to L1 and transition from R2 to
R1, data-item T have value 5 or 4 depending on the order of the components execution.

With double buffering, values assigned during a step are deferred until the end of the step so that
al actionsin the step are executed with values the data had at the beginning of the step. In this
case, attheend of thestepY =6and Z = 11.

Because of double-buffering, assignments are implemented in generated code through callsto
special services.
seti (&Y, X);

seti (&Z, Y+1);

rather than by direct C assignments:

Y = X;
Z

=Y + 1;

The Double Buffer Analysis program also finds elements in the model for which double buffering
can be safely removed. For example, in the sample Statechart, the following elements do not need
double buffering:

¢+ Dataitem Z isan output only, i.e., it isonly assigned avalue in the model, but never used
init. Therefore, there is no read-write racing. Since thereis only one assignment to Z,
thereis also no write-write racing.

¢ Dataitem X has an assignment and use of X, but they both belong to the same component
and are never executed at the same step. Therefore, X does not need double buffering.
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Optimizing Double Buffers

After running the Analyzer, complete the following steps to modify the compilation profile:

1. Select Options> Global Profile Settingsin the Code Generator’s main window. The
Global Profile Settings window opens.

.. |WINDOWSNT |

2. Click Double-Buffer Optimization. The Double Buffer Optimization window opens.
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S 'Dnuhle-Buffer Optimization

3. Select Double Buffer Only Listed Elements. This enables you to choose the elements to
double buffer.

The Initialize Double-Buffer List fields become enabled.
4. Change With All Elementsto From Saved List.

An drop-down list displays. You can select any list of elementsthat you saved including
the lists you created with the Analyzer.

5. Select thelist that the Analyzer created when you selected With Double Buffering List
Name.
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6. Click Initialize List and the element names appear in the Elements to be Double Buffered
list.

All assignments in the generated code are done in accordance with the selected list:

+ All dementsin thislist are double-buffered.

For example, Rational Statemate assignment to an integer data-item such as X :=
5istrangdated into the following call:

seti (&X,5);

¢ All elementsnot in thislist use direct assignmentsin the natural C style; for the
above assignment this would be:

X = 5;

7. Select amemory allocation option for elements that are double buffered.

Allocate Satically - Generally faster if thereisasmall number of elements.

Allocate Dynamically - Generally faster if there is alarge number of elements.

Thisisthe default setting, which you can change in Options > Preferences
M anagement.
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This section describes the architecture of the generated Ada code including how the Code
Generator structures the modules.

The Rational Statemate Code Generator generates fully functional code, based on the Statecharts
and Activity-chartsin the Rational Statemate model. The generated modules are partitioned
according to a compilation profile, which allows you to generate code for a complete Rational
Statemate model or just a subsection of the model.

Each generated modul e reflects the state, timing, and scheduling logic of the model that isincluded
in the compilation profile. This allows a suitable set of components to be built that reflect the
system logic (behavior).

The generated code uses runtime modules for timing and scheduling. Requests are generated to the
timing module for timeouts and scheduled events, and to the scheduler module to control
handwritten tasks that are connected to basic activities. In addition, the data elements are double
buffered, so data assignments are synchronized to prevent racing conditions among the
“concurrent’ behavioral components.

Note
Adais supported for regular code generation only, not ERP.
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Code Libraries

All the runtime modules are actually a set of compiled libraries. The libraries can be reused for
other projects asthey are supplied in source code form. The runtime modules actually comprise an
interface between the generated behavioral logic and the underlying operating system.

Porting the generated behavioral componentsto a particular environment primarily meansto tailor
the runtime library to use the specific services provided by the operating system/real-time kernel,
or in cases where none of them exist, to provide an aternative functionality.

Note

Tailoring the runtime libraries is a one-time effort. Once compl eted, the generated
components can be compiled and linked without being modified.

Thefollowing diagram shows the layers of software componentsin the embedded application. The
final executable imageis built from some permanent modules, in addition to the generated
modul es that are dependent on the application.

Generated Code
Permanent Code
application code _

behavioral logic + user-code main

loop

1 2
timer scheduler double callback
threading buffering handler

! ! ! !

OS services : Memory Management (3)
Timer Service
Multi-Threading services (4)
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¢ Thescheduler component isoptional - It is needed only if the user specifies that basic
activities should be implemented as tasks or desires to link a graphic panel into the
executable.

¢ Callback handler - Isused only if the user selectsto attach callback routines to
behavioral logic components.

¢ Memory management - The runtime modules timer, double-buffering and callback
handlers utilize dynamic memory allocations. Under certain assumptionsit is possible to

tailor them to use only static alocation, if amemory management package is not available
or memory resources are limited.

¢ Multi-threading (tasking) support - Thissupport provides amechanism for creating task
threads and switching between them. This serviceis needed only if the user wishesto
implement environment tasks or basic activities astasks. Thisissueisdiscussed in greater detall
in this document.
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Tasks View of the Code

One of the major issues that confuse many usersis how “concurrent” activities and states are
actually trandated into a sequentia language. Concurrency within the languages of Rational
Statemateis represented explicitly between orthogonal states (AND states), and implicitly between
separate (concurrent) activities. Sometimesiit is natural to implement them as different threads
(tasks), but it is also possible to implement them as a single threaded program.

Writing an embedded application as asingle thread or multi-threaded is actually a design decision.
Since the underlying architecture is sequential, a multi-threaded program is actually a set of
sequential pieces managed by a sequential scheduler.

Module Execution

The modules of the generated code are sequential. They are executed cyclically with each iteration
evaluating the next step of processing. In terms of simulation, executing the code is equivalent to
executing a“go-step” repeatedly, while changing the environment asynchronously. The main
difference isthat the clock isincremented in real time, so timeouts happen according to the time
taken to execute the code.

Multi-Threading

So why is multi-threading needed at all? Multi-threading is used to allow the user to implement
basic activities asindependent processes, without having to comply with the “one cycle at atime’
method. It also allows writing additional environment processes outside the system model, to
process inputs, to drive outputs or for simulating the environment. Therefore, a multi-threading
capability is needed only if the user wishes to add threads that run “concurrently’ with the
generated modules that execute as a single thread, denoted asthe “main task’.
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Asynchronous Timer

Another component in the process view of the code is the asynchronous timer. The main task
issues timer requests to be notified about timeouts and scheduled actions. The timer module
asynchronously notifies the main task when timeout events are occurring

Events, conditions

Data-items
l Inputs from
i i Environment
Timer timeouts Main Task | Start User-Taskl |«

ISR > Sop | Basic Activity

scheduled P
T i onL; (Control Suspend
oS Task) | REUME |yser-Task2
timer-requests User-Defined

+ Insome applications there are no basic activitiesimplemented as tasks. In those cases, the
only processes that exist are the main task and the asynchronous timer. If basic-activity
tasks exist, the main task issues tasking control calls such as start, suspend, etc.

¢ There are cases where the user implements environment tasks, but none of the basic-
activities are implemented as a task. In these cases, the generated-code (the main task)
does not use any tasking services. The code does not need a multi-threading adaptor
unless the user connects a panel to the executable.

Using Simulated Time Model

The generated code uses the real-time model, by default. In this modd, timeouts and scheduled

actions are treated very similarly to other inputs. The system clock keepstime and generatesinterrupts
which are processed along with the other inputs.

When using thistime model, it is possible for the code to miss atimeout or scheduled action dueto
heavy loading of the processor or an extremely small request for atimeout. In such a situation, the
generated code may actually behave slightly different than a simulation of the same model.

Rational Statemate also provides a simulated-time mode . The purpose of the smulated-time mode is
to force the generated code to behave in the same manner as the smulated modedl. It doesthis at the cost
of the real-time nature of the generated code.
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In order to meet all timeouts regardless of duration and CPU loading, the code would be required
torun at an arbitrarily fast speed. Since thisis not possible, code which is compiled using the
simul ated-time model, does not adhere to the system clock. Rather, it keepsitsown artificia time, much
thesameasasmulator. Aninterna counter iskept. The code executes model stepsuntil it reachesanidle
gatus. It then advancestheinterna clock to the necessary value to execute the next timeout or scheduled
action.

-- The main loop, loops forever
procedure main is

begin
INIT FUNCTIONS .

USER_ACTIVITIES.USER_INIT;

loop
-- Execute a step --
-- Advance internal time keeper to next
relevant step --
-- Apply timeouts and scheduled actions. -

end loop;
exception

end MAIN;

Main Task—Partition and Flow Control for Ada

In this section we describe how the different generated modules are put together into asingle
thread, and what is the control flow of the main task. The whole execution starts with an
initialization phase, where all components are initialized: the timer, the threads scheduler (if
needed) and basic activity tasks are created. In addition theuser init procedureiscalled.

Theuser init procedureresidesinafilecaled user activities.a. When you generate
code, the Code Generator automatically createsthe user activities.a fileandtheuser init
procedure. Prior to executing the model, you may initialize valuesin the user init procedure.

After theinitialization phase, the main-task starts processing in acyclic manner, where every cycle
correspondsto asingle “go-step.’ In every cycle, al the concurrent state machines are traversed,
process their inputs and generate outputs, issue timing requests and take the necessary state
transitions.
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Thisis how the Main procedure program looks:

begin
PR_INITIALIZE;
loop
PR_MAKE STEP;
end loop;

exception

when NUMERIC_ERROR | CONSTRAINT ERROR =>
REPORT_error (“NUMERIC ERROR or CONSTRAINT ERROR
exception raised”) ;
FINISHING;

when others =>

REPORT_error (“Fatal error: exception raised”) ;
FINISHING;

end MAIN;

The following diagram shows the calling sequence within the main task:

user_init
ytop_level.lo_init
other
main inits
r .| modulel
| make a_ LO_MAIN
main step .
loop moduleN
handle — | user
callbacks* \ callbackl
user
waitdinpu callbackN
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Executing a Single Step

procedure MAKE A STEP is
NEED_GO : BOOLEAN;
begin
INCREMENT STEPN;
-- advance steps counter
if IS_SYNC TIME = true then
-- synchronous (simulated) time model is used
if get stepN >1 then
INCR _TIME;
-- in synchronous time model,
-- time is advanced at each step
-- except for the first step when model
-- enters its default states
end if;
WAS UPDATE := true;
-- this means that each step
-- involves some update
WAIT4INPUT;
end if;
TOP_LEVEL.LO MAIN;
-- execution of step; all changes are
-- buffered till the end of the step
SEMAPHORE . LOCK;
-- to process the last step’s changes,
-- block the arrival of new external
-- changes to the main task
UPDATE_VALUES (NEED_GO) ;
-- assign elements their new values,
-- according to changes in the step
WAS UPDATE := WAS UPDATE or DEB _WAS UPDATE;
-- true if there were changes in the
-- previous step, or
-- an element was changed between
-- steps using the Debugger’s SET command
if not NEED GO and then (not WAS UPDATE) then
-- check whether to enter the wait mode;
-- do it if there were no updates in
-- 2 last steps
SLEEPING := TRUE;
-- mark the main task as going
-- to enter the wait mode
SEMAPHORE . RELEASE;
-- and now allow arrival of new
-- external changes to the main task
WAIT4INPUT;
-- if meanwhile an external input was
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-- generated then accept it
-- otherwise enter the wait mode
else
SEMAPHORE . RELEASE;
-- allow arrival of new external changes
end if;
WAS UPDATE := NEED GO;
TRANSMITTER.EVAL CALLBACKS;
-- at the end of step, evaluate all
-- callbacks - according to hooks
-- requested in Compilation Profile,
-- and according to panel bindings
GARBAGE COLLECT;
-- free memory which was temporarily allocated

-- during step execution
end MAKE A STEP;

Activating the Generated Modules (the “ State Machines”)

ro_MAIN iSa GENERATED procedure, that “glues’ together all the specific modules as
partitioned by the compilation-profile. Since .o_ma1n refers to specific procedures, it differs
between different models:

procedure LO MAIN is

begin
<modulel> EXEC ALL;
<module2> EXEC ALL;

<moduleN> EXEC ALL;
end

Note

Thero main isactually the scheduler of the generated components. It applies afair non-
prioritized round-robin scheduling policy, similar to the interpretive simulator. However, it
is possible to introduce priority scheduling by modifying this module.

Updating Double Buffer Assignments

The procedure urpaTe_vaLUEs executes al the deferred assignmentsinto the actua data objects, based
on the update list. Asaby-product, the procedure can determine whether the system is il processing
dataor it has reached agationary condition. If the update list is empty, it meansthat the system executed
anidegep. Thestep has_changes flagindicateswhether the step has ongoing processing, or the
previous execution cycle was actually an idle step.
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Evaluating the Callback List

If you sets hook for callback procedures, they are checked by EVAL CALLBACKS. In casethat one
of the callback hooksis “active’, the callback procedureiscaled.

Entering the Wait State

If the system has executed two consecutive idle steps, it isin astationary condition. The reason for
executing two idle stepsisthat the negation of events might yield an active trigger after asingle
idle state. If the system isidled for two steps, no negative event triggers can take place. At this
point, the main task releases the CPU by calling to a system service that blocks it from running
until some external stimulus occurs. The external stimulus can be either an event/data change, or a
timeout.

The decision whether to enter await state or not should be handled carefully, since once the main
task blocks itself, only external input wakesit.

main task timer

1] CHECK FOR WAIT

{ Checks for changesin last 2] GENERATE_TIMEOUT
two steps, or timeout ex- }
pired. If none, it decidesto { A timeout expired; hence .. }
sleep.

3] TRY_TO_WAKE_ MAIN_TASK

ﬂ WAIT { but it does not deep yet; so }
thisisawasted call

Main task enters await }

mode, instead of reactingto

the timeout

A4

This scenario leads to a deadlock condition. Since the timeout isignored by the system, the main
task has aready “decided’ to hibernate itself but has not yet done so and the “wake-up” call islost.
The use of the SEMAPHORE task allowsfor virtual exclusion test-and-block and therefore avoids
the deadlock.
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Structure of a Behavioral Module

Each behavior module is trandlated into a package that contains objects and subprograms
implementing that modulein Ada. Two files are generated for such a package: one for the package
specification and another for the package body.

The structure of the two filesis explained for the module called RAIL CROSS; thefilesare:

¢ rail cross_.apackage specification
¢ rail cross.a package body

Package Specification

Context Clauses

Basic type definitions and services for conditions, events,
data-items, etc.

with SYSTEM; use SYSTEM;

with INTRINSICS; use INTRINSICS ;

Services for timeouts and scheduled actions
with TIMEOUTS; use TIMEOUTS ;

Rationa Statemate queues operations
with QUEUES; use QUEUES ;

Rationa Statemate string operations
with STM_ STRINGS; use STM_STRINGS ;

Rational Statemate operations for bit-arrays
with BIT OPERATIONS; use BIT OPERATIONS ;

Rational Statemate predefined functions
with STD_ FUNCS; use STD FUNCS ;

GDS containing the model’s global types and constants
with UNCHECKED CONVERSION;
with RAIL DICTIONARY; use RAIL DICTIONARY;

Generic behavior modules instantiated in module RAIL_CROSS with TOP_LEVEL; use
TOP_LEVEL; elements shared by modules but not defined in GDS's

with g GEN BARRIER;

with g GEN ROAD CROSS;

with g GEN TRAIN;
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Interface Section Documents Inputs and Outputs

--Inouts
TIME1l : FLOAT64 ;
END_MEASUREl : event ;

Definitions of Data and Control Elements of the Module

In this section all primitive (non-compound) local data-items, events, and conditions are defined.
“Local’ means elements not used outside the modul e scope.
ACK _BAR2 DOWN : event ;

IN_CRIT2 : condition ;

Definition of Fictive Events

ENMOVE_DOWN : event ;

tmDOWN_FINISHED: event ;

Thefictive events are events not explicitly defined in the model. They are essentially timeout
events, enter/exit state events and in-state conditions. They are generated only when necessary; i.e.
only if thereisause of en(STATE) the ENSTATE event appears in the code. The above two events
appear because the model contains timeout event DOWN_FINISHED defined as
tm(en(MOVE_DOWN), 5).

Definition of Activities

Each activity in the moduleis represented by a data structure that contains information on the
activity’s current status, and on its hierarchical relations with other activities.

CHECK TIME2 : ACTIVITY := dummy act;
In addition, if in the Compilation Profile the user asksto implement abasic activity astask, then an
appropriate task declaration appears:

task CHECK TIME1l TASK is

entry START;

end CHECK TIME1l TASK ;
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Generic Instances in the Module

Instances of generic chartsin the module are translated into instances of the corresponding generic
packages:

package Inst BARRIER2 is new
g _GEN BARRIER (BAR2 DOWN, BAR2 UP,
ACK BAR2 UP, ACK _BAR2 DOWN,
REPAIR CLOSE2,REPAIR OPEN2,
FAIL2 TRANSIENT,FAIL2 PERMANENT)

Definition of Compound Elements

Compound elements are translated into functions of the appropriate type. For example, for
compound condition:

function CAN_OPEN_CROSS return boolean;

Procedures for Initialization and Execution of the Module

Procedures for initialization of the module and execution of single step by all chartsin the module.

procedure rail cross_ INIT;
procedure old rail EXEC ALL;
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Package Body

For each behavioral module, its package body contains implementation of those itemsthat are
declared in the package specification.

Definitions of State Status Types and Variables

Every non-basic OR-state has a status variable that indicates what substate is currently active. The
status type is an enumeration type that actually lists all substates of the OR-state. Status variable
gets value notaS (which is the default) when state Sis not active.

type tpNORMAL states is
(notaNORMAL, OPEN, CLOSED, MOVE_UP, MOVE_DOWN) ;
NORMAL isin : tpNORMAL states := not NORMAL;

Schedule Timeouts Procedure

This procedure executes every execution cycle, and evaluates what timeouts should betriggeredin
the particular module. All timeout triggers are evaluated and the necessary timeouts are scheduled
using the service SC_TMO (from the run-time library package TIMEOUTS).

procedure SCHEDULE TIMEOUTS is
begin
if ENMOVE UP then
SC_TMO (tmUP_FINISHED’ address,
FLOAT64 (5) * SEC);
end if ;
end SCHEDULE TIMEOUTS ;

Body Stubs for Basic Activities

For each basic activity selected to be stubbed out with the Profile Editor’s Make Procedure option,
aprocedure is created:

procedure user code for check timel is separate;
procedure user code_for check time2 is separate;

A separate procedure body is then placed in file user activities.a
where you can add your code to implement the activity.
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Functions Implementing the Compound Elements

The function CAN_OPEN_CROSS return BOOLEAN iS
begin
return (EXIT CROSS1 or EXIT CROSS2) and

(not (IN_CRIT1 or IN CRIT2));
end CAN_OPEN_CROSS;

Action Procedures

In some cases (depending on the modularity style), actions are transated into procedures:

procedure EXEC GET TRAIN SPEED is
begin

seti (TRAIN SPEED'address, 160) ;
end EXEC GET TRAIN SPEED ;

State Enter/Exit Procedures

Depending on modularity style, the enter/exit (including history enter) sequences are grouped into

procedures:
procedure entdef OPEN is
begin
NORMAL isin := OPEN;

gen (ACK_BAR_UP’address) ;
end entdef OPEN ;

This example shows the default entering sequence (i.e. entering viaatransition that goes to the
edge of the state) for the OPEN state:

¢ Change parent gatus variable to OPEN
¢+  Gengateevent ACK_BAR_UP; thisreflectsthe static reaction
¢ Defineinthemode for sate OPEN

entering/ACK _BAR_UP
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State Execution Procedures

The EXEC procedureis actudly the heart of the behaviord logic as described in the statecharts. Every
non-basic sate has an EXEC procedure that activates al the state-logic within asingle execution cycle.
The EXEC procedure takes care of in State trangition, static reactions, and activation of substate EXEC
procedures. The traversal is done hierarchicdly, starting at the very top state in the module and going
down towards the basic states. In case of an AND-dtate, the orthogonal components are traversed

sequentialy one after the other.

procedure EXEC BARRIER is

begin

case BARRIER isin is
when NORMAL
if FAIL PERMANENT then
exit NORMAL;
BARRIER isin :

else

EXEC_NORMAL;

end if;

when DAMAGED

end case ;

end EXEC_ BARRIER ;

Module Initialization Procedure

The module “init” procedure is called once the executable is started, before running through any
execution cycle. It performs various initializations, as shown in the example:

procedure RAIL CROSS init is

begin

INIT ACTIVITY (CHECK TIMEl’address,NONACTIVE,

FALSE, ZNIL, ZNIL, ZNIL) ;

— initialization of the data structure
— for an activity in the module
Inst BARRIER2.g GEN BARRIER init;
— hierarchical call for initialization
— of a generic instance in the module

end RAIL CROSS;

The“init” procedure is exported to the module (TOP_LEVEL) whereit is called by procedure
LO_INIT that isresponsible for initialization of the entire model.
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Module Execution Procedure

This procedure activates a single execution cycle (step), once being called by LO MAIN inthemain
module TOP_LEVEL. It activatesthe SCHEDULE TIMEOUTS procedure to schedule potential
timeouts, the user-written code for basic activities, and most importantly, it activates the hierarchical

traversa of the state EXEC procedures by activating the EXEC proceduresfor dl top-leve statecharts
that belong to the module.

procedure rail cross_ EXEC ALL is
begin

SCHEDULE TIMEOUTS;

if STARTED (CHECK TIMEl) then

CHECK _TIME1l TASK.START;
end if;

EXEC_Chart BARRIER;
EXEC_Chart RAIL ROAD CROSS;
EXEC_Chart TRAIN MOVE;

end rail cross_ EXEC all ;
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File Structure In Ada: Control Files

Behavioral Modules

The behavioral modules are the heart of the code and implement the state/transitions logic as
described by the statecharts. The specification is partitioned into behavioral modulesin the
compilation profile. For each specified module, two files are generated based on the user-defined
module name.

The following module specification file exports all the specification objects defined in the module
(to use by other modules), and the modul e execution procedure.

<module name> .a

The following module body defines all the local objects (events, conditions, data-items), and the
procedures that implement the logic of the statecharts.

<module names>.a

Top Level Module

The top-level module “wraps’ all the behavioral modulesinto a single behaviora unit. It also
defines all the global elements, i.e., those elements used by more than one module. It defines two
procedures:

¢ LO_INIT -initialization of all the participating modules.
¢ LO_MAIN - execution of asingle step of all modules.

The specification of the top-level module isidentified below. It exports the globa elements, the
initialization and the execution procedures.

<profile name>main_ .a

Implementation of these proceduresis found in the modul€e’s body:

<profile_name>main.a
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Main Procedure

Thisisthe main scheduler that activates the behavioral modules. It consists of the main unit that
instantiates all the other modules. In many cases where the generated code is not the backbone of
the application, you might want to replace the supplied main procedure with your own application
scheduler.

main.a (main_dbg.a indebugging mode)

User Supplemented Files

These filesinclude all the stubs generated for the basic activities according to the compilation
profile. Once the user-activities stubs file exists in the output directory, it is not overwritten, and a
fileuser activities.a_ tmp iSgenerated.

user activities .a (user_activities .a temp)

user activities.a (user activities.a.temp)

Transmitter Template

Thisfile contains the hooks for the elements specified in the Profile with the “Hooks” option.
Since you can modify thefile, it is not overwritten. Instead, the file
user transmitter.temp isgenerated.

Interface Modules

+ The Symbol_table file is generated only when the debug option is enabled in the Profile
Editor (Options > Global Profile Settings). It includes symbolic information about the
original model that is used by the debugger.

<profile_name>.dbg

¢ ThePGE Interfacefileis generated only if your code uses PGE to build mockup panels.
Thisis actually the code that glues the panel to the behavioral modules:

panel_transmitter.a
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Info File

<profile name>.info

Theinfo file contains information about the tranglation process, the relevant portion of the model
and the generated modules.

The info file contains the following information:

¢ Compilation profile parameters
¢ Errorsand warnings

* Crossreferencetable—Thistable contains al the elements in the code and the names of

the original elements they represent. Thisinformation is useful when supplementing the
generated code. In cases where the same name is used in different charts, this cross-
reference table is the only way to identify which code-element maps to the spec-element.

I nterface report—The interface report is a graphical diagram that shows the flow of

information and control among the behavioral modules, and among the environment and
the rest of the model.
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This section explains how the DS1103 I/O driver isdesigned. It isintended for advanced users who
want to enhance the DS1103 driver, or to port the driver to other ASPACE hardware. Thetopics are
asfollows:

Note

The Rational Statemate Embedded Rapid Prototyper (ERP) also supports dSPA CE model
DS1102.

The Rational Statemate Embedded Rapid Prototyper (ERP) supports dSPACE models DS1102 and
DS1103. The dSPACE DS110 models are single-board solutions meaning the processor and 1/0
are located on the same cards.

The dSPACE interface enables you to:

+ Generate C code from the Rational Statemate model, compile the code, and download it to
the dSPA CE system with asingle click.
+ Map model elements to the board I/Os.

¢ Generate dSPACE TRC files for use with dSPACE ControlDesk layouts.
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Implementing the Driver

The driver consists of two parts. Thefirst part describes the general infrastructure that can be used
with other boards besides model DS1103. Thisinfrastructureis defined inthefile stm_dspace.c.
It reads the signal mapping and selects the correct 1/0 function to be called by the driver function.

The second part, defined in stm_ds1103. ¢, deals with items specific to the dSPACE DS1103
board. The following sections describe each of these partsin detail.

General Driver File

To support anew card ps<xxxx> (Where <xxxx> isthe model number of the card), you must
modify some sections of the stm_dspace. c file. Specifically, you must change the sections that
use preprocessor directivesin order to switch between the different cards ("#ifdef DS<xxxx>
.."). In these sections, add callsto the functions stm_ds<xxxx> global initialize(),
stm_ds<xxxx>_get_driver_func(), and stm_ds<xxxx>_close_connection() .

Driver Interface Functions

The dSPACE driver interface functions are declared in thefile stm_dspace . h. The driver includes
three functions:

¢ stm dspace_init () - Thisfunctioniscalled only once. It configures and initializes the
signals defined in the ERP 1/0O mapping table. If mapping isinvalid, awarning or an error
message is generated (and sent to the dSPACE ControlDesk).

¢ stm dspace driver () - Thisfunctioniscalled whenever dataisread from, or written to,
an 1/O port. Therefore, thisfunction is called very often and affects overall efficiency.

¢ stm_dspace_close () - Thisfunction should be called before closing the connection with
the hardware.

The stm_dspace_init() Function

The stm_dspace_init () function parses the pin names and splits them into tokens. For example,
“IOP 1-3” isavalid reference for an array of pinson the DS1103 board. The nameisinterpretedin
the following way:

¢ |OP - Thetype of the signal

¢ “1” and “3" - The boundaries of the bit array

After pin name processing is performed, the function stm_dspace global initialize() iS
called. Thisfunction calls the initialization function of the special part of the driver.

248

Code Generation Reference Manual



Implementing the Driver

The stm dspace get driver func () function selectsthe appropriate 1/0O access function. The
function pointer is saved in the Rational Statemate element data structure and is used by the driver
function.

The stm_dspace_driver() Function

The stm_dspace driver () function iscalled with an element data structure as an argument. The
function executes the function pointed to by the arv_func field of the element data structure.

The stm_dspace_close() Function

The stm_dspace_close() function calls stm_dspace_close_ connection(), whichinturn cals
the specific driver function.

Driver-Specific Files

In addition to the stm_ds<xxxx>.c file, there are four other files that contain driver-specific
information:

¢  stm ds<xxxx> types.h - Containstypes definitions

¢  stm ds<xxxx> conf.h - Containsthe driver configuration information

¢  stm ds<xxxx> conf.c - Containsthe card configuration data structure

¢  stm ds<xxxx> msg.h -Contains error message handling and warning information
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Handling I/O Signals

As an example, this section describes how to handle an A/D converter (ADC) signal on aDS1103
board. The following functions are used to handle /O signals:

stm _ds1103 global initialize()
stm_ds1103_init ADC()

stm ds1103_get driver func()
stm _ds1103 drv_ ADC()

These functions are declared in thefile stm_dspace 1103.c.

The stm_ds1103_global _initialize() Function

Thestm ds1103 global initialize() function “attaches’ some data structure to the
user data field of the Rational Statemate report elem data structure.

Theglobal variable stm_ds1103_conf var iSOf type stm_ds1103_conf, Which is defined as
follows:

typedef struct stm ds1103 conf {

stm _ds1103 ADC type adc_t;
stm_ds1103_ADC_signal adc [20] ;
stm_ds1103_DAC_signal dac (8] ;

stm _ds1103 SLAVE PWM type slave pwm t;

stm_ds1103_SLAVE PWM signal slave_pwm[8];
stm_ds1103_SLAVE DF_type slave_df t;
stm_ds1103 SLAVE DF_ signal slave df [4];
stm_ds1103_SLAVE_ FD_signal slave_fd[4];
stm_ds1103_SLAVE PWMD_signal slave pwmd[4];
stm_ds1103 SLAVE IOP_ type slave iop_ t;

} stm_ds1103_conf;

This data structure, defined in the file stm_ds1103_types.h, storesthe user-defined card
configuration. To change the card configuration, edit thefile stm ds1103 conf .h (as documented
within the file itself).

Asyoucanseeinthestm ds1103 conf Structure declaration, there are 20 separately configured
channelsin an ADC signal. Therefore, the data structure includes an array of 20 elements of type
stm ds1103 ADC signal.
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Thestm _ds1103_ADC signal datastructureis defined asfollows:

typedef struct stm ds1103 ADC signal ({

stm ds1103_ADC type *type;

double
double
double
double

} stm ds1103 ADC signal;

Thefields of the stm _ds1103 ADC signal Structure are asfollows:

minimum;
maximum;
norm_const_A;

norm_const_B;

¢ type - Pointsto acommon part for all ADC signals. This part is used by the driver
function for storing information regarding the current status of the ADC.

The relevant structure declaration is as follows:

typedef struct stm ds1103 ADC type {

long active channel;

} stm _ds1103_ADC_ type;

¢ mi ni rumand maximum - Specify the range of the receiving signals.

¢ norm const A andnorm const_ B - Used for normalization of the signal. Thisis
necessary because the card returns values between —1.0f and 1.0f only.

The global variable cont storeslists of pointers to the I/O- mapped Rational Statemate elements.
Each list stores the elements, which are mapped to the same signal type. It isused for configuration

check and initialization.

After pin processing, the driver callsthe initialization routines. The ADC signals areinitialized by

thestm ds1103_init_apc() function.

The following figure shows the result of the data structure allocation and attachment process

performed by the initialization function.
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report_el em _»Et m_dspace_pi n_i nf o g[S M dSTI03 pin_nfo
Ce char* signal _type i nt signal _type
voi d* user_data char* id i nt channel
char* flags voi d* flag
funcp drv_func int init_error
oi d* user_data voi d* type_info
report_el ent elem

st m ds1103 _ADC si gnal

> 1 _ADC_si g st m ds1103_ADC type
stm ds1103_ADC type *type; | ong active_channel;
doubl e m ni mum

doubl e maxi mum
doubl e norm const A;
doubl e norm cont B;

The stm_ds1103 init_ ADC() Function

Thestm ds1103_init_apc () function performsthe following tasks:

¢ Checksthe validity of the port number

¢ Checks whether the signal is mapped asinput in Rational Statemate
¢ Checksthe Rational Statemate variable type against the port type

¢ Managesthe MUX mask

¢ Cadllstheinitialization function

The ADC channels are numbered from 1 to 20. If thereis an invalid channel number, mapping is
cancelled and the driver generates an error message. For example, in the Rational Statemate 1/0
mapping table, an element is specified as an input or output signal. Because the ADC signal isan
input port, if thereis a contradiction with the definition in Rational Statemate, an error message is
generated and mapping is cancelled.
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Model elements that are mapped to an ADC signal should be of typereal or integer. In every other
case, the driver generates an error message. Refer to Signal Types for information about Rational
Statemate to dSPACE mapping.

Note that the first 16 channels are organized in 4 multiplexers. Every multiplexer hasto be
initialized with a selected channel. Multiplexer number 1 handles channels 1 to 4, multiplexer
number 2 handles channels 5 to 8, and so on.

The stm_ds1103 get _driver_func() Function

Thestm ds1103 _get driver func () function returnsan I/O access function, which is used by
the driver function. For example, for an ADC port, stm ds1103 get driver func() returnsthe
function stm ds1103 drv ADC().

If the pin signal type is not supported by the driver, the function returns anuLrr vaue. If an error
occurs during initialization, the function returns the dummy function stm ds1103_drv_error().

The stm_ds1103 drv_ADC() Function

Thestm ds1103_drv apc () functionisused by the model for 1/0O access. It is called at a defined
polling rate. The implementation of this function should be very efficient.

Thestm ds1103_drv_apc () function performsthe following tasks:

¢ Changes the multiplexer channel (if necessary)

¢ Readsthe value from the hardware

¢ Normalizes the value according to the user-defined variable range
¢ Storesthevauein the Rational Statemate element structure

Thefirst 16 ADC pins of the DS1103 hardware are handled by 4 multiplexers. The function
changes the multiplexer active channels as necessary. The multiplexers’ active channels are stored
inthevariable active channel.

After setting the multiplexer, the function reads the value of the specified ADC channel. The read
value, which is always between —1.0f and 1.0f, istrandated to the user-defined range (specified in
thefilestm ds1103 conf.c) using two previously calculated constants. The result is stored in the
Rational Statemate element data structure.
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Reserved C Words

This section lists the reserved words for the C programming language. If you use any of these
words as names of elements, Rational Statemate renames the elements during code generation. For
example, if you name a condition “AFTER,” when you generate the code, Rational Statemate
automatically renames the element (“AFTER ") so there isno conflict. The following table lists

the reserved words.
ABS ABSOLUTE ACOS ACOSD
AFTER ALIAS ALL AND
ARCHITECTURE ARCSIN ARCTAN ARCCOS
ARRAY ASCII_TO_CHAR ASIN ASHL
ASHR ASIND ATAN ATAND
ATAN2 ATAN2D AT ATOM
BA_LEN BASETYPES BEGIN BITS_OF
BOOL BOOLEAN BUFFER BUS
BYTE CALLBACK CASE CHAR
CHAR_TO_ASCII COMPOUND CONCAT_BA CONFIGURATION
CONST cos COSINE COSH
COSD COUNTER DECIMAL DELAY
DELETE DELTA DIGITS DISCONNECT
DO DOMAIN DUPLICATE ELSE
ELSIF END ENTERED ENTITY
ENTRY ERROR EXCEPTION EXIT
EXITED EX_ENTERED EXP EXPORT
EXPAND_BIT FALSE FROZEN FILE
FLOAT FOR FS GENERATE
GOTO GUARDED HANGING HEX
HR IF IN INFINITE
INOUT INT INTERFACE INTERNAL_RESET
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INT_MAX INT_MIN IS ISR

LABEL LIBRARY LIMITED LINKAGE
LONG LONG_MAX LONG_MIN LOOP

LOG LOG2 LOG10 MAP
MAX_INT MAX MAXINDEX MAXLONG
MAX_DIGITS MEMORY_SIZE MIN MINUTE
MINUS MIN_INT MOD MS

MUX NAME NOTA NONACTIVE
NAND NEW NEXT NOR

NXOR NAND NOT NS

NULL OPERATING OF ON

OPEN OR OTHERS OVERFLOW
ouT PANEL_ TRANSMITTER PS PORT
PRAGMA PRIORITY PRIVATE PROC
PROCESS QACTIVE ouT Q_PUT
Q_UPUT OVERFLOW RAISE RANGE
RECORD REGISTER REM RENAMES
REPORT RETURN REVERSE ROUND
SEC SELECT SEVERITY SHORT

SIN SIND SINE SING

SINH SIGNAL SIGNED SQRT
STORAGE_UNIT STRING STRING_INDEX STRING_EXTRACT
STRING_LENGTH STRING_TO_INT SUBTYPE SUCCESS
SYSTEM_NAME TANGENT TANH TAND
TAN2D TASK TERMINATE TEXT

TICK TRUE TRUNC TRY_AGAIN
THEN TO TRANSPORT TRY

TYPE TYPES UNITS UNTIL
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UNION USE USER_ACTIVITIES us

VARIABLE VOID WAIT WAIT_TIMEOUT
WHEN WHILE WINDOWS WITH

WORD XOR
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